
 
 
 
 
 
 
 
 
 

 

Stellar Toolkit for Outlook 

User Guide for Version 11.0 

  



 

Overview 

Stellar Toolkit for Outlook is a collection of following softwares: 
 
 
1. Stellar Repair for Outlook – Technician 

2. Stellar Converter for OST – Technician 

3. Stellar Merge Mailbox for Outlook 

4. Stellar Undelete Email for Outlook 

5. Stellar Splitter for Outlook 

6. Stellar Compactor for Outlook 

7. Stellar Deduplicator for Outlook 

8. Stellar Password Recovery for Outlook 

  



 

System Requirements 

Before installing the software, ensure that your system meets the minimum system requirements. 

Minimum System Requirements 

 Processor: Intel-compatible (x86, x64) 

 Operating System: Windows 10 / Windows 8.1 / Windows 8 /  Windows 7 

 Memory: 8 GB (recommended) 4 GB (minimum) 

 Hard Disk: 250 MB for installation files  

 MS Outlook: Office 365 / 2019 / 2016 / 2013 / 2010 / 2007 

Note:  For large files, it is recommended to have 64 bit Windows, 64 bit MS Outlook and 8 GB RAM. 

Note: MS Outlook version depends on the respective software of Stellar Toolkit for Outlook that you are using.  



 

Installation Procedure 

To install the software, follow these steps: 

1. Double-click StellarToolkitforOutlook.exe executable file to start the installation. Setup - Stellar Toolkit for 

Outlook window appears. 

2. Click Next. License Agreement window is displayed. 

3. Choose I accept the agreement option. Next button will be enabled. Click Next. Select Destination Location dialog 

box is displayed. 

4. Click Browse to select the destination path where the setup files will be stored. Click Next. Select Start Menu Folder 

dialog box is displayed. 

5. Click Browse to provide path for program's shortcuts. Click Next. Select Additional Tasks dialog box is displayed. 

6. Choose the check boxes as per your choice. Click Next. Ready to Install dialog box is displayed. 

7. Review the entries. Click Back if you want to change them. Click Install to start installation. The Installing window 

shows the installation process. 

8. After completing the process, Completing the Stellar Toolkit for Outlook Setup Wizard window is displayed. Click 

Finish. 

Note: Clear Launch Stellar Toolkit for Outlook check box to prevent the software from launching automatically. 

Note: If you have Stellar Toolkit for Outlook application installed in your system and you have to reinstall MS 

Outlook/Office for any reason, in that case you need to reinstall the Stellar Toolkit for Outlook as well. 



 

Launching the Software 

To launch Stellar Toolkit for Outlook in Windows 10: 

 Click Start -> All apps -> Stellar Toolkit for Outlook -> Stellar Toolkit for Outlook. Or, 

 Double click Stellar Toolkit for Outlook icon on the desktop. Or, 

 Click Stellar Toolkit for Outlook tile on the start menu. 

  

To launch Stellar Toolkit for Outlook in Windows 8.1 / 8: 

 Click Stellar Toolkit for Outlook tile on the home screen. Or, 

 Double click Stellar Toolkit for Outlook icon on the desktop. 

  

To launch Stellar Toolkit for Outlook in Windows 7: 

 Click Start -> Programs -> Stellar Toolkit for Outlook -> Stellar Toolkit for Outlook. Or, 

 Double click Stellar Toolkit for Outlook icon on the desktop. Or, 

 Click Stellar Toolkit for Outlook icon in Quick Launch. 

 

 

  



 

User Interface 

After launching the software, the main user interface appears as shown below:  

  



 

Ordering the Software 

To know more about Stellar Toolkit for Outlook, visit https://www.stellarinfo.com/email-tools/outlook-toolkit.php  

To purchase the software online, please visit https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php 

Alternatively, click on Buy Online icon in menu bar to purchase the software online. 

Select either of the methods given above to purchase the software. 

Once the order is confirmed, you will receive an activation key through email. You require this key to activate the software. 

https://www.stellarinfo.com/email-tools/outlook-toolkit.php
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


 

Activating the Software 

The demo version is just for evaluation purpose and must be eventually activated to use the full functionality of the software. 

An 'Activation Key' is required to activate your copy of the software and save data. You will receive an activation key through 

email after purchasing the software. 

Note: Make sure that you have an active Internet connection. 

Steps to activate the software: 

1. Run Stellar Toolkit for Outlook. 

2. Click the Activation button on the menu bar. A window, as displayed below, pops up on the screen. 

 

Note:  

 If you don't have the activation key, click Get it now button in the window to go online and purchase the 

product. 

 Once the order is confirmed, an Activation Key is provided. 

4. Enter the Activation Key and click Activate button.      

 

5. The software is activated after successful verification of the activation key you have entered.  

6. 'Activation Completed Successfully' message is displayed after the process is completed successfully. Click OK to 

use all the options of the software that have been unlocked after the activation.  



 

Updating the Software 

Stellar releases updates for Stellar Toolkit for Outlook. You can update the software to keep it up-to-date. These updates 

can add new functionality, feature, service, or any other information that can improve the working of the software. The 

update option of the software is capable of checking for the latest updates. This will check for both latest, minor and major 

versions available online. While updating the software, it is recommended to close all the running programs. 

Steps to update the software: 

1. Run Stellar Toolkit for Outlook. 

2. Select the update button from software menu. Update Wizard window pops up. 

3. The wizard will start searching for the latest updates: 

i. If the new version is found a window will pop up indicating the availability of an update.  

ii. If no update is available then it indicates that the software is up-to-date.  

5. If the update is available, click Next and the software will start downloading and installing update files from the 

server.  

6. When the process is completed, the software is updated to the latest version. Click Finish. 

Live Update may not happen due to following reasons: 

 Internet connection failure. 

 Unable to download configuration files. 

 Unable to locate updated files or version. 

 Unable to locate executable file. 

 



 

Stellar Support 

Our Technical Support professionals will give solutions for all your queries related to Stellar products. 

 You can either call us or go online to our support section at http://stellarinfo.com/support/ 

 For price details and to place the order, click https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php 

 Chat Live with an Online technician at http://stellarinfo.com/support/ 

 Search in our extensive Knowledgebase at https://www.stellarinfo.com/support/kb/index.php/category/outlook-

manager 

 Submit enquiry at http://www.stellarinfo.com/support/enquiry.php 

 Send e-mail to Stellar Support at support@stellarinfo.com 

 

 
  

http://www.stellarinfo.com/support/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
http://www.stellarinfo.com/support/
https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/support/enquiry.php
mailto:support@stellarinfo.com?


 

 
 

  

  

 

 

  

 

Stellar Repair for Outlook - Technician 

User Guide for Version 11.0



 

 

1. About Stellar Repair for Outlook - Technician 

Stellar Repair for Outlook - Technician offers a complete solution to repair damaged Microsoft Outlook Personal Storage 

(PST) files. 

The software repairs corrupt PST files and restores all its content such as e-mails, attachments, contacts, calendars, tasks, 

journals and also repair accidently deleted or lost Mailbox items. This minimizes the loss from the PST corruption. Stellar 

Repair for Outlook - Technician scans and extracts data from a damaged PST file, repairs it and then saves it as a new 

usable PST file. To view repaired items, you need to import the new PST file into MS Outlook. 

Stellar Repair for Outlook - Technician also ensures recovery of accidentally deleted e-mails that you have emptied from 

the deleted items folder. After recovering the PST file, the software shows its original content. All folders from the original 

PST file get displayed along with their content in a three-pane structure. 

Key features: 

 Supported Output Formats: Repair and export PST files to Microsoft Office 365, Existing Outlook Profile or save in 

PST, MSG, EML, RTF, PDF, HTML, DBX and MBOX format. 

 Encrypted Files Support - Supports repair of encrypted PST files. 

 Recover Deleted E-mails - Supports recovery of deleted items. The application also provides preview of the deleted 

items marked with red color. 

 Preview Option: Provides preview of mails and items such as - Attachments, Calendar, Contacts, Tasks, Notes, and 

Journal. 

 Compress and Split PST files - Option to compress or split the files and save in PST file format. 

 Quick Save Option - Right-click and save individual mails in MSG, EML, RTF, HTML, and PDF from preview section. 

 Selective Repair - Provides option to only save selected mailbox folders as per requirement. 

 Find Option - Provides search option to find emails faster.  

 Resume Function - Option to save scanned information to resume the process at a later stage.  

 Source PST File Support - Repairs corrupt MS Outlook 98, 2000, 2002, 2003, 2007, 2010, 2013, 2016 and 2019 PST 

files. 

 MS Office Support - Supports MS Office 365, 2019, 2016, 2013, 2010 and 2007. 

 Operating System - Compatible with Windows 10, Windows 8.1, Windows 8 and Windows 7. 

  



 

 

2. User Interface 

Stellar Repair for Outlook - Technician has a simple and easy to use Graphical User Interface (GUI). The GUI of the 

software resembles the GUI of MS Office 2016. 

After launching the software, the main user interface appears as shown below: 

 

The user interface contains Ribbons, Buttons and Preview Tabs that allow you access various features of the software with 

ease. 



 

 

2.1. Ribbons 

1. File Menu 

 

 Select Outlook PST: Use this option to select/search for PST file.  

 Save Repaired File: Use this option to save the repaired PST file at your specified location. 

 Exit: Use this option to close the application. 

2. Home Ribbon 

 

 Select Outlook PST: Use this option to select/search for PST file.  

 Save Repaired File: Use this option to save the repaired PST file at your specified location. 

 Find Message: Use this option to search for specific emails and messages from the list of the scanned emails. 

 Save Scan: Use this option to save the scanned information of files. 

 Load Scan: Use this option to load the saved scan file. 

  



 

 

3. View Ribbon 

 

 Switch Reading Pane: Use this option to switch between horizontal and vertical views of the reading pane. 

 Log Report: Use this option to view the log report. 

4. Tools Ribbon 

 

 Relink Attachments: Use this button to relink the attachment folder 

 Update Wizard: Use this option update your software. 

5. Calendar Ribbon 

 

 Day: Use this option to list all the entries of a particular day from the calendar. 

 Work Week: Use this option to list all the entries of a work week (from Monday to Friday). 

 Week: Use this option to list all the entries of a week (from Monday to Sunday). 

 Month: Use this option to list all the entries of a particular month. 

 GoTo: Use this option to list all the entries of the current date or any particular date. 

  



 

 

6. Activation Ribbon 

 

 Activation: Use this option to activate the software after purchasing the software. 

7. Help Ribbon 

 

 Help Topics: Use this option to open the help manual of the software. 

 Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com 

 Support: Use this option to visit the support page of stellarinfo.com 

 About: Use this option to read information about the software. 

8. Buy Now Ribbon 

 

 Buy Online: Use this option to buy Stellar Toolkit for Outlook. 

9. Style Menu 

 

 Style: Use this option to switch between various themes for the software, as per your choice. Stellar Repair for 

Outlook - Technician offers the following themes: Office 2016 Colorful Theme, Office 2016 White Theme. 

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


 

 

2.2. Buttons 

Stellar Repair for Outlook - Technician toolbar has following buttons/options: 

 

Click this button to open Select PST File for Repair window. 

 

Click this button to save the repaired PST file to a location of your choice. 

 

Click this button to switch between horizontal and vertical views of the reading pane. When you click 

on a folder in left-pane, by default, the right pane shows the details in horizontal columns position. 

You can click Switch Reading Pane icon to change the position to vertical columns. 

 

Click this button to view the log report, which contains the details of the repairing process. 

 

Click this button to open Find Message dialog box, using which you can search for specific emails 
using sender's email, recipient's email, subject, or date. 

 

Click this button to save scanned information of files. 



 

 

 

Click this button to load the saved scan files. 

 

Use this button to relink the attachment folder 

 

Click this button to update your software. Use this option to check for both, major and minor versions 
of the software. 

 

Click this button to list all the entries of one particular day from the calendar. 

 

Click this button to list all the entries of a work week (from Monday to Friday). 

 

Click this button to list all the entries of a week (from Monday to Sunday). 

 

Click this button to list all the entries of a particular month. 

 

Click this button to list all the entries of the current date. 



 

 

 

Click this button to list all the entries of a particular day (any single day except the current date). 

 

Click this button to activate the software after purchase. 

 

Click this button to open the help manual for Stellar Repair for Outlook - Technician. 

 

Click this button to purchase the software. 

 

Click this button view the support page of stellarinfo.com. 

 

Click this button to visit the knowledgebase articles of stellarinfo.com 

 

Click this button to read more information about the software. 

  

https://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
https://www.stellarinfo.com/


 

 

2.3. Preview Tabs 

Stellar Repair for Outlook - Technician provides options to navigate between Mails, Calendar, Contacts, Tasks, 

Journal and Notes views at the bottom of the left pane. It also allows to reset/modify the Navigation Pane Options. 

 

 Click on Mail icon to view the mails of the scanned mailbox. 

 

 Click on Calendar icon to view the Calendar functions scanned mailbox. It displays the schedules in an 

organized and efficient manner. 

 



 

 

Calendar function also allows to efficiently display the schedule for a day, work week, week, or month. 

 

Click this button to list all the entries of one particular day from the calendar. 

 

Click this button to list all the entries of a work week (from Monday to Friday). 

 

Click this button to list all the entries of a week (from Monday to Sunday). 

 

Click this button to list all the entries of a particular month. 

 

Click this button to list all the entries of the current date, or of a particular day (any single day 
except the current date). 

  

 Click on Contacts  icon to view the contacts of the scanned mailbox. 



 

 

 

 Click on Tasks icon to view the tasks of the scanned mailbox. 

 

 Click on Journal icon to view the created journal entries of the scanned mailbox. 



 

 

 

 Click on Notes icon to view the notes of the scanned mailbox. 

   

 Click on  and select Navigation Pane Options. This will open the Navigation Pane Options window. 

  

 

 



 

 

To modify/reset the navigation pane options: 

 

o       Check/ uncheck the preview tab that you want to add/ remove from the list. 

o       Click Move Up/ Move Down button to modify the order of the preview tabs. Move Up button will shift the 

desired tab upwards and Move Down button will shift the desired tab downwards in the list. 

o       Click Reset to go back to the default list of preview tabs. 

o       Click OK to save the changes. 

  



 

 

3. Working with the Software  

3.1. Select and Repair PST File 

3.2. Preview Repaired PST File  

3.3. Find, View and Save a Single Message 

3.4. Save Repaired PST File 

3.5. Relink Attachment Folder 

3.6. Save Log Report 

3.7. Save and Load Scan Information 



 

 

3.1. Select and Repair PST File  

If you know the location of PST files, then you can directly specify the location and start repairing e-mails from that file. If 

you do not know the location, then you can search the required PST file by using the search functionality of Stellar Repair 

for Outlook - Technician software. 

Steps to select and repair PST file:   

1. Run Stellar Repair for Outlook - Technician. 

2. Select PST File for Repair window appears when the application opens. Alternatively, you can also open Select 

PST File for Repair window from File menu or Home ribbon. 

 

3. There are two options to select PST file: Browse and Find: 

(i) Browse: Use Browse button if you exactly know the location of the PST file on your system.  

a) Click Browse. Locate and select the PST file and click Open.   

b) Once the PST file is selected, click Repair to start the repairing process. 

 



 

 

c) Once the process is completed a Repair Complete dialog box appears with a message, "Selected PST 

file repaired". 

d) Click OK. 

  

(ii) Find: Using Find button you can search for PST files on your system's drives, folders, and sub folders.  

 

a) Click Find, Find PST File window appears.  

b) Select the drive from the drop down list you want to search for PST file. However, you can only select one 

drive at a time.  

c) If you want to select a folder from a particular drive, Click Look in and select the folder. 

d) If you want to include sub folders of the selected drive/folder in your search, select Search Subfolders 

checkbox.   

e) Click Find button to start the search process. 

f) If you wish to stop the search process, click Stop. 

g) After the search is finished, Find Complete dialog box appears with the number of PST files found. Click 

OK. 



 

 

h) The list of PST files found in the selected drive/folder is displayed in the Results section. Select the file you 

want to repair, only one file can be selected at a time. 

Note: If you want to clear the search result, click Clear List. 

i) Click Repair button to start the repairing process. 

j) Once the process is completed a Repair Complete dialog box appears with a message, "Selected PST file 

repaired". 

k) Click OK. 

After the repair process is complete, the application provides preview of the repaired PST files. See Preview Repaired 

PST Files, for more details. 



 

 

3.2. Preview Repaired PST File    

Stellar Repair for Outlook - Technician shows the preview once the PST file is repaired. The preview of the mailbox 

data is available in a three pane structure containing: Left pane, Middle pane and Right pane, which are explained below 

with details: 

 

 The left pane provides the navigation tree, displaying the files with its mailboxes, folders and sub-folders. Select 

the desired mailbox/folder/sub-folder from this pane. 

 The middle pane provides a list of mailbox items, in a tabular format, of the selected mailbox/folder/sub-folder. 

The pane contains the following columns: 

o Deleted icon: It shows the deleted mails of the selected mailbox, in red color.  

o Importance icon: It signifies that the particular mail is sent with high importance.   

o Type: It shows the type of mail item it has. 

o Attachments: Shows an attachment icon if the particular mail item contains an attachment.  

o From: Shows the e-mail address of the sender. 

o To: Shows the e-mail address of the receiver. 

o Subject: Shows the e-mail subject. 



 

 

o Date: Shows the date and time when the e-mail was sent. 

Tip: You can change the order of the above given columns as per your requirement. Click and hold on the column 

name and drag the column to the desired location to change it.  

 The right pane provides the preview of the mail item that you select from the middle pane. It shows the following 

information:  

o Subject: Shows the subject of the e-mail.  

o From: Shows the e-mail address of the sender. 

o To: Shows the e-mail address of the receiver. 

o Attachments: Shows the attachments of the selected mailbox item.  

o Body: Shows the preview of body of the selected mail item.   

Note: To switch between vertical and horizontal reading panes, click Switch Reading Pane icon in View ribbon. 

Additional Options: 

 Quick search: The software provides quick search options for Mails. In the middle pane below the table headings, 

type the keywords in the search bar of a particular column. The columns that support quick search are From, To, 

Subject, and Date.  

 

 Sorting columns: You can sort the mails and media items using the table headers in the middle pane. Click on the 

column heading to sort the column in ascending order. Click on the same heading again to change the sorting order 

from ascending to descending and vice versa. 



 

 

 

Alternatively, you can right click on the column and arrange it accordingly by using Arrange By option. It can be 

arranged by Date, From, To, Subject, Type, Attachment, Deleted, Importance or Show in Groups option.   

 



 

 

3.3. Find, View and Save a Single Message   

Stellar Repair for Outlook - Technician allows you to find and repair a particular message from the PST file. The software 

offers a Find Message feature, which helps you narrow the search using various search options. You can save a message 

directly from the search result in MSG, EML, RTF, HTML, PDF format. 

To find messages: 

1. Click Find Message in Home ribbon. Find Message window opens. 

2. Specify the search criteria in Find Message window: 

 In To field, specify all or few characters of email ids of recipients. Keywords should get separated by a 

semicolon (;). 

 In From field, specify all or few characters of email ids of senders. Keywords should get separated by a 

semicolon  (;). 

 In Subject field, specify the subject that you need to search. 

 If you want to search for emails sent or received on a particular date, select Select Date Field checkbox, 

and select date from Date drop box. 

3. Click Find Now button to start the search. 

 

To view messages: 

1. After the search is complete, a list of emails that match the search criteria gets displayed. 



 

 

2. Double-click on an email to open it in a new window. 

To save messages: 

To save any message from the search result list, right-click on it and: 

 Select Save as MSG to save the message in MSG format. 

 Select Save as EML to save the message in EML format. 

 Select Save as RTF to save the message in RTF format. 

 Select Save as HTML to save the message in HTML format. 

 Select Save as PDF to save the message in PDF format. 

  



 

 

3.4. Save Repaired PST File    

There are many options to save repaired file. Refer to the following topics as per your requirement:  

 Save as PST Format 

 Export to Office365 

 Export to Existing Outlook Profile 

 Save as MSG, EML, RTF, HTML, PDF, DBX or MBOX format 

  



 

 

3.4.1. Save as PST Format 

Stellar Repair for Outlook - Technician allows you to save the repaired mails to a new PST file. The application 

provides options to compress, split and filter PST file before saving. 

Here are the steps to save as PST format: 

1. Run Stellar Repair for Outlook - Technician.  

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

 

4. Select New PST from the Save Options. 

There are three advance options to save repaired file: 

i) Save PST Normally - This option is selected by default. Use this option to save repaired file to a new PST file 

without any additional changes. 

ii) Compact and Save PST - Use this option to compress the PST file and decrease the size acquired by the file on 

the disk. 

iii) Split/Filter and Save PST - Use this option to split/filter the repaired PST file as per your requirement. 

5. Click Browse to browse and select the destination path to save the repaired file. Click OK. 



 

 

6. Click OK on the Save As window to start the saving process.  

7. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired file 

is saved and the size of the repaired file. 

8. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

9. Click OK. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file. 

  



 

 

3.4.1.1. Compact and Save PST File    

Stellar Repair for Outlook - Technician, compact and save PST file feature compresses the PST file and decrease the 

size acquired by them in the disk. This enhances the greater use of memory and also saves PST file from being corrupted. 

There are four options to compact and save PST file. Refer to the following options as per requirement:    

1. Compress all attachments in new PST 

2. Extract and save attachments to a folder (No interlinking is lost) 

3. Extract, compress and save attachments to a folder (No interlinking is lost) 

4. Remove all attachments to new PST 



 

 

3.4.1.1.1. Compress all attachments in new PST  

You can use this option to compress all the attachments of the emails in the new repaired PST file. The compressed 

attachments remain in the repaired PST file. 

Here are the steps to compress all attachments in a new PST file:  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section, select Compress all attachments in new PST. 

     

7. From Other Options section of the window, select 

 Empty 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Empty 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 

8. Click OK, and you will go back to Save As window. 



 

 

9. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

10. Click OK on the Save As window to start the saving process.  

11. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file. 

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  

  



 

 

3.4.1.1.2. Extract and save attachments to a folder (No 

interlinking is lost) 

You can use this option to extract attachments from the PST file and then save them in a new folder in their original form. 

A shortcut to the extracted attachments remain in the repaired PST file. This option will extract attachments to a new folder 

without making any changes to the content or the attachments of the original PST file. 

Here are the steps to extract and save attachments of a PST file to a folder (No interlinking is 

lost):  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section of the window, select Extract and save 

attachments to a folder (No interlinking is lost). 

     

7. From Other Options section of the window, select 

 Empty 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 



 

 

 Empty 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

10. Click OK on the Save As window to start the saving process.  

11. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: If you want to know how to relink attachments, click 'How to relink attachment folder?'  

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  



 

 

3.4.1.1.3. Extract, compress and save attachments to a 

folder (No interlinking is lost)  

You can use this option to extract attachments from the PST file, compress them and then save them in a new folder in a 

compressed format. A shortcut to the extracted attachments remain in repaired PST file. 

Here are the steps to extract, compress and save attachments of a PST file to a folder (No 
interlinking is lost):  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window will open, from Compact Options section of the window, select Extract, compress and 

save attachments to a folder (No interlinking is lost) option.  

 

7. From Other Options section of the window, select 

 Empty 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 



 

 

 Empty 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

10. Click OK on the Save As window to start the saving process.  

11. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: If you want to know how to relink attachments, click 'How to relink attachment folder?'  

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  



 

 

3.4.1.1.4. Remove all attachments in new PST  

You can use this option to remove all the attachments in repaired PST file. This option retains only the mail but not any of 

its attachments. No changes are made to the original PST file. 

Here are the steps to compact a PST file: 

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window will open, from Compact Options section of the window, select Remove all attachments 

in new PST option. 

     

7. From Other Options section of the window, select 

 Empty 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Empty 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder.  

8. Click OK, and you will go back to Save As window. 



 

 

9. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

10. Click OK on the Save As window to start the saving process.  

11. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  

  



 

 

3.4.1.2. Split/Filter and Save PST File  

Stellar Repair for Outlook - Technician allows you to split/ filter the repaired PST file as per some requirements.  

There are three options to split/filter and save PST file. Refer to the following options as per requirement:   

1. Filter by Mail ID  

2. Filter by Date Range 

3. Split by Size 

  



 

 

3.4.1.2.1. Filter by Mail ID   

Stellar Repair for Outlook - Technician allows you the feature to split/filter the files by Mail ID. To Filter By Mail ID, you 

must always select at least one mail Id for filtering the PST file.  

Here are the steps to filter a PST file by Mail ID:  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Filter By Mail ID section, select e-mail ids under Mail ID scroll box to filter the PST file according to e-

mail ids. Alternatively, you can also use the Select All / Unselect All buttons to select/unselect all the email 

ids. All selected email ids will be stored in the repaired PST file, and no change is needed to be done in the 

source PST file. 

6. Click Apply Settings, and you will go back to Save As window. 



 

 

7. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

8. Click OK on the Save As window to start the saving process.  

9. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter options checkboxes (By Mail Id, By Date Range, and By Size), the 

application will queue them and will split/filter PST files using all the three methods. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file. 



 

 

3.4.1.2.2. Filter by Date Range    

Stellar Repair for Outlook - Technician allows you the feature to Filter the file by Date Range. Filtering a PST file 

according to date range will create a single PST file which will have data as per the criteria selected by you.  

Here are the steps to filter a PST file by Date:  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Filter By Date Range section, select Filter By Date Range checkbox and then select either of the two options: 

         Select in the last radio option if you want to split the PST file according to months. All e-mails that are sent 

and received in the specified months will get stored in the repaired PST file. 

         Select between radio option if you want to split the PST file according to a specific period. All e-mails from 

the specific period will get stored in the repaired PST file. Select the start and end date from the list boxes. 



 

 

6. Click Apply Settings, and you will go back to Save As window. 

7. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

8. Click OK on the Save As window to start the saving process.  

9. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter option checkboxes (By Mail Id, By Date Range, and By Size), the application 

will queue them and will split PST files using all the three methods. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  



 

 

3.4.1.2.3. Split by Size    

Stellar Repair for Outlook - Technician allows you the feature to split PST file by size. Splitting a PST file by size means 
that you can split a PST file into many PST files to the maximum size of 50 GB.  

Here are the steps to Split a PST file by size:  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. Select New PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Split By Size section, select Split By Size checkbox. You can split the PST file to a maximum size of 50 GB. 

Either enter the digit or using upward or downward arrow set the number as per your requirement. With this option 

you will get multiple split PST files. 

Note: For large files, Stellar Repair for Outlook - Technician automatically splits the new PST file in small sizes. The 

size of the split files will depend on the version of Outlook installed on your computer: 

 If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 



 

 

 If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB 

of size. 

6. Click Apply Settings, and you will go back to Save As window. 

7. Click Browse to browse and select the destination path to save the repaired file. Click OK. 

8. Click OK on the Save As window to start the saving process.  

9. Once the process is completed, Saving Complete dialog box appears. It shows the path where the PST repaired 

file is saved and the size of the repaired file. 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter option checkboxes (By Mail Id, By Date Range, and By Size), the application 

will queue them and will split PST files using all the three methods. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  



 

 

3.4.2. Export to Office365    

Stellar Repair for Outlook - Technician also allows you a feature to save repaired file as Office365 format.  

Here are the steps to save file as Office365 format:  

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

 

4. Select Office365 from Save Options section and click OK. An Office 365 Login Details window appears. 

5. Enter Mail ID and Password in Office 365 Login Details.  

6. Click OK to continue and it starts the saving process.  

 



 

 

Note:   

 You need to have a Microsoft Office 365 user account for exporting data to Office 365 format. 

 To save mailbox data in Office 365 format, you need to install Office 2019 or Office 2016 or Office 2013 or 

Office 2010 with service pack2. 

 For Domain systems, you cannot export offline data to Office 365. 

 Online mailbox data cannot get exported to Office 365. You can only export your offline mailbox data to Office 

365. 

 Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file. 

 Close Microsoft Outlook, if open, before saving the repaired PST file.  

  



 

 

3.4.3. Export to Existing Outlook Profile    

Here are the steps to export PST file to Existing Outlook profile: 

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. From Save Options section, choose Existing Profile. 

 

5. Select Outlook Profile window is displayed. Select an Outlook profile from the list of MS Outlook profiles shown. 

 



 

 

6. Click OK. 

7. If the Outlook profile is password protected, Enter Password window will appear. Enter the password and click 

OK. 

8. This will take you back to the Save As window, click OK to start the saving process. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file. 



 

 

3.4.4. Save as MSG, EML, RTF, HTML, PDF, DBX and 

MBOX format    

Stellar Repair for Outlook - Technician allows you to save the repaired file in MSG, EML, RTF, HTML, PDF, DBX and 

MBOX formats. The mail items can be saved with specific names such as subject of the email, date of the email and sender, 

using the Naming Convention option provided by the software. Naming Convention is only applicable to MSG, EML, 

RTF, HTML and PDF formats. 

Note: Your repaired PST file can only be saved in DBX format if you are using Windows XP and have Outlook Express 

installed in your system. 

Here are the steps to save the repaired file: 

1. Run Stellar Repair for Outlook - Technician. 

2. See Select and Repair PST File, to know how to select and repair the corrupt file. 

3. Click Save Repaired File from Home ribbon to open a Save As window. 

4. From Save Options select any one of the formats: MSG, EML, RTF, HTML, PDF, DBX or MBOX.   

5. If you select MSG, EML, RTF, HTML or PDF, Naming Convention section appears: 

 

 From Naming Convention section, select any one from the following options: 



 

 

o Subject - The repaired file will be saved with the name as the respective email message's subject. 

o Subject + Date(DD-MM-YYYY) - The repaired file will get saved with the name as the respective email 

message's subject, and date. 

o Date(YYYY-MM-DD) + Subject - The repaired file will get saved with the name as the respective email 

message's date, and subject. 

o From + Subject + Date(YYYY-MM-DD) - The repaired file will get saved with the name as the respective 

email message's sender, subject, and date. 

o Date(DD-MM-YYYY) + From + Subject - The repaired file will get saved with the name as the respective 

email message's date, sender, and subject. 

o Date(YYYY-MM-DD) + From + Subject - The repaired file will get saved with the name as the respective 

email message's date, sender and, subject. 

o Date(MM-DD-YYYY) + Subject + From - The repaired file will get saved with the name as the respective 

email message's date, subject, and sender. 

6. Select a Destination Path using Browse button to specify where to save the repaired file. 

7. Click OK. A window appears and shows the status of Saving in progress. 

8. After successful saving completion a Saving Complete dialog box appears with a message, "Selected messages 

saved successfully".  

9. Click on 'Open containing folder' link to view the saved messages. 

Note: Select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file.  

Note: Close Microsoft Outlook, if open, before saving the repaired PST file.  



 

 

3.5. Relink Attachment Folder  

You need to relink the attachment folder when you move it after using Extract and save attachments to a folder (No 

interlinking is lost) or Extract compress and save attachments to a folder (No interlinking is lost) option. 

To do this: 

1. Click Relink Attachments from Tools ribbon.  

 

2. Click on Select PST and Select Folder button to browse to and select the repaired PST file, and its attachment folder. 

3. Click on Relink button to relink the attachments to the emails. 

Note: You can move the attachments folder to a different location on the same local machine, or you can move both 

the repaired PST file and the attachments folder to another machine.  



 

 

3.6. Save Log Report 

With Stellar Repair for Outlook - Technician, you can save the Log Report to analyze the repairing process at a later 

stage.  

Here are the steps to save log report: 

1. From View ribbon, select Log Report. 

2. In Log Report window, click Save Log. 

 

3. In Save As window, specify the location where you want to save the log file. Click Save. 



 

 

3.7. Save and Load Scan Information  

This option allows you to save the scanned information of files using "Save Scan Info" option and later load the saved 

scan ( .DAT) file using "Load Scan Info" option. This saves time in restoring data as we do not need to scan the corrupt 

PST file again. 

Here are the steps to save scan information from the corrupt PST file:  

1. From the Home ribbon, select Save Scan Info. 

         

2. Save Scan Information window will open. Browse to the folder where you want to save the scan information and 

click OK. The information will get saved in .DAT file format. 

3. A message box appears, click OK. 

Load Scan Information 

This option is used to start repairing procedure from saved scan information or.DAT file. 

Here are the steps to load scan information of the corrupt PST file:  

1. To load the scan information click on Load Scan Info option from the Home ribbon. 



 

 

 

2. Load Scan window will appear. It displays a list of saved scan information file existing in the system. 

3. In case the file you desire is not in the list, click Add button and select the desired DAT file. 

4. Click Open. 

5. The file you added is displayed in the load scan window. Click Remove button if you want to remove the save scan 

(.DAT) file. 

6. Click Reset button to reset the load scanned list. 

7. Click Load Scan button. 

8. A message box appears, click OK. 

Note: You can select only one file at a time to start the process of scanning. 



 

 

3.8. Import PST file in Microsoft Outlook  

To import PST file in Microsoft Outlook 2019 / 2016 / 2013: 

1. Open Microsoft Outlook. From File Menu, select Open & Export. 

2. Select Import / Export option from the right pane. 

3. From Import and Export Wizard window, select Import from another program or file, click Next. 

4. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

5. Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

6. In Import Outlook Data File dialog box, select the folders that should get imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2010: 

1. Open Microsoft Outlook. From the File Menu, select Open -> Import. 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Outlook Data File (.pst), click Next. 

4. Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

5. In Import Outlook Data File dialog box, select the folders that should get imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2007 : 

1. Open Microsoft Outlook. From the File menu, select Import and Export. 

2. From Import and Export Wizard window, select Import from another program or file, click Next. 

3. In Import a File dialog box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

5. In Import Personal Folders dialog box, select the folders that should get imported in Microsoft Outlook. Click 

Finish. 



 

 

4. Frequently Asked Questions (FAQs)  

1. What does Stellar Repair for Outlook - Technician do? 

The software repairs corrupt PST files and restores all its data such as e-mails, attachments, contacts, calendars, notes, 

tasks and journals. Stellar Repair for Outlook - Technician provides the preview all scanned data and gives options 

to export data to Existing Outlook Profile, Office365 or save in PST, MSG, EML, RTF, HTML, PDF, DBX and 

MBOX format.  

2. I have forgotten the path of my PST file. Can this application search it for me? 

Yes, the application can look for PST file on your system and find it for you easily. There is a dedicated Find option in 

the application through which you can locate a particular PST and run a repair on it. 

3. I had run the demo and can see preview correctly in PST Repair software window. Do I need to rescan the 

corrupted file? 

Not at all, through the Demo version, you can preview repaired file after scanning. This special feature has been included 

in the tool to make sure that you can first preview the repair results on your damaged PST file and only after you are 

satisfied with the results, you should decide on making the purchase and saving your repaired files. 

4. I want to recover permanently deleted emails from my Outlook. Will your PST Repair software help? 

Yes, the software scans and recover your permanently deleted emails from Outlook. You can preview the deleted items 

before saving as well. These deleted items will be shown in red color while previewing. 

5. Can we exclude the deleted items from the recovered mailbox while saving? 

Yes, select the checkbox "Do not recover Deleted Items" to exclude the deleted items from the repaired file. 

6. How much time will the Outlook PST Repair software take to repair a PST file? 

The scanning time depends upon the corruption level, size of PST file and also on the number of mailbox items in the 

mailbox. If the process is running, that means that software is still scanning the corrupted file and you have to wait for 

this scanning process to complete. Once scanning gets completed, you will be able to save the repaired file at the 

desired location. 

7. I got an error "Invalid PST file" while scanning. What could be the reason?  

There could be the following reasons for this error message:  

 The PST file is severely corrupted or is not in a repairable state. 

 The PST file is not a valid file. 



 

 

 The file could not be accessed. 

8. I have repaired my corrupt PST file. But I’m unable to find my contacts. How can I find them? 

You can easily locate and access your contacts by following these simple steps: 

 Import your repaired PST file into MS Outlook. 

 Open MS Outlook. 

 Then press "Ctrl+Shift+F". 

 "Find Message / Advanced Find" window will open. Please select "Contacts" under "Look For" tab. 

 Click on the "Browse" button and select the imported PST file. 

 Then, click "Find Now." 

 Now you will be able to see all the contacts that you were able to preview with software’s Demo Version. You 

may select the entire contacts listed and drag it to your original contacts list, so that you may use it further. 

9. Can I repair a corrupt PST file of size more than 2 GB? 

Absolutely yes, this tool is capable of repairing PST files that are more than 2 GB. Please download the demo version 

and scan your PST file. You can preview all emails and other mailbox items which can get recovered through this tool. 

10. I want to analyze the repair process. Can I see the log report at a later stage? 

Certainly. The application gives you an option to save and view log reports at any point in time. To view and save log 

reports follow the following steps: 

 On View ribbon, select 'Log Report.' 

 In Stellar Repair for Outlook - Technician window, click 'Save Log' and save it at the desired location for 

viewing at any time. To know more refer to Log Report. 

11. Should Microsoft Outlook be installed in my system while I repair my PST file and it works well with which 

version?  

Microsoft Outlook is not required while repairing and previewing PST file, but must be installed in your system to use 

the saving options. The software is compatible with the following versions:  

Microsoft Outlook: Office 365 / 2019 / 2016 / 2013 / 2010 / 2007. 

 

 



 

 

12. What does the compact feature of Stellar Repair for Outlook - Technician do? 

As the name suggests, the compact feature of Stellar Repair for Outlook - Technician application helps in reducing 

the size of PST files and attachments on MS Exchange Server. It has various options for attachments of emails that 

can get selected for compaction and extraction. 

13. Why do I need to compact PST files? 

MS Outlook stores all data like e-mails, personal data, calendar, tasks, etc. in a PST file. Eventually, the file becomes 

oversized. Such PST files are prone to corruption, so you need to compact them. Stellar Repair for Outlook - 

Technician has a compaction feature using which you can compact the PST file. 

14. Can I extract all my attachments in a separate folder while compacting the PST file? 

Yes, you can extract the attachments in a separate folder. To do this, choose the Extract attachments and leave 

shortcuts in emails in Compacting Option before starting the compact process. The attachments are left as shortcut 

links in the mails. 

15. Can I restore the links to attachments to the PST file? 

Yes, you can restore the links by using the Relink Attachment Folder. You need to relink the attachment folder when 

you move it after using Extract and save attachments to a folder (No interlinking is lost) or Extract, compress and save 

attachments to a folder (No interlinking is lost) option. 

16. I want to run the software on select folders of the PST file. Can I choose some selected mailbox folders in the 

application? 

Yes, you can apply extraction and compaction settings on only the selected folders of the PST file. 

17. I repaired my PST file, but I’m unable to open my Outlook after repair. How can I solve this problem? 

That can happen, but we are sure if you follow the steps below you can easily resolve this: 

 Open Windows -> Control Panel. 

 Double-click Mail. In Mail Setup window, select E-mail Accounts to configure your email account. 

 After configuring, close the window and open MS Outlook. 

 To view the repaired PST file, you can either select Open -> Outlook Data File from File ribbon or, Import the 

PST file in MS Outlook. 

18. In how many ways can I split a PST file using Stellar Repair for Outlook - Technician software? 

There are three ways in which you can split a PST file using Stellar Repair for Outlook - Technician software. They 

are as follows: 



 

 

o By Mail Id - You can select e-mail ids under Mail Ids scroll box to split the PST file according to e-mail ids. 

Alternatively, you can also use the Select All/Unselect All buttons to select/unselect all the email ids. All 

selected email ids will be stored in the repaired PST file, and no change is made to the source PST file. To 

know more refer to Filter by Mail ID 

o By Date Range - You can select Split By Date Range checkbox and then select either of the two options: 

o Select the last radio option if you want to split the PST file according to months. All e-mails that are 

sent and received in the specified months will get stored in the repaired PST file. 

o Select between radio option if you want to split the PST file according to a specific period. All e-mails 

from the specific period will get stored in the repaired PST file. Select the start and end date from the 

list boxes.  To know more refer to Filter by Date Range 

o By Size - You can select Split by Size checkbox and then split the PST file to a maximum size of 50 GB. Either 

enter the digit or using upward or downward arrow set the number as per your requirement. With this option, 

you will get multiple split PST files. To know more refer to Split by Size 

Note: In case you select all the three split option checkboxes (By Mail Id, By Date Range and By Size), the application 

will queue them, and will split PST files using all the three methods. 

19. I have a PST file exceeding 50 GB of size, does the new PST file generated will have same size as that of source 

PST file? 

For large files, Stellar Repair for Outlook - Technician automatically splits the new PST file in small sizes. The size 

of the split files will depend on the version of Outlook installed on your computer: 

If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB of size. 

20. When I enter the Mail ID and Password to export data to Office365, the system shows an error. What can I do?  

The application shows error because of the following reasons: 

 If the credentials (Admin ID and Password) you have entered are incorrect. 

 The Admin credentials you have entered do not have required permissions to export data to Office365. 

 There is a connection failure with internet. In that case, check your network connection and try again. If your 

internet is working, check your firewall and anti-virus software settings for any blockage. 

 There is a server issue because of which server is not able to create a connection with Office 365. Check if you 

are able to connect to Office 365 outside the Stellar Repair for Outlook - Technician application and try again.  



 

 

21. After saving my repaired mailbox in PST format. How to view and access the mailbox items? 

After you have saved the repaired mailbox in PST format, you can import the PST file in MS Outlook. See Importing 

PST file in MS Outlook, to know how to import PST file. 
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1. About Stellar Converter for OST - Technician 

Stellar Converter for OST - Technician, offers a complete solution to convert OST file to multiple formats including all 

contents such as e-mails, attachments, contacts, calendars, tasks, notes and journals. The software also provides the option 

to split and compress mailbox while saving OST file to PST format.  

After OST file conversion, the software previews the original OST file mailbox items along with their content in a three-pane 

structure.  

Key features: 

 Supported Output Formats - Provides options to export OST file to Live Exchange Server, Office 365, Outlook Profile 

and PST formats. Also supports DBX, MBOX, MSG, EML, RTF, HTML and PDF formats. 

 Batch Conversion - Provides an option to convert multiple OST files to PST files in a single conversion cycle. 

 Selective Conversion - Provides options to only save selected emails as per requirement. 

 Encrypted Files Support - Supports the conversion of encrypted OST files. 

 Recover Deleted E-mails - Supports preview and conversion of deleted items. 

 Find Option - Provides an option to find emails faster. 

 Resume Function - Provides an option to resume the process at a later stage by saving a scan information file. 

 Compress and Split PST files - Provides an option to split or compress mailbox while saving the output in PST format. 

 Preview Before Saving - Provides a preview of converted mail items in a three-pane structure. 

 Save Contacts - Provides an option to save all contacts in CSV file format. 

 Quick Save Option - Provides an option to right-click on emails listed on the preview section to save them in MSG, 

EML, RTF, HTML and PDF formats. 

 Source OST File Support - Supports MS Outlook 2019, 2016, 2013, 2010 and 2007 OST files. 

 MS Outlook Support - Supports MS Office 365, 2019, 2016, 2013, 2010 and 2007. 



 

 

 Operating System - Compatible with Windows 10, Windows 8.1, Windows 8 and Windows 7. 

 

  



 

 

2. User Interface 

Stellar Converter for OST - Technician has a simple and easy to use Graphical User Interface (GUI). The GUI of  Stellar 

Converter for OST - Technician resembles the GUI of MS Office. 

After launching the software, the main user interface appears as shown below: 

 

The user interface contains ribbons, buttons and preview tabs that allow you to access various features of the software with 

ease. 

  



 

 

2.1. Ribbons 

1. File Ribbon 

 

 Select Outlook OST: Use this option to select/search for the OST file. 

 Save Converted File: Use this option to save the converted OST file at your specified location. 

 Exit: Use this option to close the software. 

2. Home Ribbon 

 

 Select Outlook OST: Use this option to select/search for the OST file. 

 Save Converted File: Use this option to save the converted OST file at your specified location. 

 Find Message: Use this option to search for specific emails and messages from the list of the scanned emails. 

 Save Scan: Use this option to save the scanned information of the file. 

 Load Scan: Use this option to load the saved scan file. 

 Batch Conversion: Use this option to convert multiple OST files to PST files. 

 

 

 



 

 

3. View Ribbon 

 

 Switch Reading Pane: Use this option to switch between horizontal and vertical views of the reading pane. 

 Log Report: Use this option to view the log report. 

4. Tools Ribbon 

 

 Save All Contacts as CSV: Use this option to save all contacts in CSV file format. 

 Relink Attachments: Use this button to relink the attachment folder. 

 Update Wizard: Use this option to update the software. 

5. Calendar Ribbon 

 

 Day: Use this option to list all the entries of a particular day from the list of the scanned emails. 

 Work Week: Use this option to list all the entries of a workweek. 

 Week: Use this option to list all the entries of a week. 

 Month: Use this option to list all the entries for a particular month. 

 GoTo: Use this option to list all the entries of the current date or any particular date. 

 



 

 

6. Activation Ribbon 

 

 Activation: Use this option to activate the software after purchasing. 

7. Help Ribbon 

 

 Help Topics: Use this option to open the help manual of the software. 

 Knowledgebase: Use this option to visit the Knowledgebase articles of stellarinfo.com 

 Support: Use this option to visit the support page of stellarinfo.com 

 About: Use this option to read information about the software. 

8. Buy Now Ribbon 

 

 Buy Online: Use this option to buy Stellar Toolkit for Outlook. 

9. Style Ribbon 

 



 

 

 Style: Use this option to switch between various themes for the software, as per your choice. Stellar Converter 

for OST - Technician offers the following themes: Office 2016 Colorful Theme and Office 2016 White Theme. 

  



 

 

2.2. Buttons 

Stellar Converter for OST - Technician toolbar has following buttons/options: 

 

Click this button to open Select OST File for Conversion window. 

 

Click this button to save the converted file to a location of your choice. 

 

Click this button to open Find Message dialog box, using which you can search for specific emails 
using the sender's email, recipient's email, subject, or date. 

 

Click this button to save scanned information of files. 

 

Click this button to load the saved scan files. 

 

Click this button to go to the Batch Conversion Module. 

 

Click this button to switch between horizontal and vertical views of the reading pane. When you click 
on a folder in the left-pane, by default, the right pane shows the details in the horizontal columns 
position. You can click Switch Reading Pane icon to change the position to vertical columns. 

 

Click this button to view the log report, which contains the details of the conversion process. 



 

 

 

Click this button to save all contacts in CSV file format. 

 

Use this button to relink the attachment folder. 

 

Click this button to update your software. Use this option to check for both, major and minor versions 
of the software. 

 

Click this button to list all the entries of one particular day from the calendar. 

 

Click this button to list all the entries of a workweek. 

 

Click this button to list all the entries of a week. 

 

Click this button to list all the entries for a particular month. 

 

Click this button to list all the entries of the current date. 



 

 

 

Click this button to list all the entries on a particular day (any single day except the current date). 

 

Click this button to activate the software. 

 

Click this button to open the help manual for Stellar Converter for OST - Technician. 

 

Click this button to visit the knowledgebase articles of stellarinfo.com 

 

Click this button to open stellarinfo.com online support website. 

 

Click this button to read more information about the software. 

 

Click this button to purchase the software. 

  



 

 

2.3. Preview Tabs 

Stellar Converter for OST - Technician provides options to navigate between Mails, Calendar, Contacts, Tasks, 

Notes and Journal views at the bottom of the left pane. It also allows you to reset/modify the Navigation Pane Options. 

 

 Click Mail   icon to preview all the emails saved in the selected mailbox. 

 

 Click Calendar   icon to preview the calendar saved in the selected mailbox. It displays the schedule in an 

organized and efficient manner. 



 

 

 

Calendar window displays the schedule created in the selected mailbox. 

 

Click this button to list all the entries of one particular day from the calendar. 

 

Click this button to list all the entries of a workweek. 

 

Click this button to list all the entries of a week. 

 

Click this button to list all the entries of a particular month. 

 

Click this button to list all the entries of the current date, or a particular day (any single 
day except the current date). 

  

 Click Contacts   icon to preview all the contacts saved in the selected mailbox. 



 

 

 

 Click Tasks   icon to preview all the tasks saved in the selected mailbox. 

 

 Click Notes   icon to preview all the notes saved in the selected mailbox. 



 

 

  

 Click Journal   icon to preview all the created journal entries saved in the selected mailbox. 

 

 Click   and select Navigation Pane Options. This will open the Navigation Pane Options window. 

  



 

 

To modify/reset the navigation pane options: 

 

 Check/ uncheck the preview tab that you want to add/ remove from the list. 

 Click Move Up/ Move Down button to modify the order of the preview tabs. Move Up button will shift the desired 

tab upwards and Move Down button will shift the desired tab downwards in the list. 

 Click Reset to go back to the default list of preview tabs. 

Click OK to save the changes. 

  



 

 

3. Working with the Software  

3.1. Select and Convert OST File 

3.2. Preview Converted OST File  

3.3. Find, View and Save a Single Message 

3.4. Save Converted OST File 

3.5. Relink Attachment Folder 

3.6. Save All Contacts as CSV 

3.7. Save Log Report 

3.8. Save and Load Scan Information 



 

 

3.1. Select and Convert OST File  

If you know the location of OST files, then you can directly specify the location and start the conversion of the selected file. 

If you do not know the location, then you can search the required OST file, using the find functionality of Stellar Converter 

for OST - Technician. 

Steps to select and convert OST file:   

1. Run Stellar Converter for OST - Technician. 

2. Select OST File for Conversion window appears when the software opens. Alternatively, you can open Select OST 

File for Conversion window from File menu or Home ribbon. 

  

3. There are two options to select OST file: Browse and Find: 

(i) Browse: Use Browse button if you exactly know the location of the OST file on your system.  

a) Click Browse. Locate and select the OST file and click Open.   

b) Click Convert to start the conversion process. 



 

 

 

c) After the process is completed a Conversion Complete dialog box appears with a message, "Conversion 

of selected OST file completed". 

d) Click OK. 

  

(ii) Find: Using the Find button you can search for OST files on your system's drives, folders, and subfolders.  

 



 

 

a) Click Find, Find OST File window appears.  

b) Select the drive from the drop-down list you want to search for OST file. However, you can only select one 

drive at a time.  

c) If you want to select a folder from a particular drive, Click Look in and select the folder. 

d) If you want to include sub folders of the selected drive/folder in your search, select Search Subfolders 

checkbox.   

e) Click Find button to start the search process. 

f) If you want to stop the search process, click Stop. 

g) After the search is finished, Find Complete dialog box appears with the number of OST files found. Click 

OK. 

h) The list of OST files found in the selected drive/folder is displayed in the Results section. Select the file you 

want to convert, only one file can be selected at a time. 

Note: If you want to clear the search result, click Clear List. 

i) Click Convert to start the conversion process. 

j) After the process is completed a Conversion Complete dialog box appears with a message, "Conversion 

of selected OST file completed". 

k) Click OK. 

After the conversion is complete, the software provides a preview of the converted OST file. See Preview Converted OST 

File, for more details. 



 

 

3.2. Preview Converted OST File    

Stellar Converter for OST - Technician shows the preview after the OST file is converted. The preview of the mailbox 

data is available in a three-pane structure containing: Left pane, Middle pane and Right pane, which are explained below 

in detail:  

 

 The left pane provides the navigation tree, displaying the files with its mailboxes, folders and sub-folders. Select 

the desired mailbox/folder/sub-folder from this pane. 

 The middle pane provides a list of mailbox items, in a tabular format, of the selected mailbox/folder/sub-folder. 

The pane contains the following columns: 

o Deleted icon: Shows the deleted emails of the selected mailbox, in red color.  

o Importance icon: Signifies that the particular mail is sent with high importance.   

o Type: Shows the type of mail item it has. 

o Attachments: Shows an attachment icon if the particular mail item contains an attachment.  

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 



 

 

o Subject: Shows the email subject. 

o Date: Shows the date and time when the email was sent. 

Tip: You can change the order of the above-given columns as per your requirement. Click and hold on the column 

name and drag the column to the desired location to change it.  

 The right pane provides the preview of the mail item that you select from the middle pane. It shows the following 

information:  

o Subject: Shows the subject of the email.  

o From: Shows the email address of the sender. 

o To: Shows the email address of the receiver. 

o Attachments: Shows the attachments of the selected mailbox item.  

o Body: Shows the preview of the body of the selected mail item.   

Note: To switch between vertical and horizontal reading panes, click Switch Reading Pane icon in View ribbon. 

Additional Options: 

 Quick search: The software provides quick search options for Mails. In the middle pane below the table headings, 

type the keywords in the search bar of a particular column. The columns that support quick search are From, To, 

Subject, and Date.  

 

 Sorting columns: You can sort the mails and media items using the table headers in the middle pane. Click on the 

column heading to sort the column in ascending order. Click on the same heading again to change the sorting order 

from ascending to descending and vice versa. 



 

 

 

Alternatively, you can right-click on the column and arrange it accordingly, using Arrange By option. It can be 

arranged by Date, From, To, Subject, Type, Attachment, Deleted, Importance or Show in Groups option.   

 



 

 

3.3. Find, View and Save a Single Message   

Stellar Converter for OST - Technician allows you to find and convert a particular message from the OST file. The software 

offers a Find Message feature, which helps you narrow the search using various search options. You can save a message 

directly from the search result in MSG, EML, RTF, HTML, PDF format. 

To find messages: 

1. Click Find Message in Home ribbon. Find Message window opens. 

2. Specify the search criteria in Find Message window: 

 In To field, specify all or few characters of email ids of recipients. Keywords should be separated by a 

semicolon (;). 

 In From field, specify all or few characters of email ids of senders. Keywords should be separated by a 

semicolon  (;). 

 In Subject field, specify the subject that you need to search. 

 If you want to search for emails sent or received on a particular date, select Select Date Field checkbox, 

and select date from Date dropbox. 

3. Click Find Now button to start the search. 

 



 

 

To view messages: 

1. After the search is complete, a list of emails that match the search criteria is displayed. 

2. Double-click on an email to open it in a new window. 

To save messages: 

To save any message from the search result list, right-click on it and: 

 Select Save as MSG to save the message in MSG format. 

 Select Save as EML to save the message in EML format. 

 Select Save as RTF to save the message in RTF format. 

 Select Save as HTML to save the message in HTML format. 

 Select Save as PDF to save the message in PDF format. 

  



 

 

3.4. Save Converted OST File  

There are many options to save converted file. Refer to the following topics as per your requirement:  

 Save as PST Format 

 Export to Live Exchange Server 

 Export to Office365 

 Export to Existing Outlook Profile 

 Save as MSG, EML, RTF, HTML, PDF, DBX and MBOX format 

  



 

 

3.4.1. Save as PST Format 

Stellar Converter for OST - Technician allows you to save the converted mails to a PST file. The software provides 

options to compress, split and filter PST file before saving. 

Here are the steps to save as PST format: 

1. Run Stellar Converter for OST - Technician.  

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. Select PST from the Save Options. 

There are three advance options to save in PST file format: 

i) Save PST Normally - This option is selected by default. Use this option to save converted file to a PST file 

without any additional changes. 

ii) Compact and Save PST - Use this option to compress the PST file and decrease the size acquired by the 

file on the disk. 



 

 

iii) Split/Filter and Save PST - Use this option to split/filter the PST file as per your requirement. 

5. Click Browse to browse and select the destination path to save the converted file. Click OK. 

6. Click OK on the Save As window to save the PST file.  

7. After the process is completed, Saving Complete dialog box appears. It shows the path where the converted file 

is saved and the size of the converted file. 

8. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

9. Click OK. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file. 

  



 

 

3.4.1.1. Compact and Save PST File    

Stellar Converter for OST - Technician, compact and save PST file feature compresses the PST file and decrease the 

size acquired by them in the disk. This enhances the greater use of memory and also saves PST file from being corrupted. 

There are four options to compact and save PST file. Refer to the following options as per requirement:    

1. Compress all attachments in new PST 

2. Extract and save attachments to a folder (No interlinking is lost) 

3. Extract, compress and save attachments to a folder (No interlinking is lost) 

4. Remove all attachments to new PST 

  



 

 

3.4.1.1.1. Compress all attachments in new PST  

You can use this option to compress all the attachments of the emails in the new PST file. The compressed attachments 

remain in the new PST file. 

Here are the steps to compress all attachments in a new PST file:  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section, select Compress all attachments in new PST. 

  

7. From Other Options section of the window, select 

 Ignore 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Ignore 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 



 

 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the converted file. Click OK. 

10. Click OK on the Save As window to start the conversion.  

11. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  



 

 

3.4.1.1.2. Extract and save attachments to a folder (No 

interlinking is lost) 

You can use this option to extract attachments from the PST file and then save them in a new folder in their original form. 

A shortcut to the extracted attachments remains in the new PST file. This option will extract attachments to a new folder 

without making any changes to the content or the attachments of the original file. 

Here are the steps to extract and save attachments of a PST file to a folder (No interlinking is 

lost):  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section, select Extract and save attachments to a folder 

(No interlinking is lost). 

     

7. From Other Options section of the window, select 



 

 

 Ignore 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Ignore 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the converted file. Click OK. 

10. Click OK on the Save As window to start the conversion.  

11. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: If you want to know how to relink attachments, click 'How to relink attachment folder?'  

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

Note: Close Microsoft Outlook, if open, before saving the converted OST file. 



 

 

3.4.1.1.3. Extract, compress and save attachments to a 

folder (No interlinking is lost)  

You can use this option to extract attachments from the PST file, compress them and then save them in a new folder in a 

compressed format. A shortcut to the extracted attachments remains in the new PST file. 

Here are the steps to extract, compress and save attachments of a PST file to a folder (No 

interlinking is lost):  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section, select Extract, compress and save attachments 

to a folder (No interlinking is lost). 

     

7. From Other Options section of the window, select 



 

 

 Ignore 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Ignore 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the converted file. Click OK. 

10. Click OK on the Save As window to start the conversion.  

11. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: If you want to know how to relink attachments, click 'How to relink attachment folder?'  

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  

  



 

 

3.4.1.1.4. Remove all attachments in new PST 

You can use this option to remove all the attachments in new PST file. This option retains only the mail but not any of its 

attachments. No changes are made to the original PST file. 

Here are the steps to remove all attachments from the new PST file: 

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Compact and Save PST option.  

6. Compact PST window opens, from Compact Options section, select Remove all attachments in new PST. 

     

7. From Other Options section of the window, select 

 Ignore 'Deleted Items' folder checkbox - If you want to delete all the emails permanently from the Deleted 

Items folder. 

 Ignore 'Junk E-mail' folder checkbox - If you want to delete all the emails permanently from the Junk E-

mail folder. 



 

 

8. Click OK, and you will go back to Save As window. 

9. Click Browse to browse and select the destination path to save the converted file. Click OK. 

10. Click OK on the Save As window to start the conversion.  

11. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

12. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

13. Click OK. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  

  



 

 

3.4.1.2. Split/Filter and Save PST File  

Stellar Converter for OST - Technician allows you to split/ filter the converted PST file as per some requirements.  

There are three options to split/filter and save PST file. Refer to the following options as per requirement:   

1. Filter by Mail ID  

2. Filter by Date Range 

3. Split by Size 



 

 

3.4.1.2.1. Filter by Mail ID  

Stellar Converter for OST - Technician allows you the feature to split/filter the files by Mail ID. To Filter By Mail ID, you 

must always select at least one mail Id for filtering the PST file.  

Here are the steps to filter PST file by Mail ID:  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Filter By Mail ID section, select e-mail ids under Mail ID scroll box to filter the PST file according to e-

mail ids. Alternatively, you can also use the Select All / Unselect All buttons to select/unselect all the email 

ids. All selected email ids will be stored in the new PST file, and no change is needed to be done in the 

source OST file. 

6. Click Apply Settings, and you will go back to Save As window. 



 

 

7. Click Browse to browse and select the destination path to save the converted file. Click OK. 

8. Click OK on the Save As window to start the conversion.  

9. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file.  

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter options checkboxes (By Mail Id, By Date Range, and By Size), the software 

will queue them and will split/filter PST files using all the three methods. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file. 



 

 

3.4.1.2.2. Filter by Date Range  

Stellar Converter for OST - Technician allows you the feature to Filter the file by Date Range. Filtering a PST file 

according to date range will create a single PST file which will have data as per the criteria selected by you.  

Here are the steps to filter PST file by Date:  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Filter By Date Range section, select Filter By Date Range checkbox and then select either of the two 

options: 

o Select in the last radio option if you want to split the PST file according to months. All e-mails that are sent 

and received in the specified months will get stored in the PST file. 



 

 

o Select between radio option if you want to split the PST file according to a specific period. All e-mails from 

the specific period will get stored in the PST file. Select the start and end date from the list boxes. 

6. Click Apply Settings, and you will go back to Save As window. 

7. Click Browse to browse and select the destination path to save the converted file. Click OK. 

8. Click OK on the Save As window to start the conversion.  

9. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter option checkboxes (By Mail Id, By Date Range, and By Size), the software 

will queue them and will split PST files using all the three methods. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  



 

 

3.4.1.2.3. Split by Size    

Stellar Converter for OST - Technician allows you the feature to split PST file by size. Splitting a PST file by size means 

that you can split a PST file into many PST files to the maximum size of 50 GB.  

Here are the steps to Split PST file by size:  

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. Select PST from the Save Options. 

5. From Advance Options section, choose Split/Filter and Save PST. Split & Filter PST window appears. 

 

 In Split By Size section, select Split By Size checkbox. You can split the PST file to a maximum size of 50 GB. 

Either enter the digit or using an upward or downward arrow set the number as per your requirement. With this 

option, you will get multiple split PST files. 

Note: For large files, Stellar Converter for OST - Technician automatically splits the new PST file in small sizes. 

The size of the split files will depend on the version of Outlook installed on your computer: 



 

 

 If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

 If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB 

of size. 

6. Click Apply Settings, and you will go back to Save As window. 

7. Click Browse to browse and select the destination path to save the converted file. Click OK. 

8. Click OK on the Save As window to start the conversion process.  

9. After the process is completed, Conversion Complete dialog box appears. It shows the path where the 

converted file is saved and the size of the converted file. 

10. To know how to import the new PST file in MS Outlook, click 'How to import PST file?' 

11. Click OK. 

Note: In case you select all the three split/filter option checkboxes (By Mail Id, By Date Range, and By Size), the software 

will queue them and will split PST files using all the three methods. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  

  



 

 

3.4.2. Export to Live Exchange Server  

Using Stellar Converter for OST - Technician you can export the converted OST files to a live exchange server. 

Here are the steps to export OST files to Live Exchange Server: 

1. Run Stellar Converter for OST - Technician software. 

2. See Select and Convert OST File, to know how to select and convert the file 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. From Export Options section, choose Export to Live Exchange Server option. 

 

5. Exchange Server Details window appears. Here you will find two radio options: 

1. Login with Administrator account of Domain: Click Login with Administrator account of Domain 

option. 



 

 

 

 In Exchange Admin Details section fill up the following details: 

 Admin Email ID 

 Admin Name 

 Admin Password 

 In Destination Mailbox Details section,  

 Enter Mailbox Email ID. (Other options remain unavailable) 

2. Login with Domain User Account: Click Login with Domain User Account option.  



 

 

 

 In Destination Mailbox Details section fill up the following details: 

o Mailbox Email ID  

o Mailbox Name 

o Mailbox Password  

 In Exchange Admin Details section, all the options remain unavailable.  

6. In Server Details section, enter the Exchange Server Name field and check or uncheck the checkbox depending 

upon the exchange server version you have.  

7. Click OK to export the data to Live Exchange Server. 

8. This will take you back to the Save As window, click OK to export the data. 

Note: The system, from which you want to export OST files to the exchange server, must be a member of the server 

domain. 

  



 

 

3.4.3. Export to Office365 

Here are the steps to save OST file to Office365 format: 

1. Run Stellar Converter for OST - Technician software. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

 

4. From the Export Options section select Export to Office365 option and click OK. An Office 365 Login Details 

window appears. 

 



 

 

5. Enter Mail ID and Password in Office 365 Login Details.  

6. Click OK to continue. This will take you back to the Save As window, click OK to export the data. 

Note:   

 You need to have a Microsoft Office 365 user account for exporting data to Office 365 format. 

 To save mailbox data in Office 365 format, you need to install Office 2019 or Office 2016 or Office 2013 or 

Office 2010 with service pack2. 

 For Domain systems, you cannot export offline data to Office 365. 

 Online mailbox data cannot get exported to Office 365. You can only export your offline mailbox data to Office 

365. 

 Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

 Close Microsoft Outlook, if open, before saving the converted OST file.  

  



 

 

3.4.4. Export to Existing Outlook Profile  

Here are the steps to export OST file to Existing Outlook profile:  

1. Run Stellar Converter for OST - Technician software. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. From Export Options section, choose Export to Existing Outlook Profile option. 

 

5. Select Outlook Profile window is displayed. Select an Outlook profile from the list of MS Outlook profiles shown. 



 

 

 

6. Click OK. 

7. If the Outlook profile is password protected, Enter Password window will appear. Enter the password and click 

OK. 

8. This will take you back to the Save As window, click OK to export the data. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file. 



 

 

3.4.5. Save as MSG, EML, RTF, HTML, PDF, DBX and 

MBOX format  

Stellar Converter for OST - Technician allows you to save the converted file in MSG, EML, RTF, HTML, PDF, DBX and 

MBOX formats. The mail items can be saved with specific names such as subject of the email, date of the email and sender, 

using the Naming Convention option provided by the software. Naming Convention is only applicable to MSG, EML, 

RTF, HTML and PDF formats. 

Note: Your converted OST file can only be saved in DBX format if you are using Windows XP and have Outlook Express 

installed in your system. 

Here are the steps to save the converted file: 

1. Run Stellar Converter for OST - Technician. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. Click Save Converted File from Home ribbon to open a Save As window. 

4. From Save Options select any one of the formats: MSG, EML, RTF, HTML, PDF, DBX or MBOX.  

5. If you select MSG, EML, RTF, HTML or PDF, Naming Convention section appears: 

  



 

 

 From Naming Convention section, select any one from the following options:  

 Subject - The converted file will be saved with the name as the respective email message's subject. 

 Subject + Date(DD-MM-YYYY) - The converted file will be saved with the name as the respective email 

message's subject and date. 

 Date(YYYY-MM-DD) + Subject - The converted file will be saved with the name as the respective email 

message's date and subject. 

 From + Subject + Date(YYYY-MM-DD) - The converted file will be saved with the name of the respective 

email message's sender, subject, and date. 

 Date(DD-MM-YYYY) + From + Subject - The converted file will be saved with the name of the respective 

email message's date, sender, and subject 

 Date(YYYY-MM-DD) + From + Subject - The converted file will be saved with the name of the respective 

email message's date, sender, and subject. 

 Date(MM-DD-YYYY) + Subject + From - The converted file will be saved with the name of the respective 

email message's date, subject, and sender 

6. Select a Destination Path using Browse button to specify where to save the converted file.  

7. Click OK. A window appears and shows the status of Saving in progress. 

8. After successful saving completion, a Saving Complete dialog box appears with a message, "Selected messages 

saved successfully".  

9. Click on 'Open containing folder' link to view the saved messages. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

Note: Close Microsoft Outlook, if open, before saving the converted OST file.  



 

 

3.5. Relink Attachment Folder  

You need to relink the attachment folder when you move it after using Extract and save attachments to a folder (No 

interlinking is lost) or Extract compress and save attachments to a folder (No interlinking is lost) option. 

To do this: 

1. Click Relink Attachments from Tools ribbon.  

 

2. Click on Select PST and Select Folder button to browse to and select the converted PST file, and its attachment folder. 

3. Click on Relink button to relink the attachments to the emails. 

Note: You can move the attachments folder to a different location on the same local machine, or you can move both the 

converted PST file and the attachments folder to another machine.  



 

 

3.6. Save All Contacts as CSV  

To save all contacts in CSV file: 

1. Run Stellar Converter for OST - Technician software. 

2. See Select and Convert OST File, to know how to select and convert the file. 

3. After all the folders and their items are listed, click on Save All Contacts as CSV button from Tools ribbon. 

4. A dialog box opens. Using Browse button, select the desired location to save the CSV file. 

            

5. Click OK. The file will get saved in the desired format. 

Note : You can also exclude the deleted contacts by selecting the check in button. 



 

 

3.7. Save Log Report 

With Stellar Converter for OST - Technician, you can save the Log Report to analyze the conversion process at a later 

stage.  

Here are the steps to save log report: 

1. From View ribbon, select Log Report. 

2. In the Log Report window, click Save Log. 

 

3. In Save As window, specify the location where you want to save the log file. Click Save. 



 

 

3.8. Save and Load Scan Information  

This option allows you to save the scanned information of files using the "Save Scan Info" option and later load the saved 

scan (DAT) file using the "Load Scan" option. It saves time in restoring data as we do not need to convert the OST file 

again. 

Here are the steps to save scan information from the converted OST file: 

1. From the Home Ribbon, select Save Scan Info. 

         

2. Save Scan Information window will open. Browse to the folder where you want to save the scan information and 

click OK. The information gets saved in .DAT file format. 

3. A message box appears, click OK. 

Load Scan Information 

This option is used to start the conversion procedure from saved scan information or .DAT file. 

To load the scan information of the OST file, follow the steps given below: 

1. To load the scan information click on Load Scan option from the Home Ribbon. 



 

 

      

2. Load Scan window will appear. It displays a list of saved scan information file existing in the system. 

3. In case the file you desire is not in the list, click Add button and select the desired DAT file. 

4. Click Open. 

5. The file you added is displayed in the load scan window. Click Remove button if you want to remove the save scan 

(.DAT) file. 

6. Click Reset button to reset the load scanned list. 

7. Click Load Scan button. 

8. A message box appears, click OK. 

Note: You can select only one file at a time to start the process of scanning. 



 

 

3.9. Import PST file in MS Outlook  

To import PST file to Microsoft Outlook 2019 / 2016 / 2013: 

 Open Microsoft Outlook. From File Ribbon, select Open & Export. 

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. Click 

Next. 

 In Import Outlook Data File dialog box, select the folders that should get imported into Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File Ribbon, select Open -> Import. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. Click 

Next. 

 In Import Outlook Data File dialog box, select the folders that should get imported into Microsoft Outlook. Click 

Finish. 

To import PST file to Microsoft Outlook 2007: 

 Open Microsoft Outlook. From the File Ribbon, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. Click 

Next. 



 

 

 In Import Personal Folders dialog box, select the folders that should get imported into Microsoft Outlook. Click 

Finish. 



 

 

4. Frequently Asked Questions (FAQs)  

1. What does Stellar Converter for OST - Technician do? 

The Stellar Converter for OST - Technician converts OST file and provides options to export data to Live Exchange 

Server, Existing Outlook Profile and Office 365. Also, provides options to save data in PST, MSG, EML, RTF, HTML, 

PDF, DBX and MBOX formats.  

2. What is an OST file? 

OST (Offline Storage Table) file represents the user's mailbox data in offline mode. An Exchange account uses an 

offline Outlook data file i.e. OST file, to store a synchronized copy of your Exchange mailbox information on your local 

computer or the local machine. Therefore, an OST file is automatically created when you configure the Exchange Server 

account on Microsoft Outlook. 

3. I am not aware of the OST file location. How do I select the file for conversion to PST? 

Stellar Converter for OST - Technician can help you find OST file on your system. There is a dedicated Find option 

in the software through which you can locate a particular OST file and convert it.  

4. I had run the demo and can see preview correctly in convert OST window. Do I need to rescan the file? 

Not at all, through the Demo version, you can preview the converted file after scanning. This special feature has been 

included in the tool to make sure that you can first preview the conversion results of your OST file and only when you 

are satisfied with the results, you should decide to make the purchase and save your converted files. 

5. I want to recover permanently deleted emails from my OST file. Will Stellar Converter for OST - Technician 

help? 

Yes, the software scans and recover your permanently deleted emails from OST file. Before saving the deleted items 

you can preview them as well. These deleted items will be shown in red color while previewing.  

6. Can we exclude the deleted items from the converted mailbox while saving? 

Yes, select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file. 

7. How much time will Stellar Converter for OST - Technician software takes to convert an OST file? 

The conversion time depends upon the size of the OST file and also on the number of mailbox items in the mailbox.  



 

 

8. I got an error "Invalid OST file" while scanning. What could be the reason?  

There could be the following reasons for this error message:  

 The OST file is severely corrupted or not in a state to be converted. 

 The OST file is not valid. 

 The file could not be accessed. 

9. I have converted my old OST file. But I’m unable to find my contacts. How can I find them? 

You can easily locate and access your contacts by following these simple steps: 

 Import your new PST file into MS Outlook. 

 Open MS Outlook. 

 Then press "Ctrl+Shift+F". 

 "Find Message / Advanced Find" window will open. Please select "Contacts" under "Look For" tab. 

 Click on the "Browse" button and select the imported PST file. 

 Then, click "Find Now." 

 Now you will be able to see all the contacts that you were able to preview with the software’s demo version. 

You may select the entire contacts listed and drag it to your original contacts list, so that you may use it further. 

10. Can I convert an OST file of size more than 2 GB? 

Absolutely yes, this tool is capable of converting OST files having a size greater than 2 GB. Please download the demo 

version and scan your OST file. You can preview all emails and other mailbox items that are converted into this tool. 

11. I want to analyze the conversion process. Can I see the log report at a later stage? 

Certainly. The software provides you an option to save and view log reports at any point in time. To view and save log 

reports just follow the following steps: 

 On View Ribbon, select 'View Log Report.' 

 On Stellar Converter for OST - Technician window, click 'Save Log' and save it at the desired location to 

view it any time. To know more refer to Log Report. 



 

 

12. Should Microsoft Outlook be installed in my system while I convert my OST file and with which version it works 

well?  

Microsoft Outlook is not required while converting and previewing OST file, but it must be installed in your system to 

use save options. The software is compatible with the following versions:  

Microsoft Outlook: Office 365 / 2019 / 2016 / 2013 / 2010 / 2007. 

13. What does the compact feature of Stellar Converter for OST - Technician do? 

As the name suggests, the compact feature of Stellar Converter for OST - Technician helps to reduce the size of 

converted PST files and attachments on MS Exchange Server. It has various options for attachments of emails that are 

selected for compaction and extraction. 

14. Why do I need to compact the PST files? 

MS Outlook stores all data such as emails, personal data, calendar, tasks, etc. in a PST file. Eventually, the file becomes 

oversized. Such PST files are prone to corruption, so you need to compact them. Stellar Converter for OST - 

Technician, has a compaction feature that helps to compact the PST file. 

15. Can I extract all my attachments in a separate folder while compacting the PST file? 

Yes, you can extract the attachments in a separate folder. There are two options to do it Extract and save attachments 

to a folder (No interlinking is lost) or Extract, compress and save attachments to a folder (No interlinking is lost) 

option. The attachments remain as shortcut links in the emails. 

16. I want to extract and compact the software on select folders of the PST file. Can I choose some selected mailbox 

folders in the software? 

Yes, you can apply extraction and compaction settings on only the selected folders of the PST file. 

17. Can I restore the links of attachments to the PST file? 

Yes, you can restore the links by using the Relink Attachment Folder. You need to relink the attachment folder when 

you move it after using Extract and save attachments to a folder (No interlinking is lost) or Extract, compress and save 

attachments to a folder (No interlinking is lost) option.  

18. I converted my OST file, but I’m unable to open my Outlook file after the conversion. How can I solve this 

problem? 



 

 

To resolve this problem, follow the below-mentioned steps:  

 Open Windows -> Control Panel. 

 Double-click Mail. In the Mail Setup window, select E-mail Accounts to configure your email account. 

 After configuring, close the window and open MS Outlook. 

 To view the newly created PST file, you can either select Open -> Outlook Data File from File ribbon or, Import 

the PST file in MS Outlook. 

19. In how many ways can I split a PST file using Stellar Converter for OST - Technician? 

There are three ways to split a PST file using Stellar Converter for OST - Technician. They are as follows: 

 By Mail ID - You can select email ids under Mail IDs scroll box to split the PST file according to email ids. 

Alternatively, you can also use the Select All / Unselect All buttons to select/unselect all the email ids. All 

selected email ids will be stored in the new PST file, and no change is required to be done to the source file. 

To know more refer to Filter by Mail ID 

 By Date Range - You can select Split By Date Range checkbox and then select either of the two options: 

o Select in the last radio option if you want to split the PST file according to months. All emails that are 

sent and received in the specified months will be stored in the new PST file 

o Select between radio option if you want to split the PST file according to a specific period. All emails 

from the specific period will be stored in the newly created PST file. Select the start and end date from 

the list boxes. To know more refer to Filter by Date Range 

 By Size - You can select Split by Size checkbox and then split the PST file to a maximum size of 50 GB. Either 

enter the digit or using an upward or downward arrow set the number as per your requirement. With this option, 

you will get multiple split PST files. To know more refer to Split by Size 

Note: In case you select all the three split option checkboxes (By Mail Id, By Date Range, and By Size), the software 

will queue them and will split PST files using all the three methods. 

20. I have an OST file exceeding 50 GB of size, does the new PST file generated will have the same size as that of 

source OST file? 



 

 

For large files, Stellar Converter for OST - Technician automatically splits the new PST file in small sizes. The size 

of the split files depends on the version of Outlook installed on your computer: 

If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB of size. 

21. When I enter the Mail ID and Password to export data to Office 365, the system shows an error. What can I do?  

The software shows an error because of the following reasons: 

 If the credentials (Admin ID and Password) you have entered are incorrect. 

 The Admin credentials you have entered do not have required permissions to export data to Office 365. 

 There is a connection failure with the internet. In that case, check your network connection and try again. If your 

internet is working, check your firewall and anti-virus software settings for any blockage. 

 There is a server issue because of which the server is unable to create a connection with Office 365. Check if 

you can connect to Office 365 outside the Stellar Converter for OST - Technician software and try again.  

22. After saving my converted mailbox in PST format. How to view and access the mailbox items? 

After you have saved the converted mailbox in PST format, you can import the PST file in MS Outlook. See Importing 

PST file in MS Outlook, to know how to import the PST file.  

23. Can I convert multiple OST files into PST files? 

Yes, you can convert multiple OST files into PST files using Batch Conversion from Home ribbon. This feature is not 

available in the demo version. 
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1. About Stellar Converter for OST - Technician 

Stellar Converter for OST - Technician, has a Batch Conversion Module that allows you to convert multiple OST files 

to PST files.  

The software also provides options to convert and split files as per date or size and to create a batch file. A batch file can 

be used to resume the convert and split process at a later stage and contains information such as file selection, source 

location, destination path for the output files, start date, end date, size, status, or any other detail as required by the process. 

Key Features: 

 Batch Conversion - Converts multiple OST files to PST files in a single conversion cycle. 

 Recover Deleted E-mails - Supports recovery of deleted items. 

 Split Output PST files -Supports splitting of Mailbox files by Date or Size. 

 Save Preferences as a Batch File - Option to save your preferences into a batch file (.DAT), to resume the 

conversion and splitting of files at a later stage. 

 Preserve Source Files - The software doesn't make any changes to the original files. 

 Source OST File Support - Supports 2019, 2016, 2013, 2010 and 2007 OST files. 

 MS Outlook Support - Supports Office 365, 2019, 2016, 2013, 2010 and 2007. 

 

  



 

 

2. User Interface 

Batch Conversion module of Stellar Converter for OST - Technician, has a simple and easy Graphical User Interface 

(GUI), which resembles the GUI of MS Office. 

Launch Stellar Converter for OST - Technician, click Batch Conversion from the Home ribbon.  

 

The main user interface of the Batch conversion module appears as shown below: 

 

The user interface contains Ribbons and Buttons that allow you to access various features of the software with ease. 



 

 

2.1. Ribbons 

1. Home Ribbon  

 

 Home: Use this option to go to the home screen of the software. 

 Add OST: Use this option to add the OST files which you want to convert. 

 Find OST: Use this option to search OST files from the system. 

 Select Batch File: Use this option to select a batch file. 

 Create Batch File: Use this option to create a batch file to resume the conversion of selected OST files at a later 

stage.  

2. View Ribbon 

 

 Log Report: Use this option to view/save the log report. 

3. Activation Ribbon 

 

 Activation: Use this option to activate the software. 

 

 

 



 

 

4. Help Ribbon 

 

 Help Topics: Use this option to view the help manual for the software. 

 Knowledgebase: Use this option to visit Knowledgebase articles of stellarinfo.com 

 Support: Use this option view the support page of stellarinfo.com 

 About: Use this option to read information about the software. 

5. Buy Now Ribbon 

 

 Buy Online: Use this option to buy Stellar Toolkit for Outlook. 

6. Style Ribbon 

 

 Style: Use this option to switch between various themes for the software, as per your choice. Stellar Converter 

for OST - Technician, offers the following themes: Office 2016 Colorful Theme, Office 2016 White Theme. 

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


 

 

2.2. Buttons 

Stellar Converter for OST - Technician toolbar has following buttons/options : 

 

Click this button to go to the Home screen of the software. 

 

Click this button to add the OST files which you want to convert and split. 

 

Click this button to search OST files from the system. 

 

Click this button to select a batch file. 

 

Click this button to create a batch file to resume the conversion of selected OST files at a later stage.  

 

Click this button to view/save the log report. 

 

Click this button to activate the software. 

 

Click this button to buy Stellar Converter for OST - Technician. 



 

 

 

Click this button to view the support page of stellarinfo.com. 

 

Click this button to view the help manual for the software. 

  

 

Click this button to visit Knowledgebase articles at stellarinfo.com. 

 

Click this button to read information about the software. 

  

http://www.stellarinfo.com/
https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/


 

 

3. Working with the software  

3.1. Add OST Files 

3.2. Find OST Files 

3.3. Select Conversion Option 

3.4. Create and Manage Batch Files 

3.5. View and Save Log Report 



 

 

3.1. Add OST Files 

To start the conversion process, you have to add files to the Batch Conversion module of Stellar Converter for OST - 

Technician. You can add multiple files to the software. 

Steps to add OST Files: 

1. Run Stellar Converter for OST - Technician. 

2. From Home ribbon, click Batch Conversion button.  

 

3. The Batch Conversion module appears as shown below.  

 



 

 

4. Click Add OST from Home ribbon of Batch Conversion module.  

5. An Open window appears. Browse and select the desired OST files and then click Open. 

 

Or, 

 Click Drag & Drop to add OST button on the main interface. An Open window appears, choose the location from 

where you want to select the file. Click Open button. 

Or, 

 Open Windows Explorer to Drag & Drop the desired files to the software. 



 

 

3.2. Find OST Files 

Stellar Converter for OST - Technician, allows you to find OST files on your computer's hard drive, in case you don't know 

their location. With the help of find OST option, you can find OST files in any folder, sub-folder, or in an entire volume on 

your system. 

Steps to find an OST File: 

1. Run Stellar Converter for OST - Technician. 

2. From Home ribbon, click Batch Conversion button.  

 

3. The Batch Conversion module appears as shown below.  

 



 

 

4. Click Find OST from Home ribbon of the Batch Conversion module.  

5. Browse for Folder window appears. Select the drive or folder you want to search for OST files and then click OK. 

  

6. After the completion of the searching process, a list of OST files found in the selected drive or folder is displayed 

on the screen.  

  



 

 

3.3. Select Conversion Option 

Batch Conversion Module of Stellar Converter for OST - Technician, provides you different features to convert Multiple 

OST files to PST files and also convert large OST file into smaller PSTs. Each option is described below, in detail. Every 

time a split operation is performed, a new PST file is created without altering the contents and structure of the original file. 

Thus Stellar Converter for OST - Technician never causes any damage to your original file. 

1. Convert Mailbox 

2. Convert and Split Mailbox 



 

 

3.3.1. Convert Mailbox 

Convert Mailbox is one of the conversion methods to convert single or multiple OST files to PST files. 

Steps to convert OST Files : 

1. Run Stellar Converter for OST - Technician. 

2. See Add OST Files and Find OST Files, to know how to select OST files.  

 

3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected.  

Note: Uncheck the checkbox for the file where conversion is not required.  

4. On the right pane of the screen, conversion options are displayed. From Select Conversion Option section, select 

the Convert Mailbox option and click Convert. 

Note: If you want to change the destination path of the converted files then click 'Click here' link. 

Note: If you want to reset the destination path of the converted files then click 'Reset' link. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

5. After completion, a Conversion Complete dialog box appears with a message, "Conversion process 

completed". If you want to view the Log Report, click View Log or else click Cancel.  



 

 

Note: See View and Save Log Report to know the saving log report process.  

Note: Close Microsoft Outlook, if open, before converting the OST file. 

  



 

 

3.3.2. Convert and Split Mailbox  

Convert and Split Mailbox option allows you to convert and split mailbox files into smaller files. It gives two different 

options, choose any of them as per your requirement:   

1. Split by Date  

2. Split by Size 

  



 

 

3.3.2.1. Split by Date 

Split by Date is one of the conversion options which is used to convert and split mailbox file under a specific date range, as 

per your requirement. 

Steps to convert and split OST Files by Date: 

1. Run Stellar Converter for OST - Technician. 

2. See Add OST Files and Find OST Files, to know how to select OST files.  

3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected.  

Note: Uncheck the checkbox for the file where conversion is not required.  

 

4. On the right pane of the screen, conversion options are displayed. From the Select Conversion Option section, 

select Convert and Split Mailbox option. By default, the Split by Date option is selected. 

 From the Start Date option specify the start date of the date range for the selected file. 

 From the End Date option specify the end date of the date range for the selected file. 

5. Click Convert.  

Note: If you want to change the destination path of the converted files then click the 'Click here' link. 



 

 

Note: If you want to reset the destination path of the converted files then click the 'Reset' link. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

6. A Save Batch File window appears. Here, select the destination path where you want to save the batch file.  

7. To know more what is the batch file click on 'What is batch file?' link.  

8. Click OK to start the conversion process.  

9. After completion, a Conversion Complete dialog box appears with a message, "Conversion process 

completed". If you want to view the Log Report, click View Log or else click Cancel.  

Note: See View and Save Log Report to know the saving log report process.  

Note: Close Microsoft Outlook, if open, before converting the OST file. 



 

 

3.3.2.2. Split by Size 

Split by Size is one of the conversion options which is used to convert and split mailbox file under a specific size as per your 

requirement. 

Steps to convert and split OST Files by Size:  

1. Run Stellar Converter for OST - Technician. 

2. See Add OST Files and Find OST Files, to know how to select OST files.  

3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected.  

Note: Uncheck the checkbox for the file where conversion is not required.  

 

4. On the right pane of the screen, conversion options are displayed. From Select Conversion Option section, select 

Convert and Split Mailbox option. Choose Split by Size option. 

 From the Split Size drop-down list, you can select a size to split the PST file according to preset sizes. By 

using this option, you will get multiple split PST files. You can choose the split file size to be either 5 GB / 

10 GB / 20 GB / 30 GB or 50 GB. 

Note: All the selected OST files split-up into the same size scale as selected by you.  



 

 

Note: For large files, Stellar Converter for OST - Technician automatically splits the new PST file in small sizes. 

The size of the split files will depend on the version of Outlook installed on your computer: 

 If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

 If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB 

of size. 

5. Click Convert.  

Note: If you want to change the destination path of the converted files then click the 'Click here' link. 

Note: If you want to reset the destination path of the converted files then click the 'Reset' link. 

Note: Select the checkbox "Do not convert Deleted Items" to exclude the deleted items from the converted file.  

6. A Save Batch File window appears. Here, select the destination path where you want to save the batch file.  

7. To know more what is the batch file click on 'What is batch file?' link.  

8. Click OK to start the conversion process.  

9. After completion, a Conversion Complete dialog box appears with a message, "Conversion process 

completed". If you want to view the Log Report, click View Log or else click Cancel.  

Note: See View and Save Log Report to know the saving log report process.  

Note: Close Microsoft Outlook, if open, before converting the OST file. 

  



 

 

3.4. Create and Manage Batch Files  

Stellar Converter for OST - Technician, provides you an option to create a batch file. A batch file can be used to resume 

the convert and split process at a later stage and contains information such as file selection, source location, destination 

path for the output files, start date, end date, size, status, or any other detail as required by the process. It can also be used 

to review the number of files processed or to get information about the selected files. 

  

Steps to create Batch File:  

1. Run Stellar Converter for OST - Technician. 

2. See Add OST Files and Find OST Files, to know how to select OST files.  

3. On the left pane of the screen, listed OST files are displayed. By default, they all are selected.  

Note: Uncheck the checkbox for the file where conversion is not required.  

4. On the right pane of the screen, conversion options are displayed. From the Select Conversion Option section, 

select Convert and Split Mailbox option. Choose any one option, as per your requirement.  

Note: You can create batch file only when ''Convert and Split Mailbox" option is selected. 

5. From Home ribbon click Create Batch File to open Save Batch File window. 



 

 

6. Select the destination path to save batch file and click OK.  

7. A Batch File dialog box appears with a message, "Batch file created successfully". 

Note: Alternatively, Save Batch File window appears when you click on Convert.  

  

Steps to select Batch Files:  

1. Run Stellar Converter for OST - Technician. 

2. From Home ribbon click Batch Conversion button to open Batch Conversion module.  

3. From Home ribbon, click Select Batch File button. 

4. A Select Batch File window appears. Here, you have to select the batch file that you want to convert.  

5. An Open window appears. Browse and select the desired batch file and then click Open.  

6. It will return to the Select Batch File window, click OK.  

7. On the left pane of the screen, selected OST files are displayed.  

Note: Uncheck the checkbox for the OST file where conversion is not required.  

8. On the right pane of the screen, conversion options are displayed.  

Note: Batch file once created with the category either (Split by Date or Split by Size) cannot be changed at this stage. 

Also new OST files cannot be added.  

9. Click OK to start the conversion process.  

10. Once completed, a Conversion Complete dialog box appears with a message, "Conversion process 

completed". If you want to view the Log Report, click View Log or else click Cancel.  

Note: See View and Save Log Report to know the saving log report process.  

Note: If the Reset Selection window opens, indicating that the action will clear currently added OST files. Click YES to 

proceed. 



 

 

3.5. View and Save Log Report  

With Stellar Converter for OST - Technician, you can save the Log Report to analyze the conversion process at a later 

stage.  

Steps to save Log Report: 

1. From View ribbon, click Log Report. 

2. In the Log Report window, click Save. 

           

3. A Log Location window appears. Use the Browse button to save the Log Report at the desired location and click 

OK. 

 

4. Log Report Saved dialog box appears and shows the location where the Log Report is saved with date and time.  

5. Click OK to finish the saving process.  



 

 

4. Frequently Asked Questions (FAQs)  

1. Where is the converted file saved if I select a file from the select batch option? 

The converted file is saved automatically at the source file location with the same name as that of the file along with 

the log report in case you do not change the location of the converted file. 

2. Where is my batch file saved if I don't change its path? 

The batch file is saved in the setup folder located under Program files as OST2PSTBatch_date _time_time/size.dat. 

3. If I select multiple files having the same name from different locations saved at a common destination path. 

Then how would I recognize my converted file? 

The converted file is saved to the destination path with the same name as that of the file along with the log report in 

case all the files have the same name is saved with format filename_0, filename_1, and so on. 

4. I have forgotten the path of my OST file. Can I search for the OST file using the software? 

Of course, you can search for OST files in a specific drive or folder. Click Find OST File option in the software to 

locate the OST file. 

5. How much time Stellar Converter for OST - Technician software takes to convert an OST file to PST 

mailbox? 

The conversion time depends upon the size of the OST file and also on the number of mailbox items in the mailbox. 

6. I want to analyze the conversion process. Can I see the log report at a later stage? 

Certainly. The software gives you an option to save and view log reports at any point in time. To view and save log 

reports follow the following steps: 

 On View ribbon, select 'Log Report.' 

 In Stellar Converter for OST - Technician window, click 'Save Log' and save it at the desired location for 

viewing at any time. To know more refer to Log Report. 

7. What is an OST file? 

OST (Offline Storage Table) file represents the user's mailbox data in offline mode. An Exchange account uses an 

offline Outlook data file i.e. OST file, to store a synchronized copy of your Exchange mailbox information on your 



 

 

local computer or the local machine. Therefore, an OST file is automatically created when you configure the 

Exchange Server account on Microsoft Outlook. 

8. What is a batch file? 

A batch file keeps all the settings and inputs of the user to convert and split multiple files. A batch file contains all the 

information required to convert and split OST files such as some files selected, their location path, destination path 

of the output file, start date, end date, processed status or any other detail as required by the process. 

It can be used as an input file once it is created. It can also be used to review the number of files processed or to get 

information about selected files. 

A batch file is created by the software itself before the initiation of the process to use the batch file as input to convert 

and split process. When a batch file is created by the software, then it has a file extension .DAT. 

The default location of the batch file will be in the installation folder of the software. 

9. I have an OST file exceeding 50 GB of size, does the new PST file generated will have the same size as that 

of source OST file? 

For large files, Stellar Converter for OST - Technician automatically splits the new PST file in small sizes. The 

size of the split files will depend on the version of Outlook installed on your computer: 

 If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB of size. 

 

  



 

 

 

 

 

 

 

 

 

 

Stellar Merge Mailbox for Outlook 

User Guide for version 6.0 

  



 

 

1. Overview 

Stellar Merge Mailbox for Outlook is an easy to use application designed to merge multiple Outlook PST files into a single 

file without modifying contents of the original Outlook PST files. This software can be used to merge Email, Calendars, 

Contacts, Journal, Notes, To-Do and Tasks folders from different PST files created in different Outlook versions. PST files 

can be joined, creating multiple folder hierarchies within one PST file, or they can be merged where matching folders are 

combined within a new or into an existing PST file. The user can also merge only specified data from the PST file such as, 

Calendars, Contacts or any other folder from the specified PST file without the need to merge all PST files. 

The software supports removing the duplicate items and excluding deleted items from new PST file during the merging 

process. 

Key Features 

 Merge and Join multiple outlook files. 

 Provides Merge and Join PST saving options (New PST, Existing PST, Outlook Profile, Office 365, Exchange Server). 

 Maintains the integrity of the original PST files while merging them.   

 Allows saving the new PST file at user defined location. 

 Supports password protected PST files. 

 Option to exclude Duplicate Items while merging PST files. 

 Option to Exclude Deleted Items and Junk Items. 

 Option to Drag and Drop PST files. 

 Filter items to provide more space. 

 Supports MS Outlook 2019, 2016, 2013, 2010, 2007, 2003 and Office 365. 

 Compatible with Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012 and Windows Server 2008. 

 

  



 

 

2. User Interface 

Stellar Merge Mailbox for Outlook software has a very easy to use Graphical User Interface. The user interface 
contains features required for merging / joining Outlook PST files. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains Menus and Buttons that let you access various features of the software with ease. 

  



 

 

2.1. Menus 

1. Home Menu 

 

 Home: Use this option to go to the home screen of the software. 

 Add PST: Use this option to add the PST files which you want to merge. 

 Find PST: Use this option to search PST files from the system. 

 Merge PST: Use this option to merge all folders of selected PST files in a new or existing PST file. 

 Join PST: Use this option to join PST files by creating new folder for each selected PST file. 

 Stop: Use this option to stop the merge process. 

 Exclude Deleted Folder: Click this option to exclude deleted items. 

 Exclude Junk Folder: Click this option to exclude junk email folder. 

 Remove Duplicate: Click this option to remove the duplicate items from a PST file during merging process. 

 Subject: Two mails will be regarded as duplicate if their subject is same. This is checked by default. 

 Sender Email: Two mails will be regarded as duplicate if they are sent by same Email ID. This is checked by 

default. 

 Text: Two mails will be regarded as duplicate if their content is same. This is checked by default. 

 Sender Name: Two mails will be regarded as duplicate if their sender name is same. 

 Recipient Name: Two mails will be regarded as duplicate if their receiver name is same. 

 Internet Header: Two mails will be regarded as duplicate if their internet header is same. 

 Attachment Files: Two mails will be regarded as duplicate if they have same attachment. 

 Date and Time of Sending: Two mails will be regarded as duplicate if their date and time of sending is same. 



 

 

2. Logs Menu 

 

 Log Report: Use this option to view / save the log report. 

3. Activation Menu 

 

 Activate: Use this option to activate the software after purchasing. 

4. Support Menu 

 

 Update: Use this option to check for both, latest minor and major versions available online. 

 Purchase: Use this option to buy Stellar Toolkit for Outlook. 

 Support: Use this option view the support page of stellarinfo.com 

 Submit Enquiry: Use this option to submit enquiry to stellarinfo.com 

5. Help Menu 

 

 Help: Use this option to view the help manual for the software. 

https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

 

 Knowledgebase: Use this option to visit Knowledgebase articles of stellarinfo.com 

 About: Use this option to read information about the software. 

6. Style Menu 

 

 Style: Use this option to switch between various themes for the software, as per your choice. 

  

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/


 

 

2.2. Buttons 

 

Click this button to go to the Home screen of the software. 

 

Click this button to add the PST files which you want to merge. 

 

Click this button to search PST files from the system. 

 

Click this button to merge all folders of selected PST files in a new or existing PST file. 

 

Click this button to join PST files by creating new folder for each selected PST file. 

 

Click this button to stop the merge process. 

 

Click this button to view / save the log report. 

 

Click this button to activate the software after purchasing. 

 

Click this button to check for both, latest minor and major versions available online. 



 

 

 

Click this button to buy Stellar Toolkit for Outlook software. 

 

Click this button to view the support page of stellarinfo.com. 

 

Click this button to submit enquiry to stellarinfo.com. 

 

Click this button to view the help manual for the software. 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

Click this button to read  information about the software. 

 

 

 

 

  



 

 

3. How To... 

3.1. Add PST Files 

3.2. Find PST Files 

3.3. Saving Options 

3.4. View and Save Log Report 

  



 

 

3.1. Add PST Files 

To start the merge process, you need to add files to the Stellar Merge Mailbox for Outlook software. You can add a single 

file or multiple files to the software. 

 To add PST files: 

 Run Stellar Merge Mailbox for Outlook. 

 From the Home menu, click Add PST icon. Open dialog box will appear. Browse and select the desired file and 

then click Open. 

 

Or, 

 Click Drag & Drop to add PST button on the main interface. An Open dialog appears, choose the location from 

where you want to select the file. Click Open button. 

Or, 

 Open Windows Explorer to Drag & Drop the desired file(s) to the application. 

  

  



 

 

3.2. Find PST Files 

Stellar Merge Mailbox for Outlook allows you to find PST files in your computer's hard drive, in case you don't know their 

location. With the help of 'Find PST' option, you can find PST files in any folder, subfolder or an entire volume in your 

system. 

To Find a PST File: 

 Run Stellar Merge Mailbox for Outlook application. 

 From the Home Menu, click Find PST. 

 In Browse for Folder dialog box, select the drive or folder you want to search for PST files. Click OK. 

 After the search is finished, a list of PST files found in the selected drive or folder is shown. 

 

 Select files you wish to merge from this list and click Next button to proceed to the merging process. 

  



 

 

3.3. Saving Options 

Stellar Merge Mailbox for Outlook software provides you with merge/join saving options where PST files can be joined, 

creating multiple folder hierarchies within one PST file, or they can be merged where matching folders are combined within 

a new or into an existing PST file. 

Merge PST Files: 

Merge PST option allows to merge all folders of selected PST files in a new PST file. The different merging options are 

described below: 

 Merge to new PST File 

 Merge to existing PST File 

 Merge to Outlook Profile 

 Merge to Office 365 

 Merge to Exchange Server 

 

Join PST Files: 

Join PST option allows you to join PST files by generating multiple root folders to accommodate new child folders from 

separate PST files. The different joining options are described below: 

 Join to new PST File 



 

 

 Join to existing PST File 

 Join to Outlook Profile 

 Join to Office 365 

 Join to Exchange Server 

 

  



 

 

3.3.1. Merge PST Files 

Stellar Merge Mailbox for Outlook allows you to merge similar folders of selected PST files into a single PST file. It creates 

a new output PST file without making any changes into the original data or folder of an existing PST. With this application, 

users can use the option to include or exclude Deleted/Junk Items folder from an Outlook PST file. 

To Merge PST Files: 

1. Add PST Files which you want to merge. 

2. Stellar Merge Mailbox for Outlook application window shows a three-pane window. All folders with number of 

items in them will be listed in the left-pane, under the root node. Click on a folder to view its content in the middle 

pane. 

 

3. From the root node, select the folders which you want to merge. Make a check on the root node to automatically 

select complete mailbox / all the folders. 

4. From the Home menu, select desired options from Exclude Items, Default Duplicate Criteria and/or Advanced 

Duplicate Criteria to remove duplicate items. 

Note: Advanced Duplicate Criteria is enabled only when you select Default Duplicate Criteria. 

5. From Saving Options section in the right pane of the screen, select the desired option. 

 Merge to new PST File: You can select this option when you want to merge contents into a new PST file. 

o Select Merge to new PST File option. 

o Click Browse and select the location where you want to save the PST file. Click OK. 



 

 

 

o Click Merge. 'Process completed' message is displayed after the process is completed 

successfully. Click OK. The PST file will be saved at your specified location. 

 Merge to existing PST File:  You can select this option when you want to merge contents into an already 

existing PST file. 

o Select Merge to existing PST File option. 

o Click Browse and locate the PST file into which you want to merge. Click Open. 

 



 

 

o Click Merge. 'Process completed' message is displayed after the process is completed 

successfully. Click OK. The PST file will be saved at your specified location. 

 Merge to Outlook Profile: You can select this option when you want to merge contents into an Outlook 

profile. 

o Select Merge to Outlook Profile option. 

o Select the desired Outlook Profile. 

 

o Click Merge. 'Process completed' message is displayed after the process is completed 

successfully. Click OK. The PST file will be saved at your specified location. 

Note: In case of Merge to new PST File, Merge to existing PST File and Merge to Outlook Profile, if the 

size of the merged PST file exceeds the MS Outlook file size limit then the contents of merged PST file will 

split accordingly. 

 Merge to Office 365 : You can select this option when you want to merge contents into Office 365 profile. 

o Select Merge to Office 365 option. 

o Login by entering the Office 365 ID and Password. 

Note: Make sure you have entered correct Office 365 ID and Password. 



 

 

 

o Click Merge. 'Process completed' message is displayed after the process is completed 

successfully. Click OK. The PST file will be saved at your specified location. 

 Merge to Exchange Server: You can select this option when you want to merge the mailboxes on 

Exchange Server. 

o Select Merge to Exchange Server option. 

o From Exchange Connection Option select (either Administrator Domain or User Domain) and 

then enter Microsoft Exchange Server Information details. 

o Enter Admin Email ID, Password, Mailbox Email Id and Server Name (for MS Exchange 2007, 

2010, 2013, 2016) and check the checkbox for Exchange Server 2010 or higher. 

 



 

 

o If you have selected User Domain option, then enter Mailbox Email ID, Password, Mailbox 

Name and Server Name. Click OK button. 

Note: Make sure you have entered correct MS Exchange Server details. 

 

o Click Merge. 'Process completed' message is displayed after the process is completed 

successfully. Click OK. The PST file will be saved at your specified location. 

  



 

 

3.3.2. Join PST Files 

Stellar Merge Mailbox for Outlook allows you to join PST files by generating multiple root folders to accommodate new 

child folders from separate PST files. It creates a new Outlook PST file without making any changes into the original data 

or folder of an existing PST. With this application, users can use the option to include/exclude Deleted and Junk Items folder 

from an Outlook PST file. 

To Join PST Files: 

1. Add PST Files which you want to join. 

2. Stellar Merge Mailbox for Outlook application window shows a three-pane window. All folders with number of 

items in them will be listed in the left-pane, under the root node. Click on a folder to view its content in the middle 

pane. 

 

3. From the root node, select the folders which you want to join. Make a check on the root node to automatically select 

complete mailbox / all the folders. 

4. From the Home menu, select desired options from Exclude Items. 

Note: In case of Join PST, Advanced Duplicate Criteria and Default Duplicate Criteria both are disabled. 

5. From Saving Options section in the right pane of the screen, select the desired option. 

 Join to new PST File: You can select this option when you want to join contents into a new PST file. 

o Select Join to new PST File option. 

o Click Browse and select the location where you want to save the PST file. Click OK. 



 

 

 

o Click Join. 'Process completed' message is displayed after the process is completed successfully. 

Click OK. The PST file will be saved at your specified location. 

 Join to existing PST File:  You can select this option when you want to join contents into an already 

existing PST file. 

o Select Join to existing PST File option. 

o Click Browse and locate the PST file into which you want to join. Click Open. 

 



 

 

o Click Join. 'Process completed' message is displayed after the process is completed successfully. 

Click OK. The PST file will be saved at your specified location. 

 Join to Outlook Profile: You can select this option when you want to join contents into an Outlook profile. 

o Select Join to Outlook Profile option. 

o Select the desired Outlook Profile. 

 

o Click Join. 'Process completed' message is displayed after the process is completed successfully. 

Click OK. The PST file will be saved at your specified location. 

Note: In case of Join to new PST File, Join to existing PST File and Join to Outlook Profile, if the size of 

the joined PST file exceeds the MS Outlook file size limit then the contents of the joined PST file will split 

accordingly. 

 Join to Office 365 : You can select this option when you want to join contents into Office 365 profile. 

o Select Join to Office 365 option. 

o Login by entering the Office 365 ID and Password. 

Note: Make sure you have entered correct Office 365 ID and Password. 



 

 

 

o Click Join. 'Process completed' message is displayed after the process is completed successfully. 

Click OK. The PST file will be saved at your specified location. 

 Join to Exchange Server: You can select this option when you want to join the mailboxes on Exchange 

Server. 

o Select Join to Exchange Server option. 

o From Exchange Connection Option select (either Administrator Domain or User Domain). 

o Enter Admin Email ID, Password, Mailbox Email ID and Server Name (for MS Exchange 2007, 

2010, 2013, 2016) and check the checkbox for Exchange Server 2010 or higher. 

 

o If you have selected User Domain option, then enter Admin Email ID, Password, Mailbox Email 

Id and Server Name. Click OK. 

Note: Make sure you have entered correct MS Exchange Server details. 



 

 

 

o Click Join. 'Process completed' message is displayed after the process is completed successfully. 

Click OK. The PST file will be saved at your specified location. 

  



 

 

3.4. View and Save Log Report  

With Stellar Merge Mailbox for Outlook, you can save the Log Report to analyze the merging process at a later stage. 

To save log report: 

 From Logs Menu, select Log Report. 

 A log window appears on the screen displaying the details of the merged folders. 

 

 Click Save button. 

 In Save Log dialog box, click Browse and select the location where you want to save the log report. Click OK. 

To clear log report: 

 From Logs Menu, select Log Report. 

 A log window appears on the screen displaying the details of the merged folders. 

 Click Clear button. 

  

  



 

 

4. FAQs 

1. What does the demo version of the software do? 

The demo version of the software allows you to see mail body and attachments only. Fields such as From, To, CC, BCC, 
and Subject display 'Demo'. To view complete mailbox, you need to purchase and activate the software. 

2. How can Stellar Merge Mailbox for Outlook help me search for the location of PST file in the computer? 

You can search for PST file in a specific drive or folder using Find PST option of the software. For more details, please refer 
Find PST Files topic of the help manual. 

3. Which version of MS Outlook is supported by the software? 

The software supports PST Files made with MS Outlook 2019, 2016, 2013, 2010, 2007, 2003 and Office 365. 

4. How much time Stellar Merge Mailbox for Outlook software takes to merge/join PST mailbox? 

The time for the merge/join process depends upon the size of PST file. While the process is running, you have to wait for 
process to complete. Once the process is complete you can save the newly created PST mailbox at the specified location. 

5. Does the software merge password protected PST Files? 

Yes, this tool is capable of merging PST files that are password protected. You need to enter the password for that PST 
File. 

6. Does the software maintain the integrity of the original PST files while merging them? 

The software merges multiple Outlook PST files into a single file without modifying contents of the original Outlook PST 

files. 

7. Can we save process log? 

Yes, Stellar Merge Mailbox for Outlook gives you option to save log report of the process. 

To save log report: 

o From Logs Menu, select Log Report. 

o In Save Log dialog box, select the location where you want to save the log report. Click OK. 

  



 

 

 

 

 

 

 

 

Stellar Undelete Email for Outlook  

User Guide for version 9.0 

  



 

 

1. About Stellar Undelete Email for Outlook  

Stellar Undelete Email for Outlook successfully recovers accidentally deleted and lost emails, folders, calendars, 
appointments, meeting requests, contacts, tasks, task requests, journals, notes as much as possible which minimize the 
loss of corruption. 

It is a powerful software to recover deleted mails either from PST and OST files, created by MS outlook. All the message, 
calender events, notes, etc. are discovered.  You can also save emails in any one of the six following formats: 

 PST 

 MSG 

 EML 

 PDF 

 HTML 

 RTF 

To view data from a newly recover file, you need to import the new PST file into MS Outlook. 

Key features: 

 Support for MS Office 2019, 2016, 2013, 2010 and 2007. 

 Option to save and load scan information. 

 Option to recover Mailbox from OST and PST files. 

 Recover all your accidentally/intentionally deleted mails, even after emptying the 'Deleted Items' folder. 

 Recover deleted mails and all other objects even from password protected files 

 Recovers all types of deleted attachments such as Excel Worksheets, Word documents, images and so on. 

 Enables you to view messages in a 3-view format. 

 Find option to search emails faster. 

 Recovers e-mails, calendar entries, contacts, notes, tasks and journals from outlook mailbox files. 

 The recovered mailbox will get saved as a new PST file on any drive (including network drives) visible to host 
computer 

 Can save single mail messages in MSG, EML, RTF, HTML and PDF format. 

 Enhanced preview feature for calendars, tasks, journals, and contacts. 



 

 

 Right-click option to save emails in any one of the following formats from preview section itself - MSG, EML, RTF, 
HTML, and PDF. 

 Option to arrange scanned emails and messages as per Date, From, To, Subject, Type, Attachment, deleted and 
Importance. You can also arrange scanned emails in the form of groups. 

  



 

 

2. User Interface 

Stellar Undelete Email for Outlook has a simple and easy to use Graphical User Interface (GUI). The GUI of Stellar 
Undelete Email for Outlook resembles the GUI of MS Office 2016. 

After launching the software, the main user interface appears as shown below: 

 

The user interface contains Ribbons and buttons that allow you to access various features of the software with ease. 

When you start Stellar Undelete Email for Outlook, the Select Mailbox to Recover Deleted Items dialog box opens as 

shown below 

:  

To select an outlook mailbox file, click on Browse button. Select the outlook mailbox file that needs to be recovered and 
then click Recover to initiate the recovery process. 



 

 

Stellar Undelete Email for Outlook also allows you to find files, in case you don't know the location of the outlook mailbox 
file, you want to recover. Click on Find button, Find Outlook Mailbox dialog box opens. Use Look in to specify the drive 
in which you wish to search for outlook mailbox files, and then click Find to search for files. 

Note: We can view  Select Mailbox to Recover Deleted Items dialog box by selecting Select Outlook Mailbox in the File 

ribbon. 

  



 

 

2.1. Ribbons 

1. File Ribbon 

 

 Select Outlook Mailbox : Opens Select Mailbox to Recover Deleted Items dialog box, using which you can 

select/search for Outlook Mailbox files. 

 Save Deleted Items : It saves the recovered deleted items of mailbox  file at your specified location. 

 Exit : Use this option to close the application. 

  

2. Home Ribbon 

 

 Select Outlook Mailbox : Open Select Mailbox to Recover Deleted Items dialog box, using which you can 

select/search for Outlook Mailbox files. 

 Save Deleted Items : It saves the recovered deleted items of mailbox  file at your specified location. 

 Find Message : Use this option to search for specific emails and messages from the list of the scanned emails. 

 Save Scan : Use this option to save the scanned information of file. 

 Load Scan : Use this option to load the saved scan file. 

  

 

 



 

 

3. View Ribbon 

 

 Switch Reading Pane : Use this option to switch between horizontal and vertical views of the reading pane. 

 Log Report : Use this option to view the log report. 

  

4. Tools Ribbon 

 

 Update Wizard : Use this option update your software 

  

5. Calendar Ribbon 

 

 Day : Use this option to list all the entries of a particular day from the list of the scanned emails. 

 Work Week : Use this option to list all the entries of a work week (from Monday to Friday). 

 Week : Use this option to list all the entries of a week (from Monday to Sunday). 

 Month : Use this option to list all the entries for a particular month. 

 GoTo : Use this option to list all the entries of the current date or any particular date. 

  

 

 

 



 

 

6. Activation Ribbon 

 

 Activate : Use this option to activate the software after purchasing the software. 

  

7. Help Ribbon 

 

 Help Topics : Use this option to open the help manual of the software. 

 Knowledgebase : Use this option to visit the Knowledgebase articles of stellarinfo.com 

 Support : Use this option to visit the support page of stellarinfo.com 

 About : Use this option to read information about the software. 

  

8. Buy Now Ribbon 

 

 Buy Online : Use this option to buy Stellar Toolkit for Outlook. 

  

9. Style Ribbon 

 

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php


 

 

 Style : Use this option to switch between various themes for the software, as per your choice. Stellar Undelete Email 

for Outlook offers the following themes: Office 2016 Colorful Theme, Office 2016 White Theme. 

  



 

 

2.2. Buttons 

Stellar Undelete Email for Outlook toolbar has following buttons/options: 

 

  

Click this button to open Select Mailbox to Recover Deleted Items dialog box. 

 

  

Click this button to save the recovered file to a location of your choice. 

 

Click this button to switch between horizontal and vertical views of the reading pane. When you click 
on a folder in left-pane, by default, the right pane shows the details in horizontal columns. Click 
Switch Reading Pane button to change the position to vertical columns. 

 

  

Click this button to view the Log Report, which contains the details of the recovery process. 

 

  

Click this button to open Find Message dialog box, using which you can search for specific emails 
using sender's email, recipient's email, subject or date. 

 

Click this button to save scanned information of files. 

 

Click this button to load the saved scan files. 



 

 

 

  

Click this button to update your software. Use this option to check for both, major and minor versions 
of the software. 

 

  

Click this button to list all the entries of one particular day from the list of the scanned emails. 

 

  

Click this button to list all the entries of a work week (from Monday to Friday). 

 

  

Click this button to list all the entries of a week (from Monday to Sunday). 

 

  

Click this button to list all the entries for a particular month. 

 

  

Click this button to list all the entries of the current date. 

 

  

Click this button to list all the entries on a particular day (any single day except the current date). 



 

 

 

  

Click this button to activate the software after purchase. 

 

  

Click this button to open the help manual for Stellar Undelete Email for Outlook. 

 

  

Click this button to purchase the software. 

 

  

Click this button to open Stellar Information Technology Private Limited online support website. 

 

  

Click this button to visit the Knowledgebase articles of stellarinfo.com 

 

  

Click this button to read more information about the software. 

  

http://www.stellarinfo.com/


 

 

3. Working with the Software  

3.1. Find Outlook Mailbox Files 

3.2. Recover Deleted Items of a Mailbox 

3.3. Find, View and Save a Single Message 

3.4. Arrange Scanned Emails 

3.5. Import PST File in MS Outlook 

3.6. Read MSG, EML, RTF, HTML and PDF Files 

3.7. Save Log Report 

3.8. Save and Load Scan Information 

  



 

 

3.1. Find Outlook Mailbox Files  

Stellar Undelete Email for Outlook allows you to recover your lost or deleted data from your Outlook Mailbox File. Using 

the Find option, you can search for Outlook mailbox files in your computer's drives, folders, and subfolders. However, you 

can only select one drive at a time to search for Outlook Mailbox files. 

To Find Outlook Mailbox Files in drives: 

1. Open Stellar Undelete Email for Outlook. Select Mailbox to Recover Deleted Items dialog box will appear. 

2. Click Find button. Find Outlook Mailbox dialog box opens. 

     

3. Select the drive you want to search for Outlook Mailbox files. Click Find. 

4. Click Look in button to particularly select the folder from the drive. 

5. After the search is finished, a list of mailbox files found in the selected drive is shown in the Results section. 

6. Select the file you want to recover and click Recover button to start the recovery process. 

To find Outlook Mailbox files in folders and subfolders:  

1. From Home ribbon, click on Select Outlook Mailbox icon to open Select Mailbox to Recover Deleted Items dialog 

box. 

2. Click Find button. Find Outlook Mailbox  dialog box opens. 

3. In Find Outlook Mailbox dialog box, select the drive you want to search for mailbox files. 



 

 

4. Click Look in button and select the folder from which you want to search mailbox files. Also, if you want to search 

subfolders within that folder, select Search Subfolders  checkbox. 

5. Click Find button. 

6. After the search is finished, list of mailbox file found in the selected drive is shown in the Results section. 

7. Select the file you want to recover and click Recover button to start the recovery process. 

Note: Click Clear List button to clear the search result. 

  



 

 

3.2. Recover Deleted Items of a Mailbox  

If you know the location of outlook mailbox files, then you can directly specify the location and start recovering outlook 

mailbox file to PST file. If you do not know the location, then you can search for outlook mailbox file by using the Find option 

of Stellar Undelete Email for Outlook software. 

To recover Outlook mailbox files: 

1. Run Stellar Undelete Email for Outlook software. From the Select Outlook Mailbox dialog box, select / find the 

Outlook Mailbox files that you want to recover. Click Recover to initiate recovery of the selected Outlook Mailbox 

file. 

2. The time required for recovery depends on the size of selected Outlook Mailbox file. You can stop the recovery 

process by clicking Stop button, that appears during the recovery of selected Outlook Mailbox file. 

          

3. After completion of the recovery process, Stellar Undelete Email for Outlook application window shows the 

preview of the Outlook Mailbox file. The recovered file, along with its original content is shown in a three-pane 

structure. 

All mailbox folders will get listed in the left-pane, under the root node. Click on a folder to view its items. Click an 

email to view its content. We can also view  Emails, calendar, contacts, tasks, notes, and journals by clicking on 

respective folders or buttons.   

To switch between vertical and horizontal reading panes, click Switch Reading Pane button in View Ribbon. 

4. To save the recovered Outlook Mailbox file, click Save Deleted Items button in Home Ribbon. Save As dialog box 

opens. Click Browse. 

5. In Browse for Folder dialog box, select the location where you want to save the PST file. Click OK. 



 

 

          

6. The recovered file (PST) get saved at your specified location. You will need to import the PST file to Microsoft 

Outlook to use it. 

Note: You can stop the scan and recovery process individually. If you stop the scanning process, then no files will be 

recovered. If you stop the recovery process, then those files will be shown, which got recovered until the process had 

stopped. Also, Microsoft Outlook should get closed before saving the recovered outlook mailbox file 

  



 

 

3.3. Find, View and Save a Single Message  

Stellar Undelete Email for Outlook allows you to find a particular message from the recovered file. The software offers a 

Find Message feature, which helps you narrow the search using various search options. You can save a message directly 

from the search result in MSG, EML, RTF, HTML or PDF format. 

To find messages: 

1. Click on Find Message icon in Home Ribbon. Find Message dialog box opens. 

2. Specify the search criteria in Find Message dialog box. 

      

 In To field, specify all or few characters of email ids of recipients. Keywords should be separated by a semicolon 

(;). 

 In From field, specify all or few characters of email ids of senders. Keywords should be separated by a semicolon 

(;). 

 In Subject field, specify the subject that you need to search. 

 If you want to search for emails sent or received on a particular date, select Select Date Field checkbox, and select 

date from Date drop box. 

3. Click Find Now button to start the search. 

To view messages: 

1. After the search is complete, a list of emails that match the search criteria is displayed. 

2. Double-click on an email to open it in a new window. 



 

 

To save messages: 

 To save any message from the search result list, simply right-click on it and: 

o Select Save as MSG to save the message in MSG format. 

o Select Save as EML to save the message in EML format. 

o Select Save as RTF to save the message in RTF format. 

o Select Save as HTML to save the message in HTML format. 

o Select Save as PDF to save the message in PDF format. 

You need to import the PST file to MS Outlook to view it. 

  



 

 

3.4. Arrange Scanned Emails  

Stellar Undelete Email for Outlook allows you to arrange recovered emails as per date, from, to, subject, type, attachment, 

and importance. This feature helps you to sort and organize the messages into pre-defined groups. 

The software provides seven pre-defined, standard arrangements from where you can choose. They are available in the 

pane listing all the scanned emails/messages. 

To arrange scanned email and messages: 

1. Run Stellar Undelete Email for Outlook. 

2. Select the Outlook Mailbox file that needs recover. 

3. After scanning, the application will list all the emails from the recovered Outlook Mailbox file in the preview pane. 

      

4. Right-click on email grid column headers and you will get the Arrange By option. 

5. Select either of the following properties from the Arrange By list to list the emails as per the selected criteria: 

o Date 

o From 

o To 

o Subject 

o Type 

o Attachment 

o Deleted 

o Importance 

o Show in Groups 

Search e-mails option at mail grid 



 

 

You can search for specific emails from preview pane itself. Once the recovered Outlook Mailbox file appears in the preview 

pane, you can enter the search text in the column header search box to search for emails in a given column. This search is 

performed on a single column only. 

To search for e-mails in the preview pane, follow the steps given below: 

1. Run Stellar Undelete Email for Outlook application. 

2. Select the Outlook Mailbox file that needs recover. 

3. After scanning, the application will list all the emails recovered from the Outlook Mailbox file in the preview pane. 

4. Enter search text in any of mail grid search box. You can enter text in From, To, Subject, and Date mail grid column 

headers only. 

       

5. The application will show all the emails and messages fulfilling the search criteria. 

  



 

 

3.5. Import PST file in MS Outlook  

To import PST file to Microsoft Outlook 2019 / 2016 / 2013: 

 Open Microsoft Outlook. From File ribbon, select Open & Export. 

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Outlook Data File dialog box, select the folders that should get imported into Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File ribbon, select Open -> Import. (For MS Outlook 2013, select Open and 

Import from File Ribbon) 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Outlook Data File dialog box, select the folders that should get imported into in Microsoft Outlook. Click 

Finish. 

To import PST file to Microsoft Outlook 2007: 

 Open Microsoft Outlook. From the File ribbon, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to get imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Personal Folders dialog box, select the folders that should get imported into Microsoft Outlook. Click 

Finish 

  



 

 

3.6. Read MSG, EML, RTF, HTML and PDF Files 

To read an e-mail saved as an MSG file: 

1. Navigate to the location where MSG file is saved or click on the link displayed in success message dialog box. 

2. Double-click to open the file as a regular e-mail in MS Outlook window. 

To read an e-mail saved as an EML file: 

1. Navigate to the location where EML file is saved or click on the link displayed in success message dialog box. 

2. Double-click to open the file as a regular e-mail in MS Outlook window. 

To read an e-mail saved as an RTF file: 

1. Navigate to the location where RTF file is saved or click on the link displayed in success message dialog box. 

2. Double-click to open the file in Wordpad. 

To read an e-mail saved as an HTML file: 

1. Navigate to the location where HTML file is saved or click on the link displayed in success message dialog box. 

2. Double-click to open the file in your default browser. 

To read an e-mail saved as a PDF file: 

1. Navigate to the location where PDF file is saved or click on the link displayed in success message dialog box. 

2. Double-click to open the file in a PDF file reader. 

  



 

 

3.7. Save Log Report 

With Stellar Undelete Email for Outlook, you can save the Log Report to analyze the conversion process at a later stage.  

To save log report: 

1. From View ribbon, select Log Report. 

2. In Log Report dialog box, click Save Log. 

           

3. In Save As dialog box, specify the location where you want to save the log file. Click Save. 

  



 

 

3.8. Save and Load Scan Information  

This option allows you to save the scanned information of files using "Save Scan Info" option and later load the saved 

scan (DAT) file using "Load Scan " option. It saves time in restoring data as we do not need to scan the Outlook Mailbox 

file again. 

To save scan information of the Outlook Mailbox file, follow the steps given below: 

1. From the Home ribbon, click Save Scan button. 

      

2. Save Scan Info dialog box will open. Browse to the folder where you want to save the scan information and click 

OK. The information gets saved as. DAT file format. 

3. A message box appears, click OK. 

Load Scan Information 

This option is used to start recovery procedure from a saved scan information or.DAT file. 

To load the scan information of the Outlook Mailbox file, follow the steps given below: 

1. To load the scan information click on Load Scan  option from the Home ribbon. 



 

 

         

2. Load Scan dialog box will appear. This dialog displays a list of saved scan information file existing in the system. 

3. In case the file you need is not in the list, click Add button and select the needed .DAT file. 

4. Click Open. 

5. The file you added gets displayed in the load scan dialog box. Click Remove button if you want to remove the save 

scan (.DAT) file. 

6. Click Reset button to reset the load scanned list. 

7. Click Load Scan button. 

8. A message box appears, click OK. 

Note: You can select only one file at a time to start the process of scanning. 

  



 

 

4. FAQs 

1. What is Stellar Undelete Email for Outlook used For? 

Stellar Undelete Email for Outlook software is used to recover mails that are knowingly or accidently deleted 

from  Outlook Mailbox. 

2. Does the software recovers deleted e-mails in password protected/secured files? 

Yes, the software recovers deleted mails even in the password protected files. 

3. Should MS Outlook be installed on the system before executing the recovery process? 

Yes, MS Outlook should be installed before executing the recovery process. 

4. Can the software recover deleted Calenders/Contacts/Tasks/Journals/Notes folders in the e-mail? 

Yes, the software recovers these items efficiently. 

5. Can I recover a corrupt Outlook Mailbox file of size more than 2 GB ? 

Absolutely yes, this tool is capable of recovering Outlook Mailbox file that are more than 2 GB. Please download the 

demo version and scan your Outlook Mailbox file. You can preview all emails and other mailbox items which can be 

recovered through this tool. 

6. Can the software recover the deleted attachments from the mailbox? 

Yes, the software recovers the deleted attachments from the mailbox. 

7. Does the software recovers Deleted mails from both OST and PST files? 

Yes, the software recovers the deleted mails from both OST and PST files. 

8. I have forgotten the path of my Outlook Mailbox file. Can this application search it for me? 

Yes, the application can look for Outlook Mailbox file on your system and find it for you easily. There is a dedicated 

Find option in  the application through which you can locate a particular Outlook Mailbox file and run recover on it. 

9. I want to analyze the recover process. Can I see the log report at a later stage? 

Certainly. The application gives you an option to save and view log reports at any point of time. To view and save log 

reports just follow the following steps: 

On View ribbon, select view 'Log Report'. 

In log report dialog box, click 'Save Log' and save it at a desired location for viewing it anytime. 

10. I have an Outlook Mailbox file exceeding 50 GB of size, does the new PST file generated will have same size 

as that of source Outlook Mailbox file ? 



 

 

For large files, Stellar Undelete Email for Outlook automatically splits the new PST file in small sizes. The size of 

the split files will depend on the version of Outlook installed on your computer: 

If you have Outlook 2007 installed, the new PST will be splitted at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be splitted at approximately 45 GB to 48 GB of size. 
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1. About Stellar Splitter for Outlook  

Stellar Splitter for Outlook is a very powerful and robust application that helps you split large PST files into smaller files 
as per the criteria specified by you. 

Microsoft Outlook data is stored in the personal folders file that ends with the PST extension. All the data stored in various 
Outlook folders goes in to the PST file. Outlook PST file, also known as Outlook Data File contains all items like emails, 
calendars, to-do lists, tasks, journals, notes, contacts. Protecting this data is crucial since it contains confidential, personal 
and financial information. 

Key Features: 

 Splits PST files on the basis of: 

o Date 

o Size 

o Mail ID 

o Folders 

 Allows to split single or multiple files in one operation. 

 Saves all your preferences to split files in a batch file. 

 You can create your own batch file to automate splitting of multiple files. 

 All activities of application are recorded in a log. 

 Application doesn't make any changes in the original PST. 

 Support for MS Office 2019, 2016, 2013, 2010 and 2007. 

Note: Every time a split operation is performed, a new PST file is created without altering the contents and structure of 
original PST file. Thus Stellar Splitter for Outlook never causes any damage to your invaluable original PST file. 

  



 

 

2. User Interface 

Stellar Splitter for Outlook software has a very easy to use Graphical User Interface. The user interface contains features 
required for splitting Outlook PST files. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains Ribbons and Buttons that let you access various features of the software with ease. 

  



 

 

2.1. Ribbons 

1. Home 

 

 Home: Use this option to go to the home screen of the software. 

 Add PST: Use this option to add the PST files which you want to split. 

 Find PST: Use this option to search PST files from the system. 

 Select Batch File: Use this option to select already created batch file from the system. 

 Create Batch File: Use this option to create your own batch file to automate splitting of multiple files. 

 Split: Use this option to split single or multiple PST files. 

 Stop: Use this option to stop the split process. 

  

2. Logs 

 

 Log Report: Use this option to view / save the log report. 

 

 

 

 



 

 

3. Activation 

 

 Activate: Use this option to activate the software after purchasing. 

  

4. Support 

 

 Update: Use this option to check for both, latest minor and major versions available online. 

 Purchase: Use this option to buy Stellar Toolkit for Outlook. 

 Support: Use this option view the support page of stellarinfo.com 

 Submit Enquiry: Use this option to submit enquiry to stellarinfo.com 

  

5. Help 

 

 Help: Use this option to view the help manual for the software. 

https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

 

 Knowedgebase: Use this option to visit Knowledgebase articles of stellarinfo.com 

 About: Use this option to read information about the software. 

  

6. Style 

 

 Style: Use this option to switch between various themes for the software, as per your choice. 

  

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/


 

 

2.2. Buttons 

 

Click this button to go to the Home screen of the software. 

 

Click this button to add the PST files which you want to split. 

 

Click this button to search PST files from the system. 

 

Click this button to select already created batch file from the system. 

 

Click this button to create your own batch file to automate splitting of multiple files. 

 

Click this button to split single or multiple PST files. 

 

Click this button to stop the split process. 

 

Click this button to view / save the log report. 

 

Click this button to activate the software after purchasing. 



 

 

 

Click this button to check for both, latest minor and major versions available online. 

 

Click this button to buy Stellar Toolkit for Outlook software. 

 

Click this button to view the support page of stellarinfo.com. 

 

Click this button to submit enquiry to stellarinfo.com. 

 

Click this button to view the help manual for the software. 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

Click this button to read information about the software. 

  

  



 

 

3. Working with the Software  

3.1. Add PST Files 

3.2. Find PST Files 

3.3. Splitting Options 

3.4. Create and Manage Batch Files 

3.5. View and Save Log Report 

  



 

 

3.1. Add PST Files 

To start the split process, you need to add files to the Stellar Splitter for Outlook software. You can add a single file or 

multiple files to the software. 

 To add PST files: 

 Run Stellar Splitter for Outlook. 

 From the Home menu, click Add PST icon. Open dialog box will appear. Browse and select the desired file and 

then click Open. 

 

Or, 

 Click Drag & Drop to add PST button on the main interface. An Open dialog appears, choose the location from 

where you want to select the file. Click Open button. 

Or, 

 Open Windows Explorer to Drag & Drop the desired files to the application. 

  



 

 

3.2. Find PST Files 

Stellar Splitter for Outlook allows you to find PST files in your computer's hard drive, in case you don't know their  location. 

With the help of 'Find PST' option, you can find PST files in any folder, subfolder or an entire volume in your system. 

To Find a PST File: 

 Run Stellar Splitter for Outlook application. 

 From the Home ribbon, click Find PST. 

 In Browse for Folder dialog box, select the drive or folder you want to search for PST files. Click OK. 

 After the search is finished, a list of PST files found in the selected drive or folder is shown on the left side of the 

screen. 

 

 Select files you wish to split from this list. 

 From the middle pane of the screen, specify the criteria based on which you want to split your PST. 

  



 

 

3.3. Splitting Options 

Stellar Splitter for Outlook provides you different features to split your large PST file into smaller PSTs. Each option is 

described below, in detail. Every time a split operation is performed, a new PST file is created without altering the contents 

and structure of original PST file. Thus Stellar Splitter for Outlook never causes any damage to your invaluable original 

PST file. 

3.3.1. Split Single PST By Date Criteria 

3.3.2. Split Single PST By Size 

3.3.3. Split Single PST By Mail ID 

3.3.4. Split Single PST By Selecting Folders 

3.3.5. Split Multiple PST Files By Date 

3.3.6. Split Multiple PST Files By Size 

  



 

 

3.3.1. Split Single PST By Date Criteria  

To split single PST file by date criteria, please follow the procedure as described below: 

1. Start Stellar Splitter for Outlook application. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, select By Date option. 

5. Click Browse and select the location where you want to save the PST File. Click OK. 

6. From 'Date Range' section in the right pane of the screen, 

o Select In last radio option if you want to split the PST file according to months. All e-mails that are send 

and received in the specified months will be stored in the split PST file. 

o Select Between radio option if you want to split the PST file according to a specific time period. All e-mails 

from the specific time period will be stored in the split PST file. Select the start and end date from the list 

boxes. 

7. User can specify to create a new PST file of all mails sent or received in last 'x' number of months or mails sent or 

received in a specified date range. 

 

8. Onwards this click on 'Split' to start the process. 



 

 

9. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 

 

10. Once the process is complete, you need to specify the path where a log can be saved for the split operation. This 

will help you to check the operation activities performed on your PST file. 

  



 

 

3.3.2. Split Single PST By Size  

Split By Size option allows you to create small PST files of your bigger PST by specifying the size of each PST file. The 
size of split PST file can be 5GB, 10GB, 20GB, 30GB or 50GB. 

To split single PST file by size, please follow the procedure as described below: 

1. Start Stellar Splitter for Outlook application. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, select By Size option. 

5. Click Browse and select the location where you want to save the PST File. Click OK. 

6. From 'Specify Size' section in the right pane of the screen, specify size of each PST slice that you want to create 

from larger PST. Size range can be 5GB, 10GB, 20GB, 30GB or 50GB. 

Note: For large files, Stellar Splitter for Outlook automatically splits the new PST file in small sizes. The size of the 

split files will depend on the version of Outlook installed on your computer: 

If you have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 GB to 48 GB of size. 

 

7. Onwards this click on 'Split' to start the process. 

8. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 



 

 

 

9. Once the process is complete, you need to specify the path where a log can be saved for the split operation. This 

will help you to check the operation activities performed on your PST file. 

Note: In demo version of the software, the size of the split PST file will not be more than 250 MB. 

  



 

 

3.3.3. Split Single PST By Mail ID  

To split single PST file by mail id, please follow the procedure as described below: 

1. Start Stellar Splitter for Outlook application. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, select By Mail ID option. 

5. A new dialog appears prompting you to proceed to the splitting process. 

6. Click Yes to start the process of scanning the PST file. Once the scanning is complete, application will display a list 

of all mail ids found in the file in the right pane of the screen. 

7. Select e-mail ids under Mail IDs scroll box to split the PST file according to e-mail ids. Alternatively, you can also 

use the Select All / Unselect All buttons to select / unselect all the email ids. 

8. Click Browse and select the location where you want to save the PST File. Click OK. 

 

9. Onwards this click on 'Split' to start the process. 

10. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 



 

 

 

11. Once the process is complete, you need to specify the path where a log can be saved for the split operation. This 

will help you to check the operation activities performed on your PST file. 

  



 

 

3.3.4. Split Single PST By Selecting Folders  

You can select one or more mail folders and create a new PST consisting of selected items only. To split single PST file by 
extracting selected items, please follow the procedure as described below. 

1. Start Stellar Splitter for Outlook application. 

2. Add PST File which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, click Select & Split option. 

5. A new dialog appears prompting you to proceed to the splitting process. 

6. Click Yes to start the process of scanning the PST file. Once the scanning is complete, application will display a list 

of all folders found in the file in the right pane of the screen. 

7. From 'Select Folders' section in the right pane of the screen, select the folders that you want to be used as split 

criteria for the file. 

8. Click Browse and select the location where you want to save the PST File. Click OK. 

 

9. Onwards this click on 'Split' to start the process. 

10. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 



 

 

 

11. Once the process is complete, you need to specify the path where a log can be saved for the split operation. This 

will help you to check the operation activities performed on your PST file. 

  

  



 

 

3.3.5. Split Multiple PST Files By Date  

You can select and split multiple PST files stored in a folder. To split multiple PST files, please follow the procedure as 
described below. 

1. Start Stellar Splitter for Outlook application. 

2. Add PST File(s) which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, select By Date option. 

 

  

5. 'Customize Split Options' section in the right pane of the screen displays the criteria to be set as Index, File Name, 

File Path, Start Date, End Date, Apply Upto File Index and Destination Path. 

6. You can specify date range and destination path for each file individually. Application also has an option to apply 

common settings to a group of files. 

7. Specify the start date of the date range by clicking on 'Start Date' column. You can apply the same start date to 

other files by selecting the index number in 'Apply Upto File Index' column. For example if same start date is to 

be applied upto third file in the list then select the value 3 in 'Apply Upto File Index' column. 



 

 

 

8. Specify the end date of the date range by clicking on 'End Date' column. You can apply the same end date to other 

files by selecting the index number in 'Apply Upto File Index' column. For example if same end date is to be applied 

upto second file in the list then select the value 2 in 'Apply Upto File Index' column. 

 

9. If you want to change destination location of a file then click on the 'Destination Path' column and select a new 

destination. You can select the same destination path for a group of files by selecting the index number in 'Apply 

Upto File Index', column. For example if same destination path is to be selected for all files in the list then select 

the value 4 in 'Apply Upto File Index' column. 



 

 

 

10. Onwards this click on 'Split' to start the process. 

11. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 

 

  



 

 

3.3.6. Split Multiple PST Files By Size  

1. Start Stellar Splitter for Outlook application. 

2. Add PST Files which you want to split. 

3. Stellar Splitter for Outlook application window shows a three-pane window. The PST File you added will be listed 

in the left-pane. 

4. From 'Select Splitting Option' section in the middle pane of the screen, select By Size option. 

 

5. 'Customize Split Options' section in the right pane of the screen displays the criteria to be set as Index, File Name, 

File Path, Apply Upto File Index, Split Size and Destination Path. 

6. You can specify size and destination path for each file individually. Application also has an option to apply common 

settings to a group of files. 

7. Specify the size of the new PST files by clicking on 'Split Size' column. You can apply the same size criteria to 

other files by selecting the index number in 'Apply Upto File Index' column. For example if same size of new PST 

files are to be created from upto third file in the list then select the value 3 in 'Apply Upto File Index' column. 



 

 

 

8. If you want to change destination location of a file then click on the 'Destination Path' column and select a new 

destination. You can select the same destination path for a group of files by selecting the index number in 'Apply 

Upto File Index', column. For example if same destination path is to be selected for all files in the list then select the 

value 4 in 'Apply Upto File Index' column. 



 

 

 

9. Onwards this click on 'Split' to start the process. 

10. 'Splitting completed' message is displayed after the process is completed successfully. Click OK. The PST file will 

be saved at your specified location. 

 

  



 

 

3.4. Create and Manage Batch Files  

Stellar Splitter for Outlook provides you an option to create a batch file. A batch file contains all the information required 
to split PST files such as number of files selected, their location path, destination path of output file, start date, end date, 
processed status or any other detail as required by the process. It can be used as input file once it has been created either 
by user or by the application. It can also be used to review the number of files processed or to get information about selected 
files. 

A batch file is created either by the application itself before the initiation of process or by the user to use the batch file as 

input to split process. When a batch file is created by the application then it has a file extension of .DAT and user created 

batch file is saved with a file extension of .TXT 

 

To create a batch file for time based splitting 

Follow the steps mentioned below to create a batch file for time based split operation: 

1. Open Notepad.exe 

2. Create a structure as given below: 

3. First file source path;First file output destination path;First file start date;First file end date;Second file source 

path;Second file output destination path;Second file start date;Second file end date; 

4. Date must be in MM/DD/YYYY format. 

5. Example: C:\PST1\Test1.pst;E:\Split_Destination1\;03/23/2000;09/05/2009;D:\PST File2\Test2.pst;D:\Split 

Destination2\;11/02/2001;05/28/2008; 



 

 

Note: There should be no space between parameters, even if they are for different files as shown above. Parameters are 
separated by semi colons. 

To create a batch file for size based splitting 

Follow the steps mentioned below to create a batch file for size based split operation: 

1. Open Notepad.exe 

2. Create a structure as given below: 

First file source path;First file output destination path;First file split size;Second file source path;Second file output 

destination path;Second file split size; 

3. Size must be in GB and no fraction in size is accepted. Size should be greater than 5GB and can have a value of 

10GB, 20GB, 30GB or 50GB. 

4. Example: C:\PST1\Test1.pst;E:\Split_Destination1\;2;D:\PST2\Test2.pst;D:\Split_Destination2\;7; 

Note: There should be no space between parameters, even if they are for different files as shown above. Parameters are 
separated by semi colons. 

To use already created batch file to split PST files 

Already created batch file can be used to split multiple PST files that are either saved at different locations or are stored in 
a folder. 

 

  

A batch file created for time based splitting can be used to split: 

 Multiple PST files at different locations. 



 

 

 Multiple PST files with multiple date ranges. 

 Multiple PST files located in a folder. 

A batch file created for size based splitting can be used to split: 

 Multiple PST files at different locations. 

 Multiple PST files located in a folder. 

  



 

 

3.5. View and Save Log Report 

With Stellar Splitter for Outlook, you can save the Log Report to analyze the split process at a later stage. 

To save log report: 

1. From Logs Menu, select Log Report. 

2. A log window appears on the screen displaying the details of the split files. 

 

3. Click Save button. 

4. In Save Log dialog box, click Browse and select the location where you want to save the log report. Click OK. 

  



 

 

4. Frequently Asked Questions (FAQ)  

1. Which version of MS Outlook is supported by the software? 

The software supports PST Files made with MS Outlook 2003, 2007, 2010, 2013, 2016 and 2019. 

2. Does the software maintain the integrity of the original PST files while splitting them? 

Yes, the software maintains the integrity of the original PST files while splitting them. 

3. Is it necessary to have MS Outlook installed on to the system where I want to split my PST file? 

This application requires MS Outlook installed on to the system where PST file is being split. 

4. How can Stellar Splitter for Outlook help me search for the location of PST file in the computer? 

You can search for PST file in a specific drive or folder using Find PST option of the software. For more details, please 

refer Find PST Files topic of the help manual. 

5. Can I split multiple PST files stored at different locations on the basis of date? 

You can split multiple file stored at different locations. Click here to check step by step procedure to split multiple files at 

different locations based on date range. 

6. Can I split multiple files stored at different locations on the basis of size? 

You can split multiple file stored at different locations. Click here to check step by step procedure to split multiple files at 

different locations based on size criteria. 

7. Can I split PST file on the basis of a mail id? 

Yes, you can split a single PST file according to e-mail ids. For more details, please refer Split Single PST By Mail ID topic 

of the help manual. 

8. Can I split my contacts & Calendars? 

When a PST file is split using date range, all contacts and calendar items are added to the newly created PST file. 

In case where PST file is split using size criteria, contact and calendar items are added to any one of the PST file. You 

can find out this by checking the log of split operation. 

9. What is a batch file? 

A batch file keeps all the settings and inputs of user for splitting multiple files. A batch file contains all the information 

required to split PST files such as number of files selected, their location path, destination path of output file, start date, 

end date, processed status or any other detail as required by the process. 

It can be used as input file once it has been created. It can also be used to review the number of files processed or to get 

information about selected files. 



 

 

A batch file is created either by the application itself before the initiation of process or by the user to use the batch file as 

input to split process. When a batch file is created by the application then it has a file extension of .DAT and user created 

batch file is saved with a file extension of .TXT 

The default location of batch file will be in Installation folder of the application. 

10. How can I create my own batch file? 

Creating a batch file makes splitting task very easy to follow. Click here to know step by step procedure to create a batch 

file. 

11. Can I create another PST file of one or more folders from my original PST file? 

It is possible to create a new PST file having only selected folders from original PST file. Click here to know step by step 

procedure to create PST file with one or more folders in How To section of this manual. 

12. What is "Apply Upto File Index" and how to use it? 

"Apply Upto File Index" is a very useful option that allows you to select same value of a criteria for multiple files. This 

saves you from selecting the value for every individual file separately. You can read the complete procedure of splitting 

PST files based on Apply Upto File Index in Split Multiple PST Files By Date and Split Multiple PST Files By Size section 

of this manual. 

13. Can we save process log? 

Yes, Stellar Splitter for Outlook gives you option to save log report of the process. 

To save log report: 

 From Logs Menu, select Log Report. 

 In Save Log dialog box, select the location where you want to save the log report. Click OK. 

14. I have a PST file exceeding 50 GB of size, does the new PST file generated will have same size as that of 

source PST file ? 

For large files, Stellar Splitter for Outlook automatically splits the new PST file in small sizes. The size of the split files 

will depend on the version of Outlook installed on your computer: 

If you have Outlook 2007 installed, the new PST will be split at approximately 18 GB size. 

If you have Outlook 2010 or above installed, the new PST will be split at approximately 45 GB to 48 GB of size. 
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1. Overview 

Microsoft Outlook data is stored in personal folders file that ends with PST extension. Almost all the data, one stores in 

various MS Outlook folders, goes in to PST file linked with that profile. Outlook PST file, also known as Outlook Data File 

contains all items like e-mails, alerts, to-do lists, tasks, journals, notes, contacts. Protecting this data is crucial since it 

contains confidential, personal and financial information. 

One of the major threats to Outlook PST file is its becoming oversized. PST files can be compressed to recover from this 

situation. Stellar Compactor for Outlook is designed to compact the size of PST files using powerful algorithms. The 

application performs deep scan of  the PST file and compacts all the e-mails, calendar, contacts, tasks, and notes.    

Key Features 

 Stellar Compactor for Outlook is a 100% result-oriented tool to compact Outlook PST files. 

 Software can extract the attachments and saves them in a new folder. Interlinking of the compacted PST file and 

attachments is preserved. 

 Software extracts the attachments, compresses them in zipped file (ZIP) and saves them in a new folder. Interlinking 

of compacted PST file and attachments is preserved. 

 Software can compact PST file without saving the attachments. This option will remove all attachments in the 

compacted PST file. 

 Application can compact any PST file of MS Outlook 2019/ 2016/ 2013/ 2010/ 2007/ 2003/ 2002/ 2000. 

 Application can empty Deleted Items folder while performing any compaction option. 

 Application can empty Junk E-mail folder while performing any compaction option. 

 Application also removes unused space. 

Note: The software never deletes or modifies data in original PST file. It creates a new PST file. 

  



 

 

2. User Interface 

Stellar Compactor for Outlook software has a very easy to use Graphical User Interface. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains menus and buttons that let you access various features of the software with ease. 

  



 

 

2.1. Menus 

1. Home Menu 

 

 Home : Use this option to go to the home page of the software. 

 Add PST : Use this option to add the PST file. 

 Find PST : Use this option to search PST files from the system. 

 Compact : Use this option to compact the PST file. 

 Stop : Use this option to stop the compact process. 

  

2. Logs Menu 

 

 Log Report : Use this option to view summary after the compact process. 

  

 

 



 

 

3. Registration Menu 

 

 Activation : Use this option to activate the software after purchasing. 

  

4. Support Menu 

 

 Update : Use this option to check for both, latest minor and major versions available online. 

 Purchase : Use this option to buy Stellar Toolkit for Outlook. 

 Support : Use this option view the support page of stellarinfo.com 

 Submit Enquiry : Use this option to submit enquiry to stellarinfo.com 

  

5. Help Menu 

 

 Help : Use this option to view the help manual for the software. 

https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

 

 Knowledgebase : Use this option to visit Knowledgebase articles of stellarinfo.com 

 About : Use this option to read information about the software. 

  

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/


 

 

2.2. Buttons 

 

Click this button to go to the Home page of the software. 

 

Click this button to add the PST file. 

 

Click this button to search PST files from the system. 

 

Click this button to compact the PST file. 

 

Click this button to stop the compact process. 

 

Click this button to view summary after the compact process. 

 

Click this button to register the software after purchasing. 

 

Click this button to check for both, latest minor and major versions available online. 

 

Click this button to buy Stellar Toolkit for Outlook software. 



 

 

 

Click this button to view the support page of stellarinfo.com. 

 

Click this button to submit enquiry to stellarinfo.com. 

 

Click this button to view the help manual for the software. 

 

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

Click this button to read information about the software. 

  



 

 

3. Features 

Stellar Compactor for Outlook software is a powerful application to compress Microsoft outlook PST file. It provides four 

options for compacting PST files. Compaction of PST file can be done with or without separating attachments. Extracted 

attachments can be saved into a new folder either in original form or in compressed zip files. The application also gives 

options to delete contents of the 'Deleted Items' and Junk E-mail' folder in compacted Outlook PST file. 

3.1. Compact Options 

3.2. Advance Compact Options     

  



 

 

3.1. Compact Options 

E-mails in the MS Outlook PST file may have attachments in them. Stellar Compactor for Outlook gives four options for 

attachments that can be set while compacting a PST file. Stellar Compactor for Outlook allows to extract attachments 

from PST file and save them in a new folder either in original form or in compressed zip format. Options to remove all 

attachments while compacting PST file are also available. Four compact options available in the application are: 

 Compress all attachments in new PST file 

 Extract and save attachments to a folder (no interlinking is lost) 

 Extract, compress and save attachments to a folder (no interlinking is lost) 

 Remove all the attachments in new PST file 

  



 

 

3.2. Advance Compact Options  

When e-mails are deleted in MS Outlook, the space occupied by them remains allocated. This space can grow up to large 

size in short span of time. Over sized PST files are more likely to corrupt than normal sized files. So, unused space must 

be released. Stellar Compactor for Outlook application helps in removing unused space while compacting PST file. It 

also provides an option to remove deleted items and junk mails from their respective folders. Three advanced compact 

options available in the application are as follows: 

 Remove Unused Space. 

 Empty 'Deleted Items' folder. 

 Empty 'Junk E-mail' folder. 

  



 

 

4. How To... 

4.1. Select PST file 

4.2. Find PST files 

4.3. Compact PST file 

4.4. Import PST files 

4.5. Relink Attachment Folder 

  



 

 

4.1. Select PST file 

To select a PST file, follow these steps. 

 Run Stellar Compactor for Outlook application. 

 Click on Add PST or you can also drag and drop PST file. 

  

 Open dialog box is displayed. 

 Browse for file location, select the PST file and click Open button.  



 

 

 

 Click Destination button to select the path where you want to save the compacted PST file. Default destination path 

is selected by default and is same as source path. 

.  

 Choose any of the Compact Options to compact PST file. 

 Choose Advance Compact Options to remove items. 

 Click on Compact button to continue. 



 

 

4.2. Find PST files 

Stellar Compactor for Outlook allows you to search for PST files in your computer. Using the Find PST option, you can 

search for PST files in your computer's drives, folders and sub folders. However, you can only select one drive at a time to 

search for PST files. 

To Find PST files in drives: 

 Run  Stellar Compactor for Outlook application. 

 Click on Find PST button. 

 

 Find PST File dialog box is displayed. 

      



 

 

       

 From Look in field under Find Options section, select the drive you want to search for PST files. Click Start. 

 After the search is finished, a list of PST files found in the selected drive is shown in Find PST File dialog box, under 

the Find Results section. 

  



 

 

      

Note: Click Clear List button to clear the search result. 

To Find PST files in folders and subfolders: 

1. From Home menu, click Find PST button. 

2. Find PST File dialog box opens. 

3. In Find PST File dialog box, click Find in folder button. Browse for Folder dialog box opens 



 

 

.  

4. Select the folder from which you want to search PST files. Click Start. Also, if you want to search subfolders within 

that folder, select Find in Subfolders checkbox. 

5. After the search is finished, list of PST files found in the selected folder is shown in Find PST File dialog box, under 

Find Results section. 

  



 

 

4.3. Compact PST file 

Stellar Compactor for Outlook software compresses the PST file and decrease the size acquired by them in the disk. 

This enhances greater use of memory and also saves PST files from being corrupted. To compact a PST file, follow these 

steps. 

 Run Stellar Compactor for Outlook application. 

 Select the PST file If do not know the path of your file, then you can search it by Find PST option of the application. 

 Click Destination button to select the path where you want to save the compacted PST file. Default destination path 

is selected by default and is same as source path. 

 

 Choose any of the Compact Options available for attachments. 

 Choose any of the Advance Compact Options as per your preference. 

 Click on Compact button to start the compaction process. 

  



 

 

 

 On completion of process a Log Report is displayed that shows the details of the compacted file. 

 

 The compacted file name is same as the source file suffixed with Compressed.pst 

Note: You need to import compacted PST file to view it in MS Outlook 

  



 

 

4.4. Import PST files 

To import PST file in Microsoft Outlook 2019 / 2016 / 2013: 

 Open Microsoft Outlook. From File Menu, select Open & Export. 

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. Click 

Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select Open and Import 

from File Menu) 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. Click 

Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2007: 

 Open Microsoft Outlook. From File menu, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. Click 

Next. 



 

 

 In Import Personal Folders dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

  



 

 

4.5. Relink Attachment Folder  

Once you install Stellar Toolkit for Outlook software, you also get a software called Stellar Attachment Links Updater. 

You will need this software to relink the attachment folder when you move it after using Extract and save attachments to a 

folder (No interlinking is lost) or Extract, compress and save attachments to a folder (No interlinking is lost) option. 

Note: You can move the attachments folder to a different location on the same local machine or you can move both the 

PST file and the attachments folder to another machine. This software will link the attachments folder to the PST file in 

both these scenarios. 

In these two cases, you can use Stellar Attachment Links Updater software to relink the attachments to the mails. 

Follow the steps given below to relink the attachments to the mails: 

1. Go to Start -> Programs -> Stellar Toolkit for Outlook ->Stellar Attachment Links Updater. A Relink 

Attachment Folder dialog box will appear. 

  

2. Click on Select PST and Select Folder button to browse to and select the PST file and it's attachment folder. 

3. Click on Relink Attachment button to relink the attachments to the mails. 

4. 'Relinking process completed' message will be displayed on completion of process.  



 

 

5. FAQs 

1. What is Stellar Compactor for Outlook? 

Stellar Compactor for Outlook is a software application that helps in reducing the size of MS Outlook PST files. It has 

various options for attachments of mails that can be selected for compaction. Unused space taken by deleted items can 

also be wiped by help of this application. 

2. What is need to compact PST files? 

MS Outlook stores all the data i.e. e-mails, personal data, calendar, tasks, etc. in a PST file. Eventually this file becomes 

over sized with time. Also, when we delete items in any of the folders of a PST file, space allocated to them is kept intact. 

Hence, there is no difference to size. Oversized PST files are prone to corrupt so they must be compacted when ever 

oversized. Stellar Compactor for Outlook compacts size and deletes unused space of PST files. 

3. Can I extract all my attachments in a separate folder while compacting the PST file? 

Yes, you can extract the attachments in a separate folder. To do this, choose the Extract and save attachments to a 

folder  option in the Compact Option before starting the compact process. Interlinking of the attachments and PST file is 

preserved after compaction. 

4. Can I get a PST file after compaction that has only the messages and no attachments? 

Yes, You can get it by choosing the Remove all the attachments in new PST file  option in the Compact Option before 

starting the compact process. The compacted PST file will have only messages and other items but no attachments. 

5. I do not want any item in my Deleted items folder after compacting the PST file? How to do this? 

You can empty Deleted Items folder in the compacted PST file. To do this, select the Empty 'Deleted Items' 

folder  option in the Advance Compact Option before starting the compact process. 

6. Can I delete all the junk items in my compacted PST file? 



 

 

Yes, you can empty the Junk Items folder in PST file. Choose Empty 'Junk E-mail' folder option in Advance Compact 

Option to do this. 

7. How to import the compacted PST file in MS Outlook? 

Import the PST file in MS Outlook application to view it. To do this, 

1. Open Microsoft Outlook. On the File menu, select Import and Export. 

2. In the Import and Export Wizard, select Import from another program or file, click Next. 

3. In the Import a File box, select Personal Folder File (PST), click Next. 

4. Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. Click 

Next. 

5. In the Import Personal Folders dialog box, select the folders that should be imported in Microsoft Outlook. Click Finish. 
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1. Overview 

Stellar Compactor for Outlook helps in compressing PST and OST file. The software allows the users to automatically 

manage incoming and outgoing mail attachments. Stellar Compactor for Outlook gives various options to manage mail 

attachments. By help of Stellar Compactor for Outlook, user can replace the extracted attachments with a shortcut in 

the mails, compress the attachment in the mail itself, or extract and compress the attachments to a separate folder. 

Extracted attachments can also be restored in the mails by help of the software. Moreover, you can schedule the 

application to run at a preset time of week day(s). The software adds itself to MS Outlook application tool bar for quick 

launch.    

The software allows users to select specific attachment extraction and compaction method.  

Key Features  

 Compacts .PST and .OST files. 

 Extract attachments and replace it with shortcut link to extract attachment file. 

 Stellar Compactor for Outlook is installed as Add Ins application in MS Outlook. 

 Compacts incoming and outgoing e-mails. 

 No need to close MS Outlook during compaction process. 

 Extracts and compresses attachments. 

 Extract attachments and save it to separate location. 

 Can be used with both Microsoft Exchange server and POP3 Internet mail. 

  



 

 

2. Features 

Stellar Compactor for Outlook software is a powerful application to compress Microsoft outlook PST file and manage 

attachments of mails. It provides three options for compacting PST files. Extracted attachments can be saved into a new 

folder either in original form or in compressed zip files. Moreover, the compact options can be set to process incoming and 

outgoing mails without any user intervention. A log report is also provided to review the process at later stage. 

 Compact Options 

 Works as Add Ins Application 

 Compacts Incoming and Outgoing Mails 

 Log Report 

  



 

 

2.1. Compact Options 

E-mails in the MS Outlook PST file may have attachments in them. Stellar Compactor for Outlook gives three options 

for attachments that can be set while compacting a PST file. The application allows to extract attachments from the mail 

and save them in a new folder either in original form or in compressed zip format. A shortcut to the extracted attachments 

is left in the mails. The three compact options available in the application are: 

 Extract and save attachments to a folder. A shortcut to the saved attachment is left in the mail. 

 Compress the attachment in the mail itself. Note that once the attachments are compressed they can not be restored 
in their original form. 

 Extract, compress and save attachments to a folder. A shortcut to the saved attachment is left in the mail. 

  



 

 

2.2. Works as Add Ins Application  

When Stellar Compactor for Outlook software is installed, no desktop icon or link in program file menu is added. A link 

to the software is added in MS Outlook application tool bar, in the form of icon. Also, a link is added in MS Outlook menu 

option. 

To start Stellar Compactor for Outlook application, follow these steps, 

1. In MS Outlook application, 

 Click on the Stellar Compact link in MS Outlook tool bar. 

 

  

 Or, On Tools menu, click Stellar Compactor for Outlook. 



 

 

 

 Or, On Stellar Compactor for Outlook menu, click Stellar Compactor for Outlook icon. 

 

After launching the program, you will see the screen as shown below: 



 

 

 

Stellar Compactor for Outlook makes use of the following buttons: 

 

Click this button to open the help manual for Stellar Compactor for Outlook. 

 

Click this button to register the software after purchasing. 

 

Click this button to start the process. 

 

Click this button to close Stellar Compactor for Outlook add-in. 

 

Click this button to update the attachments storage path. 

 

Click this button to stop the running process. 

 

Click this button to save the log report. 

  



 

 

2.3. Compacts Incoming and Outgoing Mails  

Stellar Compactor for Outlook gives an option to set the application to extract attachments or compact attachments. 

These options can be set to run automatically on incoming and outgoing mails. Attachments from the incoming mails are 

automatically detached and saved in a folder. Same process can be applied for outgoing mails. Both the activities run 

without any user intervention. 

Compaction of mails in Inbox and Sent Items folder can be done by running the Stellar Compactor for Outlook process 

manually. 

  



 

 

2.4. Log Report 

Log report helps to analyze the process and activities executed by user and the application. Stellar Compactor for 

Outlook gives an option to save the log report of all its activities as text. 

To save log report shown at end of the process, follow these steps, 

1. Click Save Log button in the application. Save As dialog box is displayed. 

2. Select location and type a name for the log file. 

 

3. Click Save. A message confirms the save process. Click OK. 

4. Click Close button to close the log window. 

  



 

 

3. How To... 

3.1. Compact PST and OST Files 

3.2. Extract Attachments of Mails 

3.3. Restore Attachments of Mail 

3.4. Filter Attachments of Specific File Types from Being Extracted 

3.5. Extract Attachments According to Hierarchy 

3.6. Apply Settings to Incoming and Outgoing Mails 

3.7. Select Storage Path for Attachments 

3.8. Select Folders on Which the Settings Will Take Effect 

3.9. Change Attachment Path Folder 

3.10. Schedule Settings for the Application 

  



 

 

3.1. Compact PST and OST Files  

Stellar Compactor for Outlook software compresses the PST and OST files and decrease the size acquired by them. 

This enhances greater use of memory and also saves the Outlook data files from being corrupted. 

To compact an Outlook data file, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select Compact Outlook Data File option. 

4. Choose any of the 'Compact Options' available for attachments. 

5. In Filter Attachments section, select the check box if you want to Filter Attachments of Specific File Types from 
Being Extracted. 

6. Apply Settings. 

7. Select attachments storage path. 

8. Click Run Process button to start the process. A progress bar shows advancement of the process. 



 

 

 

9. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

10. A Log report is displayed that shows the details of the process. 

  



 

 

3.2. Extract Attachments of Mails  

Stellar Compactor for Outlook gives an option to extract attachments from the mails without making any changes to the 

mail and the attached files. You can save the attachments at your preferred location. 

To extract attachments of mails, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select Extract attachments of mails. Mails remain intact 
option. 

4. In Filter Attachments section, select the check box if you want to Filter Attachments of Specific File Types from 
Being Extracted. 

5. Apply Settings. 

6. Select attachments storage path.   

7. Click Run Process button to start the process. A progress bar shows advancement of the process. 

8. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 



 

 

 

9. A Log report is displayed that shows the details of the process. 

  



 

 

3.3. Restore Attachments of Mail  

After you have extracted your mail attachments, a shortcut is left with the mails. Stellar Compactor for Outlook software 

gives an option to restore the extracted attachments to the mails. Shortcuts to the attachments will be replaced by the 

attachment files. 

To restore attachment of mails, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select Restore attachments of mails option. 

4. Select attachments storage path. 

5. Click Run Process button to start the process. A progress bar shows advancement of the process. 

6. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

7. A Log report is displayed that shows the details of the process. 

  



 

 

3.4. Filter Attachments of Specific File Types from Being 

Extracted 

While extracting attachments from the mails you can restrict attachments of certain file types from being extracted. 
Attachments of the specified types remain intact in the mails. 

To filter attachments of some specific file types from being extracted, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select the extraction option. 

4. In the Filter Attachments section, Select Filter attachments extensions not to be processed in extraction 
option. Filter Attachment Extension dialog box is displayed. 

5. Filter Attachment Extension dialog box shows a list of extensions that are to be ignored while extraction. 

 To add a file extension, 

 Type a file type in Enter file extension to exclude: text box. 

 Click Add button. Added file type will be shown in the 'Excluded Extensions' list. 

 To remove a file type from the list, 

 Click on the file type in the Excluded Extensions list. 

 Click Remove button. 



 

 

6. Click Save button for the changes to take effect. Or, click Cancel button to undo the changes and close the dialog 
box. 

7. Click Run Process button to start the process. A progress bar shows advancement of the process. 

8. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

9. A Log report is displayed that shows the details of the process. 

  



 

 

3.5. Extract Attachments According to Hierarchy  

Extracted attachments are saved in a folder at the default path provided in the Stellar Compactor for Outlook 

application. By default, hierarchy of the attachments is not maintained and all the folders are saved at same level. If you 

want to save the attachments according to their hierarchy, the application gives you an option to do this. 

To save attachments according to their hierarchy in the mail, follow these settings, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select the extraction option. 

4. In the Attachments Saving Option, Select Save processed attachments according to folder hierarchy option. 

By default, this option is selected. 

5. Click Run Process button to start the process. A progress bar shows advancement of the process. 

6. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

7. A Log report is displayed that shows the details of the process. 

  



 

 

3.6. Apply Settings to Incoming and Outgoing Mails  

After making all the changes and selection the required options, you can set the application to perform the set options 

only on incoming mails or on outgoing and moved mails. 

To apply the settings only to incoming mails or to outgoing and moved mails, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, Select the extraction option. 

4. In the Apply Settings To option, 

5. Select Incoming Mails option if you want to save the settings for incoming mails. 

6. Select Outgoing Mails & Moved Mails option if you want to save the settings for outgoing and moved mails. You 

can also select both the options. 

7. Click Run Process button to start the process. A progress bar shows advancement of the process. 

8. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

9. A Log report is displayed that shows the details of the process.  



 

 

3.7. Select Storage Path for Attachments  

Stellar Compactor for Outlook gives an option to select a folder where the extracted attachments from the mails will be 

saved. 

To select storage path for attachments, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Extract, Compact and Restore Options section, select the options. 

4. Click Browse button in Select attachments storage path section. 

5. Select the folder where you want to save the attachments. Click OK. 

6. Click Run Process button to start the process. A progress bar shows advancement of the process. 

7. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

8. A Log report is displayed that shows the details of the process. 

  



 

 

3.8. Select Folders on Which the Settings Will Take 

Effect 

You can select specific folders of MS Outlook on which you want the settings for extraction and compression to take 
place. The saved settings will be applicable only on the selected folders. 

To use this option, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Apply To tab. Select Folders section is displayed in the application window. 

 

3. In the Select Folders section select the folders on which you want the settings to take place. By default, all the 
folders are selected. 

4. Click Run Process button to start the process. A progress bar shows advancement of the process. 

5. After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

6. A Log report is displayed that shows the details of the process. 

  



 

 

3.9. Change Attachment Path Folder 

If you want to change the attachments storage path while keeping the previously saved links for settings for compression 
and extraction, the application gives you an option to do this. 

To change path of the folder where attachments will be saved, follow these steps, 

1. Click the Storage Settings tab in application. Update Attachments Folder Path section is displayed in the 
application window. 

2. Current path for the storage of attachment is shown. Click Browse button in the New Attachment Folder Path 
section. Select the folder where you want to save the attachments. 

 

3. Click Update Path button for the settings to take effect. 

Note: It is best to select the root node as path for saving the attachments. 

  



 

 

3.10. Schedule Settings for the Application 

Stellar Compactor for Outlook can be set to start automatically at a preset time and date. You can set the application to 
run every time MS Outlook is started, or to run on specific days in a week at a preset time. 

To schedule the Stellar Compactor for Outlook, follow these steps, 

1. Run Stellar Compactor for Outlook Application. 

2. Click the Settings tab. By default, this tab is in active position. 

 

3. In the Compact Scheduler section, select Schedule settings for compacting 'Outlook Data File' option. 

Compact Scheduler dialog box is displayed. 

o To compact Outlook data file every day at start of MS Outlook application, 

o In the Everyday at section, select Start of MS Outlook. 

4. To compact Outlook data file on specific days of week at a specified time, 

o In the Specified Day & Time section, select Compact Daily at and set time. 

o Select the days on which you want to run the application automatically. 

5. Click OK button. 

  



 

 

4. FAQs 

1. What does the demo version of the software do? 

Demo version of the software only provides you with " Extract attachments of mails. Mails remain intact " option. To 
use the full functionality of the software, you need to purchase and register the software. 

2. What is Stellar Compactor for Outlook? 

Stellar Compactor for Outlook is a software application that helps in reducing the size of PST files and managing the 
attachments. It has various options for attachments of mails that can be selected for compaction and extraction. 

3. What is need to compact PST files? 

MS Outlook stores all the data i.e. e-mails, personal data, calendar, tasks, etc. in a PST file. Eventually this file becomes 
over sized with time. Oversized PST files are prone to corrupt so they must be compacted when ever oversized. Stellar 
Compactor for Outlook compacts size. Also some times we need to collect all the attachments at one place for personal 
review. Stellar Compactor for Outlook gives various options to manage attachments. 

4. Can I extract all my attachments in a separate folder while compacting the PST file? 

Yes, you can extract the attachments in a separate folder. To do this, choose the Extract attachments and leave 
shortcuts in mails in Compacting Option before starting the compact process. The attachments are left as shortcut 
links in the mails. 

5. Can I have restore the shortcut links of attachments? 

Yes, You can restore the shortcuts by choosing the Restore Attachments of mails  option in the Compact Outlook 
Data File section of the application. 

6. I want to run the software on selected folders of PST files. Can I choose some selected mailbox folders in the 
application? 

Yes,  You can apply extraction and compaction settings on selected folders. To do this, select the Apply To tab and 
select the folders on which you want the settings to take effect. 

7. I want to extract the attachments of my incoming mails automatically to a folder. How can I do this? 

To extract attachments of the incoming mails, follow these steps. 

 Run Stellar Compactor for Outlook Application. 

 Click the Settings tab. By default, this tab is in active position. 

 In the Extract, Compact and Restore Options section, Select the extraction option. 

 In the Apply Settings To option, 

 Select Incoming Mails option if you want to save the settings for incoming mails. 

 Click Run Process button to start the process. A progress bar shows advancement of the process. 



 

 

 After the process is completed successfully, a message appears indicating its successful completion. Click OK. 

 A Log report is displayed that shows the details of the process. 

 

 

  



 

 

 

 

 

 

 

 

 

 

 

Stellar Deduplicator for Outlook 

User Guide for Version 6.0 

  



 

 

1. Overview 

Duplicate items are often present in the Outlook mailbox. Multiple copies of a mail are saved when replies or forwarding is 

done to many persons. Duplicate mails can be present any where from Inbox or Outbox folder to Sent Items folder. These 

duplicate mails, unnecessarily increase the size of PST files. Your PST file can get oversized than its prescribed limit and 

get corrupted. Large sized PST files often slow the system. 

Stellar Deduplicator for Outlook is a powerful software to remove duplicate items from MS Outlook mailboxes. The 

application easily and precisely removes duplicates according to the set comparison criteria. A wide range of comparison 

criteria is given in the software. You can compare and mark the mails as flagged, expired, copy or move the duplicate 

mails to a folder. you can also delete the duplicate mails to move them in deleted items folder or delete them permanently. 

Key Features 

 Simple and easy-to-use interface 

 Removes duplicate MS Outlook items precisely 

 Duplicate e-mail items can be flagged 

 Duplicate e-mail items can be marked as expired 

 Duplicate e-mail items can be Copied/Moved to folder 

 Duplicate e-mail items can be moved to 'Deleted Items' folder 

 Duplicate e-mail items can be permanently deleted 

 Any number of mailbox e-mail folders can be selected at a time for detecting duplicates 

 Time range of e-mails and other items can be set for finding duplicates items 

 A number of duplicate matching criteria are provided 

 Allows duplicate scanning criteria like text, subject, sender e-mail, sender name, receiver name, internet header, date 

and time of sending, and attachment files 

 PST file size is reduced by removal of duplicate mails 

 Support for MS Outlook 2016 / 2013 / 2010 / 2007 / 2003 

  



 

 

2. Features 

Stellar Deduplicator for Outlook software is a powerful application to remove duplicate mails from Microsoft Outlook. It 

provides options for selecting mail folders, setting a scan criteria and executing preferred action on the duplicate mails. A 

log report is also provided to review the process at later stage. Its main features are: 

2.1. Works as Add Ins Application 

2.2. Time Span 

2.3. Comparison Criteria to Scan Duplicates 

2.4. Personalized Action on the Duplicates 

  



 

 

2.1. Works as Add Ins Application  

When Stellar Deduplicator for Outlook software is installed, no desktop icon or link in program file menu is added. A link 

button to the software is added to MS Outlook application tool bar, in the form of icon. Also, an option is added in MS 

Outlook Tools menu. 

To start Stellar Deduplicator for Outlook application, follow these steps. 

1. Start MS Outlook application, 

 Click on the Stellar Deduplicator for Outlook link in MS Outlook tool bar. 

 

 Or, on Tools menu, click Stellar Deduplicator for Outlook option. 



 

 

 

 Or, on Stellar Deduplicator for Outlook menu, click Stellar Deduplicator for Outlook icon. 

 

 After launching the program, you will see the screen as shown below: 



 

 

 

Stellar Deduplicator for Outlook makes use of the following buttons: 

 

Click this button to read more information about the software. 

 

Click this button to activate the software after purchasing. 

 

Click this button to open the help manual for Stellar Deduplicator for Outlook. 

 

Click this button to move to the next window of the application. 

 

Click this button to start the process. 

 

Click this button to move to the previous window of the application. 



 

 

 

Click this button to save the log report. 

 

Click this button to close Stellar Deduplicator for Outlook add-in. 

  



 

 

2.2. Time Span 

Stellar Deduplicator for Outlook allows its users to select a time range. Mail items falling within the selected time period 

will be checked for duplicates. 

 

Time span options 

 Last Day: Mail items sent or received on the last day (previous day) will be scanned for duplicates 

 Last 2 days:Mail items sent or received in last 2 days will be scanned for duplicates 

 Last 5 days: Mail items sent or received in last 5 days will be scanned for duplicates 

 Last 10 days:Mail items sent or received in last 10 days will be scanned for duplicates 

 Last 20 days:Mail items sent or received in last 20 days will be scanned for duplicates 

 Last 30 days:Mail items sent or received in last 30 days will be scanned for duplicates 

 Last 50 days:Mail items sent or received in last 50 days will be scanned for duplicates 

 Last 75 days:Mail items sent or received in last 75 days will be scanned for duplicates 

 Last 100 days:Mail items sent or received in last 100 days will be scanned for duplicates 

 Last year:Mail items sent or received last year will be scanned for duplicates 

 Anytime: All the Mail items sent or received will be scanned for duplicates 

  



 

 

2.3. Comparison Criteria to Scan Duplicates  

Stellar Deduplicator for Outlook gives various matching criteria options to find duplicate mail items. You can choose 

from a list of criteria available before scanning your mailbox.  

 

Comparison Criteria 

 Text: Two mails will be regarded as duplicate if their content is same. This is checked by default. 

 Subject: Two mails will be regarded as duplicate if their subject is same. This is checked by default. 

 Sender Email: Two mails will be regarded as duplicate if they are sent by same Email ID. This is checked by 

default. 

 Sender Name: Two mails will be regarded as duplicate if their sender name is same. 

 Receiver Name: Two mails will be regarded as duplicate if their receiver name is same. 

 Internet Header: Two mails will be regarded as duplicate if their internet header is same. 

 Attachment Files: Two mails will be regarded as duplicate if they have same attachment. 

 Date and Time of Sending: Two mails will be regarded as duplicate if their date and time of sending is same. 

  



 

 

2.4. Personalized Action on the Duplicates  

After scanning of the mail items is over. You can set an action to be taken on the found duplicate mail items according to 

your choice. 

 

Available Action 

 Mark with the Flag: All the duplicate mails found will be marked as flagged 

 Mark as Expired:  All the duplicate mails found will be marked as expired 

 Copy to folder...: All the duplicate mails found will be copied to a folder 

 Move to folder...: All the duplicate mails found will be moved to a folder 

 Delete (move to Deleted Items folder): All the duplicate mails found will be moved to Deleted Items folder 

 Deleted permanently:  All the duplicate mails found will be permanently deleted and will not be recovered 

  



 

 

3. How To... 

3.1. Select Folder(s) to Scan for Duplicates 

3.2. Remove Duplicate Mails 

3.3. Save Log Report 

  



 

 

3.1. Select Folder(s) to Scan for Duplicates  

 Launch Stellar Deduplicator for Outlook. 

 Folder List window appears as the home screen of the application. A list of all user mailboxes existing in MS Outlook is 

shown as a tree. Folder named Top of Outlook data file is the root node. 

 Select any folder to select all the sub folders under that node. You can also individually select folders. Mail items in the 

selected folders will be matched for duplicates. 

         

  



 

 

3.2. Remove Duplicate Mails 

 Launch Stellar Deduplicator for Outlook. 

 Select Folder(s) to Scan for Duplicates 

 Click Next button. 

 Select Time Span. This section lets you define the time range within which the software will check for duplicates in email 

items. 

 Select Any time option in drop down list to include all the mail items 

 Or, select the appropriate time span from the list (Last day, Last 2 days, Last 5 days, Last 10 days, Last 20 days, Last 

30 days, Last 50 days, Last 75 days, Last 100 days, Last year). 

 Select Comparison Criteria that will be used to match mails for duplicates. 

 Select Action that will be executed on the found duplicate items. 

 Click Run Process button to start removing duplicates from Outlook. 

  



 

 

3.3. Save Log Report 

Log report helps to analyze the process and activities executed by user and the application. Stellar Deduplicator for 

Outlook gives an option to save the log report of all its activities as text. 

To save log report shown at end of the process, follow these steps: 

 Click Save Log button in the application. Save As dialog box is displayed. 

 Select location and type a name for the log file. 

 

 Click Save. A message confirms the save process. Click OK. 

 Click Close button to close the log window. 

  



 

 

4 FAQs 

1. What does the demo version of the software do? 

Demo version of the software is only for evaluation purpose. To use the full functionality, you need to purchase and 

register the product. 

2. What is Stellar Deduplicator for Outlook? 

Stellar Deduplicator for Outlook is a powerful software to remove duplicate items from MS Outlook mailboxes. The 

application easily and precisely removes duplicates according to the set comparison criteria. 

3. What is need to find duplicate mails? 

MS Outlook stores all the mail items in a PST file. Eventually this file becomes over sized with time. Oversized PST files 

are prone to corrupt so they must be compacted when ever oversized. Stellar Deduplicator for Outlook finds 

duplicates and prevents the files from over sizing. 

4. Can I extract all my duplicate mails in a separate folder? 

Yes, you can move all mails in a separate folder. To do this, choose the Copy to folder... in Select Action. 

5. I don't remember the mail items I deleted last time. Is there any way to know it? 

Yes, Stellar Deduplicator for Outlook gives an option to save the log report of all its activities as text. Open the log report 

and view the items deleted last time.   

6. I want to run the software on selected folders of PST files. Can I choose some selected mailbox folders in 

the application? 

Yes, you can set the application to find duplicates from selected folders. To do this, select the folders in the Select 

folders dialog box and select the folders in which you want the application to find the duplicate mails. 



 

 

7. I have got mails from different people with same attachment. How to delete these mails with same 

attachment? 

To find mails with same attachments, follow these steps: 

 Launch Stellar Deduplicator for Outlook. 

 Select Folder(s) to scan for duplicates 

 Click Next button 

 Select Time Span. This section lets you define the time range within which the software will check for duplicates 

in email items. 

 Select Any time option in drop down list to include all the mail items 

 Or, select the appropriate time span from the list (Last day, Last 2 days, Last 5 days, Last 10 days, Last 20 days, 

Last 30 days, Last 50 days, Last 75 days, Last 100 days, Last year) 

 Select Attachment Files in the Comparison Criteria section. 

 Select Action that will be executed on the found duplicate items.  

 Click Run Process button to start removing duplicates from Outlook. 

  



 

 

 

 

 

 

 

 

 

 

  

Stellar Password Recovery for Outlook  

User Guide for version 6.0 

 

  



 

 

1. Overview 

Stellar Password Recovery for Outlook is a complete solution to recover lost and forgotten password of email accounts 

of Microsoft Outlook. 

You can recover password of PST files by using Stellar Password Recovery for Outlook. All valid passwords will be 

generated by Stellar Password Recovery for Outlook that can be used to open PST files. However, the exact password 

will not be generated but a series of password will be available to open PST file. You can use any of the password generated 

by Stellar Password Recovery for Outlook to open PST files. 

Key features: 

 Supports drag and drop of selected files. 

 Recovers lost or forgotten password of Microsoft Outlook PST files. 

 Supports MS Outlook 2000, 2002, 2003, 2007, 2010, 2013, 2016. 

 

  



 

 

2. User Interface 

Stellar Password Recovery for Outlook software has a very easy to use Graphical User Interface. 

After launching the program, you will see the main user interface as shown below: 

 

The user interface contains menus and buttons that let you access various features of the software with ease. 

  



 

 

2.1. Menus 

1. Home Menu 

 

 Home : Use this option to go to the home page of the software. 

 Add PST : Use this option to add the PST files for which you want to recover the password. 

 Find PST : Use this option to search PST files from the system. 

 Find Password : Use this option to start the password recovery process. 

 Stop : Use this option to stop the password recovery process. 

  

2. Activation Menu 

 

 Activate : Use this option to activate the software after purchasing. 

  

3. Support Menu 

 

 Update Wizard : Use this option to check for both, latest minor and major versions available online. 

 Purchase : Use this option to buy Stellar Toolkit for Outlook. 

 Support : Use this option view the support page of stellarinfo.com 

 Enquiry : Use this option to submit enquiry to stellarinfo.com 

https://www.stellarinfo.com/email-tools/outlook-toolkit/buy-now.php
http://www.stellarinfo.com/support/
http://www.stellarinfo.com/
http://www.stellarinfo.com/support/enquiry.php
http://www.stellarinfo.com/


 

 

4. Help Menu 

 

 Help : Use this option to view the help manual for the software. 

 Knowledgebase : Use this option to visit Knowledgebase articles of stellarinfo.com 

 About : Use this option to read  information about the software. 

  

5. Style Menu 

 

 Style : Use this option to switch between various themes for the software, as per your choice. 

  
  

https://www.stellarinfo.com/support/kb/index.php/category/outlook-manager
http://www.stellarinfo.com/


 

 

2.2. Buttons 

 

  

  

Click this button to go to the Home page of the software. 

 

  

  

Click this button to add the PST files for which you want to recover the password. 

 

  

  

Click this button to search PST files from the system. 

 

  

Click this button to start the password recovery process. 

 

  

  

Click this button to stop the password recovery process. 

 

  

  

Click this button to activate the software after purchasing. 

 

  

  

Click this button to check for both, latest minor and major versions available online. 

 

  

  

Click this button to buy Stellar Toolkit for Outlook software. 



 

 

 

  

  

Click this button to view the support page of stellarinfo.com. 

 

  

  

Click this button to submit enquiry to stellarinfo.com. 

 

  

  

Click this button to view the help manual for the software. 

 

  

  

Click this button to visit Knowledgebase articles of stellarinfo.com. 

 

  

  

Click this button to read information about the software. 

  
  



 

 

3. How To... 

3.1  Add PST File 

3.2  Find PST File 

3.3. Find Password 

3.4. Import PST File 

  



 

 

3.1. Add PST File 

Stellar Password Recovery for Outlook allows you to select PST files from your computer for the password recovery 

process. 

To add PST file: 

 Run Stellar Password Recovery for Outlook. 

 

 From the Home menu, click Add PST button. An Open dialog box will appear. Browse and select the desired file 

and then click Open. 

Or, 

Drag and drop the desired file to the application. 

Or, 

Click Drag & Drop to add PST button on the main user interface. An Open dialog box will appear. Browse and select 

the desired file and then click Open. 

  



 

 

3.2. Find PST Files 

Stellar Password Recovery for Outlook allows you to find PST files in your computer's hard drive, in case you don't know 

their location. With the help of 'Find PST' option, you can find PST files in any folder, subfolder or an entire volume in your 

system. 

To Find a PST File: 

1. Run Stellar Password Recovery for Outlook application. 

2. From the Home menu, click Find PST. 

3. In Browse for Folder dialog box, select the drive you want to search for PST files. Click OK. 

4. After the search is finished, a list of PST files found in the selected drive is shown. 

5. Select files for which you wish to recover the password and click Find Password button to proceed to the password 

recovery process. 

  



 

 

3.3. Find Password  

You can recover password of any PST file by using Stellar Password Recovery for Outlook. All valid passwords will be 

generated by the software that can be used to open PST files. You can use any of the generated passwords to open your 

PST file. 

To recover password of PST file: 

1. Run Stellar Password Recovery for Outlook. 

2. Select the PST file whose password you wish to recover or if you don't know the location of your PST file you can 

use Find PST option to search for PST files. A list of all the available PST files will be displayed from which you 

can select your desired file for the password recovery process. 

3. Click Find Password. 

 

4. A series of passwords will be generated which can be used to open your PST file. 



 

 

 

Note: Exact password will not be generated but all valid passwords will be available to open PST file. 

  



 

 

3.4. Import PST File 

To import PST file in Microsoft Outlook 2016 / 2013: 

 Open Microsoft Outlook. From File Menu, select Open & Export. 

 Select Import / Export option from the right pane. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2010: 

 Open Microsoft Outlook. From File Menu, select Open -> Import. (For MS Outlook 2013, select Open and Import 

from File Menu) 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Outlook Data File (.pst), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Outlook Data File dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

To import PST file in Microsoft Outlook 2007 / 2003: 

 Open Microsoft Outlook. From File menu, select Import and Export. 

 From Import and Export Wizard window, select Import from another program or file, click Next. 

 In Import a File dialog box, select Personal Folder File (PST), click Next. 

 Click Browse to locate the PST file that needs to be imported. In the options box, select an appropriate option. 

Click Next. 

 In Import Personal Folders dialog box, select the folders that should be imported in Microsoft Outlook. Click 

Finish. 

  



 

 

4. FAQ's 

1. I have forgotten the path of my PST file. Can this application search it for me? 

Yes, the application can look for PST file on your system and find it for you easily. There is a dedicated Find PST 

option in the application through which you can locate a particular PST and run password recovery on it. 

2. What version of outlook is supported by the software ? 

The software Supports PST Files made by MS Outlook 2016, 2013, 2010, 2007, 2003, 2002, and 2000. 

3. How Can I Recover Password of a PST file ? 

Please follow the below procedure to recover the password. 

 Open the Stellar Password Recovery for Outlook software 

 Click Add PST button. 

 Navigate to the file, select it and click Open. 

 Click Find Password to recover the passwords. 

Software will show the password of the PST file. 

4. Does this software recover original password for the PST files? 

No, the application does not recover the exact password but will generate all valid password to open the PST file. 

  



 

 

Legal Notices 

Copyright 

Stellar Toolkit for Outlook software, accompanied user manual and documentation are copyright of Stellar Information 

Technology Private Limited with all rights reserved. Under the copyright laws, this user manual cannot be reproduced in 

any form without the prior written permission of Stellar Information Technology Private Limited. No Patent Liability is 

assumed, however, with respect to the use of the information contained herein. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject to change without 

notice. 

STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED PROVIDES NO WARRANTY WITH REGARD TO THIS 

MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREBY EXPRESSLY DISCLAIMS ANY 

IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD 

TO ANY OF THE FOREGOING STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED ASSUMES NO LIABILITY 

FOR ANY DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY TECHNICAL OR TYPOGRAPHICAL 

ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE 

MANUAL. IN NO EVENT SHALL STELLAR INFORMATION TECHNOLOGY PRIVATE LIMITED, BE LIABLE FOR ANY 

INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER BASED ON TORT, CONTRACT 

OR OTHERWISE, ARISING OUT OF OR IN CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION 

CONTAINED HEREIN OR THE USE THEREOF. 

Trademarks 

Stellar Toolkit for Outlook® is a registered trademark of Stellar Information Technology Private Limited. 

Windows 7®, Windows 8®, Windows 8.1®, Windows 10® are registered trademarks of Microsoft® Corporation Inc. 

All Trademarks Acknowledged. 

All other brands and product names are trademarks or registered trademarks of their respective companies. 

END USER LICENSE AGREEMENT 

PLEASE READ THIS AGREEMENT CAREFULLY. BY DOWNLOADING, INSTALLING, COPYING, ACCESSING OR 

USING THIS SOFTWARE, ALL OR ANY PORTION OF THIS SOFTWARE, YOU (HEREINAFTER “CUSTOMER”) 



 

 

ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT WHICH WILL BIND YOU. THE TERMS OF THIS 

LICENSE INCLUDE, IN PARTICULAR, LIMITATIONS ON LIABILITY CLAUSE. 

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE WILL NOT LICENSE THE SOFTWARE AND 

DOCUMENTATION TO YOU AND YOU MUST DISCONTINUE THE INSTALLATION PROCESS NOW, AND PROMPTLY 

RETURN THE SOFTWARE AND PROOF OF ENTITLEMENT TO THE PARTY FROM WHOM YOU ACQUIRED THE 

SOFTWARE. 

1. DEFINITIONS. 

1.1 “Stellar” means Stellar Information Technology Pvt. Ltd., having its registered office at 205, Skipper Corner, 88, Nehru 

Place, New Delhi, India 110019. 

1.2 “Compatible Computer” means a Computer with the recommended operating system and hardware configuration as 

stated in the Documentation. 

1.3 “Computer” means a virtual or physical device that accepts information in digital or similar form and manipulates it for 

a specific result based on a sequence of instructions, including without limitation desktop computers, laptops, tablets, mobile 

devices, telecommunication devices, Internet-connected devices, and hardware products capable of operating a wide 

variety of productivity, entertainment, or other software applications. 

1.4 “Customer” means you and any legal entity that obtained the Software and on whose behalf it is used; for example, 

and as applicable, your employer. 

1.5 “Permitted Number” means one (1) unless otherwise indicated under a valid license (e.g., volume license) granted by 

Stellar. 

1.6 “Software” means (a) all of the information with which this agreement is provided, including but not limited to: (i) all 

software files and other computer information; (ii) any proprietary scripting logic embedded within exported file formats 

(iii)images, sounds, clip art, video and other works bundled with Stellar software or made available by Stellar on Stellar’s 

website for use with the Stellar software and not obtained from Stellar through a separate service (unless otherwise noted 

within that service) or from another party (“Content Files”); (iv) related explanatory written materials and files 

(“Documentation”); and (v) any modified versions and copies of, and upgrades, updates, and additions to, such information, 

provided to Customer by Stellar at any time, to the extent not provided under separate terms (collectively, “Updates”). 

2. LICENSE GRANT; PROPRIETARY RIGHTS 

Right to use the Software: Subject to the terms and conditions of this Agreement, Stellar grants Customer a non-exclusive, 

non-transferable right, revocable and limited license to access and use the Software and Documentation on a single 

computer or workstation in a single location for your personal purposes (if you are a consumer) or your internal business 

purposes (if you are a business user) subject to the terms stated below. Customer must use the Technician License if using 



 

 

the software to provide professional or paid service to a third party (individual or company) and / or for any commercial 

purposes.   

SINGLE USER LICENSE. The term means a SOFTWARE that may be installed and used only by a single USER on a 

single computer at any one time. Consequently, the SOFTWARE must not be installed, displayed, shared or used 

concurrently from the computer or on distinct computers. Single User License is granted to customer who is using 

STANDARD, PROFESSIONAL, PREMIUM or CORPORATE Edition of the Software. 

MULTIPLE USER LICENSE. The term means a SOFTWARE that may be installed and used by a specified number of 

USERS representing an equivalent number of computers. The SOFTWARE must not be installed, displayed, shared or 

used from or on a number of computers greater than the number of workstations authorized. Multiple User License are 

associated with Technician & Toolkit Edition of the Software. MAXIMUM Installation and usage limit of this License in on 3 

Computers. 

3. LICENSE TYPES 

3.1 Evaluation Software/Trial version: The Software is provided with or without License key which can be downloaded 

for free from Stellar’s website. The Software may only be installed and used on Permitted Number of Compatible Computers 

during the License Term for demonstration, evaluation, and training purposes only. Evaluation Software or Trial version of 

the Software may be freely distributed, if the distribution package is not modified. No person or company may charge a fee 

for the distribution of trial version without written permission from the copyright holder. 

3.2 Subscription License: For the Software available on a subscription-basis (“Subscription License”), Customer may 

install and use the Subscription License only on the Permitted Number of Compatible Computer during the License Term 

Period. Subject to the Permitted Number of Computers for the Subscription License, Customer agrees that Stellar may 

change the type of Software (such as specific components, versions, platforms, languages, etc.) included in the Subscription 

License at any time and shall not be liable to the Customer whatsoever for such change. Ongoing access to a Subscription 

License requires a recurring Internet connection to activate, renew, and validate the license. If Stellar does not receive the 

recurring subscription payment or cannot validate the license periodically, then the Software may become inactive without 

additional notice until Stellar receives the payment or validates the license. 

3.3 Lifetime License: Once registered, user is granted an exclusive license to use the Software for maximum period of 10 

years on the same computer with same configuration and operating system which is compatible with the software. If the 

computer hardware or software is changed during the lifetime of the license which is not compatible with the original 

purchased version; then user may need to additionally purchase the upgraded version of the software. 

4. SOFTWARE SUPPORT.      



 

 

Support will only be provided to only license customer for a period of 1 Year from the date of purchase. Queries regarding 

the installation and use of the software should be submitted by e-mail which get responded usually within 24 Business 

Hours. 

Free Technical Support is provided for 1 Year from the date of purchase, if your license term is greater than 1 year then you 

may avail Technical Support by paying additional fee applicable at that time. Paid support can be purchased for Lifetime 

License only upto a maximum period of next 2 years. Stellar will not assist customers for any support request related to the 

Software after 3 years from the purchase of the software. 

5. INTELLECTUAL PROPERTY OWNERSHIP. 

The Software and any authorized copies that Customer makes are the intellectual property of and are owned by Stellar. 

The structure, organization, and source code of the Software are the valuable trade secrets and confidential information of 

Stellar Information Technology Pvt. Ltd. The Software is protected by law, including but not limited to the copyright laws of 

the United States and other countries, and by international treaty provisions. Except as expressly stated herein, this 

agreement does not grant Customer any intellectual property rights in the Software. All rights not expressly granted are 

reserved by Stellar. 

6. RESTRICTIONS & REQUIREMENTS. 

6.1 Proprietary Notices. Any permitted copy of the Software (including without limitation Documentation) that Customer 

makes must contain the same copyright and other proprietary notices that appear on or in the Software. 

6.2 Use Obligations. Customer agrees that it will not use the Software other than as permitted by this agreement and that 

it will not use the Software in a manner inconsistent with its design or Documentation. 

6.3 No Modifications. Customer shall not modify, adapt, tamper with, translate or create Derivative Works of the Software 

or the Documentation; combine or merge any part of the Software or Documentation with or into any other software or 

documentation; or refer to or otherwise use the Software as part of any effort to develop software (including any routine, 

script, code, or program) having any functional attributes, visual expressions or other features similar to those of the 

Software to compete with Stellar; 

except with Stellar’s prior written permission, publish any performance or benchmark tests or analysis relating to the 

Software; 

6.4 No Reverse Engineering. Customer shall not reverse engineer, decompile, disassemble, or otherwise attempt to 

discover the source code of the Software. 

6.5 No Unbundling. The Software may include various applications and components, may allow access to different Stellar 

Online Channels, may support multiple platforms and languages, and may be provided to Customer on multiple media or in 

multiple copies. Nonetheless, the Software is designed and provided to Customer as a single product to be used as a single 

product on Computers as permitted herein. Unless otherwise permitted in the Documentation, Customer is not required to 



 

 

install all component parts of the Software, but Customer shall not unbundle the component parts of the Software for use 

on different Computers. 

6.6 Customer will not remove, erase, obscure or tamper with any copyright or any other product identification or proprietary 

rights notices, seal or instructional label printed or stamped on, affixed to, or encoded or recorded in or on any Software or 

Documentation; or fail to preserve all copyright and other proprietary notices in all copies Company makes of the Software 

and Documentation; 

6.7 Customer will not run or operate the Software in a cloud, Internet-based computing or similar on-demand computing 

environment unless Company’s Grant Letter or the applicable Product Entitlement Definitions specifically allows the use. 

6.8 No Transfer. Customer will not rent, lease, sell, sublicense, assign, or transfer its rights in the software (including without 

limitation, software obtained through a web download), or authorize any portion of the software to be copied onto another 

individual or legal entity’s computer except as may be expressly permitted herein. 

7. COPYRIGHT/OWNERSHIP. 

Customer acknowledges that all intellectual property rights in the Software and the Documentation anywhere in the world 

belong to, or are licensed to Stellar.  The rights granted to you in the Software are licensed (not sold), and you have no 

rights in, or to, the Software or the Documentation other than the right to use them in accordance with the terms of this 

License. The Software, its source code and Documentation are proprietary products of Stellar Information Technology Pvt. 

Ltd. (“Stellar”) to provide the License and are protected by copyright and other intellectual property laws. Stellar shall at all 

times retain all rights, title, interest, including intellectual property rights, in the Software or Documentation. 

8. WARRANTIES.  

The licensed software (excluding the media on which it is distributed) and all Stellar related websites and services are 

provided to licensee ‘AS IS’ and “AS AVAILABLE,” and Stellar and its suppliers and licensors make NO WARRANTY as to 

their use or performance. Stellar and its suppliers and licensors make NO WARRANTIES OR REPRESENTATIONS 

(express or implied, whether by statute, common law, custom, usage, or otherwise) as to any matter including without 

limitation to quality, availability, performance or functionality of the licensed software or any related Stellar websites or 

services; quality or accuracy of any information obtained from or available through use of the licensed software or related 

Stellar websites or services; any representation or warranty that the use of the licensed software or any related Stellar 

websites or services will be uninterrupted or always available (whether due to internet failure or otherwise), error-free, free 

of viruses or other harmful components or operate on or with any particular hardware, platform or software; non-infringement 

of third-party rights, merchantability, integration, satisfactory quality, or fitness for any particular purpose, except for, and 

only to the extent, that a warranty may not be excluded or limited by applicable law in licensee’s jurisdiction. 

9. DATA PROTECTION.   



 

 

You understand that by using the Licensed Software, you consent and agree to the collection and use of certain information 

about you and your use of the Licensed Software in accordance with Stellar’s Privacy Policy. You further consent and agree 

that Stellar may collect, use, transmit, process and maintain information related to your Account, and any devices or 

computers registered thereunder, for purposes of providing the Licensed Software, and any features therein, to you. 

Information collected by Stellar when you use the Licensed Software may also include technical or diagnostic information 

related to your use that may be used by Stellar to support, improve and enhance Stellar’s products and services. For more 

information please read our full privacy policy at “https://www.stellarinfo.com”, on the section Privacy Policy. You further 

understand and agree that this information may be transferred to the United States, India and/or other countries for storage, 

processing and use by Stellar, its affiliates, and/or their service providers. You hereby agree and consent to Stellar’s and 

its partners’ and licensors’ collection, use, transmission, processing and maintenance of such location and account data to 

provide and improve such features or services. 

10. INTERNET CONNECTIVITY & PRIVACY. 

10.1 Automatic Connections to the Internet. The Software may cause Customer’s Computer, without notice, to automatically 

connect to the Internet and to communicate with Stellar website or Stellar domain for purposes such as license validation 

and providing Customer with additional information, features, or functionality. Unless otherwise specified in Sections 10.2 

through 10.5, the following provisions apply to all automatic Internet connections by the Software: 

10.1.1 Whenever the Software makes an Internet connection and communicates with a Stellar website, whether 

automatically or due to explicit user request, the Privacy Policy shall apply. Stellar Privacy Policy allows tracking of website 

visits and it addresses in detail the topic of tracking and use of cookies, web beacons, and similar devices. 

10.1.2 Whenever the Software connects to Stellar over the Internet, certain Customer information is collected and 

transmitted by the Software to Stellar pursuant to the Stellar Online Privacy Policy available at https://www.stellarinfo.com/ 

under Privacy Policy section. 

10.1.3 If Customer accesses Stellar Online Service or activates or registers the Software, then additional information such 

as Customer’s ID, user name, and password may be transmitted to and stored by Stellar pursuant to the Privacy Policy and 

additional terms of use related to such Stellar Online Service. 

10.1.4 Stellar, unless barred under applicable law, may (a) send Customer transactional messages to facilitate the Stellar 

Online Service or the activation or registration of the Software or Stellar Online Service, or (b) deliver in-product marketing 

to provide information about the Software and other Stellar products and Services using information including but not limited 

to platform version, version of the Software, license status, and language. 

10.2 Updating. The Software may cause Customer’s Computer, without additional notice, to automatically connect to the 

Internet (intermittently or on a regular basis) to (a) check for Updates that are available for download to and installation on 

the Computer and (b) notify Stellar of the results of installation attempts. 

https://www.stellarinfo.com/
https://www.stellarinfo.com/


 

 

10.3 Activation. The Software may require Customer to (a) obtain Stellar Software Activation Key, (b) activate or reactivate 

the Software, (c) register the software, or (d) validate the Ownership. Such requirement may cause Customer’s Computer 

to connect to the Internet without notice on install, on launch, and on a regular basis thereafter. Once connected, the 

Software will collect and transmit information to Stellar. Software or Customer may also receive information from Stellar 

related to Customer’s license, subscription, or Ownership. Stellar may use such information to detect or prevent fraudulent 

or unauthorized use not in accordance with a valid license, subscription, or Ownership. Failure to activate or register the 

Software, validate the subscription or Ownership, or a determination by Stellar of fraudulent or unauthorized use of the 

Software may result in reduced functionality, inoperability of the Software, or a termination or suspension of the subscription 

or Ownership. 

10.4 Use of Online Services. The Software may cause Customer’s Computer, without additional notice and on an 

intermittent or regular basis, to automatically connect to the Internet to facilitate Customer’s access to content and services 

that are provided by Stellar or third parties. In addition, the Software may, without additional notice, automatically connect 

to the Internet to update downloadable materials from these online services so as to provide immediate availability of these 

services even when Customer is offline. 

10.5 Digital Certificates. The Software uses digital certificates to help Customer identify downloaded files (e.g., applications 

and/or content) and the publishers of those files. For example, Stellar uses digital certificates to help Customer identify the 

publisher of Stellar applications. Customer’s Computer may connect to the Internet at the time of validation of a digital 

certificate. 

11. LIMITATION OF LIABILITY 

In no event shall Stellar or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever 

(including, without limitation, damages for loss of business profits, business interruption, loss of business information, or 

any other pecuniary loss) arising out of the use of or inability to use the software product or the provision of or failure to 

provide support services, even if Stellar has been advised of the possibility of such damages. In any case, Stellar’s entire 

liability under any provision shall be limited to the amount actually paid by you for the software product or a sum of US 

Dollars Five whichever is higher. 

12. TERMINATION       

If Customer breaches this EULA, and fails to cure any breach within 30 calendar days after request from Stellar, Stellar may 

terminate this EULA, whereupon all rights granted to Customer shall immediately cease including but not limited to the 

license granted to the customer to use the software which shall also stand revoked. Furthermore, upon termination, 

Customer shall return to Stellar all copies of the Licensed Software, or verify in writing that all copies of the Licensed 

Software have been destroyed and failure of the customer  to do so would entitle Stellar to sue for relief in equity and 

damages. 

13. JURISDICTION AND LAW 



 

 

13.1 This EULA is subject to, and will be governed by and construed in accordance with the substantive laws applicable 

to the state of Delhi (India). Courts at Delhi, India alone shall have the jurisdiction to entertain any dispute arising out of the 

terms and conditions of this EULA and you consent to such jurisdiction of the courts at Delhi, India. 

13.2 This EULA will not be governed by the conflict of law rules of any jurisdiction, or the United Nations Convention on 

Contracts for the International Sale of Goods, the application of which is expressly excluded. 

14. GENERAL 

14.1 This License is the complete statement of the agreement between the parties on the subject matter and merges 

and supersedes all other or prior understandings, purchase orders, agreements and arrangements.  

14.2 The exclusions of warranties and liability limitations shall survive the termination of this EULA, howsoever caused; 

but this survival shall not imply or create any continued right to use the Licensed Software after termination of this EULA. 

14.3 Licensee shall not ship, transfer, or export Licensed Software into any country or use Licensed Software in any 

manner prohibited by the applicable export control laws, notably where applicable, the United States Export Administration 

Act, restrictions, or regulations (collectively the 'Export Laws'.) All rights to use the Licensed Software are granted on 

condition that Licensee complies with the Export Laws, and all such rights are forfeited if Licensee fails to comply with the 

Export Laws. 

14.4 Stellar reserves all rights not expressly granted to Licensee by this EULA All rights are reserved under the copyright 

laws of India and/or of other countries, to Stellar Information Technology Pvt Ltd, having its registered office at 205, Skipper 

Corner, 88, Nehru Place, New Delhi, India 110019. 

14.5 There are no third party beneficiaries of any promises, obligations or representations made by Stellar herein.  

14.6 Any waiver by Stellar of any violation of this License by you shall not constitute nor contribute to a waiver by Stellar 

of any other or future violation of the same provision or any other provision of this License. 

14.7 This EULA constitutes the entire agreement between you and Stellar and it supersedes all prior or 

contemporaneous representations, discussions, undertakings, communications, agreements, arrangements, 

advertisements, and understandings regulating the Licensed Software. This EULA is binding on and made for the benefit 

of the parties and their successors and permitted assigns. 

14.8 This EULA may only be modified, supplemented or amended by a writing signed by an authorized officer of Stellar. 

Copyright © Stellar Information Technology Private Limited. All rights reserved. 

  



 

 

About Stellar 

is the world's foremost Data Care Corporation, with expertise in Data Recovery, Data Erasure, Mailbox 
Conversion, and File Repair software and services. Stellar has been in existence from past 25+ years and is a customer-
centric, critically acclaimed, global data recovery, data migration & erasure solutions provider with cost-effective solutions 
available for large corporate, SMEs & Home Users. 

Stellar has a strong presence across USA, Europe & Asia. 

Product Line: 

Stellar provides a wide range of Do It Yourself (DIY) Software for Consumer as well as Software for Businesses: 
 

Data Recovery 

 

File Repair 

 

Data Erasure 

 

The widest range of data recovery 
software that helps you recover 

your valued data lost after 
accidental format, virus problems, 
software malfunction, file/directory 

deletion, or even sabotage! 

The most comprehensive range of 
file repair software for Windows, 

Mac and Linux. Recover your files, 
which have been infected by 

viruses, malwares or have been 
damaged by improper shutdown 

and other corruption-related issues. 

Best software for IT assets 
disposition. Secure and erase 

variety of storage media and files 
from PC/Laptop, Servers, Rack 
Drives or Mobile devices. Data 

once erased cannot be recovered 
by using any data recovery 

software or service.  

 

Know More --> 

 

Know More --> 

 

Know More --> 

  

      

Email Repair & Converter 

 

Database Repair 

 

Email Backup Tools 

 
Robust applications to restore 
inaccessible mailboxes of MS 

Exchange, Outlook, AppleMail, 
Thunderbird, Eudora, Spicebird, 

Entourage, and Pocomail mailbox. 
Also, tools to convert mailboxes 

and database files from one format 
to another. 

Professional and reliable software 
to repair corrupt or damaged 

database for Microsoft SQL Server, 
QuickBooks®, Microsoft Access, 

SQLite and many more. 

Fully featured backup utilities that 
provides a comprehensive solution 

in case of any disaster. These 
software facilitates taking back up 
of all your mails, contacts, tasks, 
notes, calendar entries, journals 

etc. with full & incremental backup 
options. 

 

Know More --> 

 

Know More --> 

 

Know More --> 

      

https://www.stellarinfo.com/disk-recovery.php
https://www.stellarinfo.com/file-repair/file-repair-software.php
https://www.stellarinfo.com/data-erasure/data-eraser-windows.php
https://www.stellarinfo.com/mail-recovery.php
https://www.stellarinfo.com/database-recovery.php
https://www.stellarinfo.com/backup-mail.php


 

 

Photo and Video Tools 

 

Utility Tools 

 

Stellar Toolkits 

 
Professional tools to rebuild 

damaged or corrupt photos, videos, 
audios, and other multimedia files, 
from Window and Mac systems. 
Recover files from hard drives, 

memory cards, iPods, USB flash 
drives, digital cameras, IBM Micro 

Drives and more. 

A range of utility software such as 
SpeedUp Mac, Drive Clone and 

Partition Manager for Mac systems 
as well as Password Recovery for 
Windows and Password Recovery 
for Windows Server based systems 

Stellar also provides toolkits that 
are combination of Powerful Tools 
Designed for Data Recovery, File 

repair, Mailbox repair and File 
Conversion. All in one power 

packed toolkits to meet the need of 
every business. 

 

Know More --> 
 

Know More --> 

 

Know More --> 

 
For more information about us, please visit www.stellarinfo.com. 
 

 

 

 

https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/consumer.php
https://www.stellarinfo.com/toolkit.php
http://www.stellarinfo.com/

